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L1/2/3/48BUNIVAR) DFH

AUDIO SELECT CH1/CH2AA wF, BKU

AUDIO SELECT CH 3-4 21w F7ZMANUALIC

oL BEF YRV 20 3. 4ICEKERT D
BEUNIVZRRBTEET,

7. AUDIO SELECT CH 34 (BEF v =L
3-488) FEILANILGEBYIDI]Z) X1 v
9’.

BET v RV E4DEFEUNIVHRTEZE

AISERULE T,

AUTO : B8

MANUAL : F&

8. ESSENCE MARK (T vt RA~¥—7) K%
4

HARAIJVEERRPICHT S U MDER

EEICHRUT, #RUCIUYTDIvEYR

N—OTLRAI)VBEEZRRS & ENTER

ED

Al TyEYANY—oIfenNfcg X TD I
—LD—EBZFRRT D,

Rec Start : Ly IR —bN—OM]fcnic”
U—LBRU. £BEIV—LICLYIRS
— ~NY—=OPMTNTWLEWI U w Thiesd
BalE. ZOEBEIV—LBNAT—EB%=
KNI D,

Shot Markl : 3w bY—2 1 BERESNIC
JL—LD—&

Shot Mark2 : 3w hN—2 2 BERESN
TJU—L0D—E

Shot Mark0 & Shot Mark3 ~ Shot Mark9+&

RCTEFT,

Y3y hN—20~Y3 v h—U90D&F1%

ERUCTSVIVIXGT—I=FERLTY

Uw J7ZzsEir UIciBald. U R SOFEIRIBEEH

TR UCARICEDFRT,

9. SHIFT(¥ 7 M) K&~
BREONY 2V EBHFEDEBTERLET.

10. PRESET/REGEN/CLOCK (ZFUEw kU
JIRrb—h/00V9) AL YF

YA LO— RZEERTDAEZRRLET,

PRESET : #ifclCBRESNc Y A LO— REXT
« 7 |CECERT Do

REGEN @ XTF 4 PICEEERSNcY A LO— Rz
FHED . ZDEIGERITDEIDICTA L
O— R7ZEEr9 ©. F-RUN/SET/R-RUN &
A wFDREICEDS T, A#F R-RUN £
— RTHET D,

CLOCK: A AO— FZNEDRETEEhTE .
F-RUN/SET/R-RUN XA w FDERE (B
5. AE(F F-RUN E— RTHET D,

11. AUDIO SELECT CH1/CH2 (BFF v =%
W1 /288) FEUARIVERZYIDIRZ) X
1YF

BEETvURIVIE20ERBE LNV EZE

AISERULE T,

AUTO : B&p

MANUAL : &

12. AUDIO IN CH1/CH2/CH3/CH4 (BE A}
VIR F v RIV1/2/3/4) AA v F
BEF RV 20 3. 4ICECERT DATIES

EERUE T,

FRONT : MIC IN s FICEER UTe A1 I 5D
BEANES

REAR : AUDIO IN CH-1/CH-2 g FICH#i LTz
T—T«FTHEDODEEAIES

WIRELESS : A#&(C RO A~ UHF IR—% 7
WF 21— —ZEEUCEEDERANE

=

=
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I\ R)LER - XEY—H—FAOv MEAIE

XEU—H— RO B
(35R=2))

654 3

1. ASSIGNABLE (P53 TJIL) 4/5XA v F

X Za—@0peration >Assignable SwitchT
BREZEIDZCTET (135—),

THEER(ICIE. OffEOHTSNTVET,

2. GPSEYa—)b
CDBBDICGPSEY 2 —ILAWE SN TVE T,

& CANTERORE (GPS)) (67°—)

(T3]

GPSHEBEERRlE. COBAEESHENTZEL,

3. POzfmT

F7ZEUSBERE— NICYIDB|RA TIVE2—
5 —DAMECIREE LS U TERT DIz DT
TY, V21— —LCDRFEERIDE.
FRICEASNEXEU—N— P A—RCT
ERRSATELTRHINE T,

4. SiEpkaRiRiTn T

M—5T)VA SL—IHDD PSZ-HA/HB/HCY
U—X (BIFE). R—=FTILAKL—ISSD PSZ-
SA25 (BI78). NADIMSITDUSB HDD. &k
UUSBXEU—ZHEI D& AREDSXSH—
RROW MMTHASNICETA T « TRDT

Uy IZUSBAT 4 7[COE—F B ENTE
F,

(T3]

TOHFIE, LRROBERDEEICEIFER LTS,
USB/\ D3 £IFD D i L TR T 2 T &ldTEa
Hh

5. USBUA YL ALANEY 1 —IVAIKRF
USBD A ¥ L ZLANE Y 2 —)LIFU-WLM3 (F
B 2y hD—=075T5—Fv hCBK-NAT
(BIFE). DA VL ALANY & T5— CBK-WA02
(BIFe). FIFET L (BI5E) ZEiidd I &IC
KO, FHRLANEZ PR Y hD—0 EOBEN
BJREICIEDE T,

& [FRET) A 2DTA PURALANER] (69°—)
& [y —y MER] (73%—Y)

6. PROXY SDA—RZOv ks (62X—2)
JOFYF—SERASDA— REEALE T,

7. N(NFO~¥—2
NFC7 VT HRBENTVE T,

8. SLOT SELECT (SXSXEU—7H— F=FER) iR
%

A0 FAEBDMISICEERXT « 7 HiEE SN

TWBHEE, ERATDEHAT « P ZTIDI]R

FI (36X—=),

9. Ry RD—JiHF

LANT—T)L (BIFE) ZE&F{EI ST ET. BR
LANEEEIC K DR Y hD—T ED@ENTEEIC
TOFET,

[TEE]

o REDfCHIC, FliEZERT DRIF. BRELZ
FOFREMN D S IR T & —7& CDimFICHER LIEL
TLEEL,
BERICOVTIFEBDIERICIE D TS,

o LANT—DILCERDIRIE. 8B/ A XCKDREEZR
Lfed. Y=V REFATOT—T I ZERL TS L,

& [(U5—v NMER] (73X—Y)

10. HDMIimF
HDMIEZS—P L O—4F -1 L=EEL. HD
F2IFSD HDMIIC L 2ktg - BREESZE AU
gg—(}
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11. GENLOCK IN (#*>Ov Z FHAR) tmF

(BNCZY)
AASEICT Oy IZEMNTEEE. Eeld¥
ALTD—RZAROYISEDEE. BEES
BANUET . ANTEOEHEESF. RES
NCTVBDYRT LEKREICK D TREDK DI
HIEDFET,

VAT LERE AN TEDEERES
59.94i 1080/59.94i. 480/59.94i
59.94P 1080/59.94i. 480/59.94i
50i 1080/50i. 576/50i

50P 1080/50i. 576/50i
29.97p 1080/59.94i. 480/59.94i
25P 1080/50i. 576/50i
23.98P 1080/23.98PsF

12. TCIN (&4 LO— FAFD) iimF (BNCRE)
YA LO—RZEHNBOYITEHLEE, BEL
BT A LI—bEANDLET,

& [54L0—RERET D] (53X%—Y)

13. VIDEO OUT (E 57 H77) iz F (BNCE)
EFFEZY—RBOET A ESZEHLET,

14, TCOUT (¥4 L O— Rt iimF (BNCRE)
NEBVTRD S A L d— RZERBEDY A LI— R
[COvoSBDHEE, ABMVIRDY A LO—R
Ov ZATCIN (¥4 LA0—FAH) mF iR
LET,

& U—8B - Fifcim 5

ouT REMQTE

8 9

10

1

J

1. TALLY (K\w o5 U—) ST (FR)
SERPICRAIULET, 22l TALLYR

A VFHOFFICEDTVBD ERIT LR R A
WARNINGS >V THEWEL CWD EEF R L
FT. BB, Ea—Tr7AVI—REDYJ—
Sv7J, Ea—D7A V5 —EHEDRECGRT®
BERICRKT RBLET,

® [I5— EBEIRT L] (156R—Y)

2. TALLY(#U—) A1 v F
TALLYS > T2 {ERAT & & ONICERELE T,

3. EARPHONE (1 Vih) imF (RFLA. =
“Ivwy)

AVRVZERIT D& oirhlFE-EEZ. BE

HIFBEBEEZY—CEFT, EESVTP

ZEERTORE - RAICEDETCESSZDEC

AFT. AEAE—H—D5DEIFEBMICH

CAIFLHEDFT,

XZa—MMaintenance >Audio

>Headphone OUtCTE/ ZIL " RT LA 7ZY]
DX D ENTEFRT,
[TEE]
o AVIRVIFE/SIL O FlFRFT LA (3®) 547
ZERULTLEEV,. ZNLUNZERT D AN
BEIHENBDET,
o AVE—FURI6QDAVRYEFBHLTIZEL,
4, AUDIO IN (BEAN VDR XA v F
AUDIO IN CH-1/CH-2i5FICAHTNDBEED
ERZVIDMA T,
LINE . AT LA TPV TIEE NBEDA—F « 7
EERZERT 2155

AES/EBU : SABRDT I Z A —TF « A 1ESF%=
ERdoBa

MIC : YA U ZER T DIEE
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5. +48V/OFF (+48VAERENMIET > 7 7T)
AAYF

BREANICEATEONATICELDT. UTFOK

DICYIDIWA KT,

+48V : A EBEBIRHIES DY A &

OFF : AEBEBREEHTDON 12

6. SDIIN (SDIAS#®F) (BNCEY)
NEDSDSDUESZAEICATIT D EE(CfE
A9 dmTCT,

7. AUDIO IN CH-1/CH-2 (BBEANF v /=
L1/2) imF (XLRE, 3E>., M)
T—T 1 AREONA TR LUE T,

8. WhLA/IN—
BEHDORFICERT T —JILEZRET DI
HDI—YTT,
ANLD—F—REDIRDHIFRIZDDHD &,
BRI oNA 0T —JIEldd —FT 14—
TIVDTSTDRARITIRC T, IR LSI—=D
UBZRHEITDIENTETT, FERIL. R
V7 CHIN—ZBEEL TS,

9. AUDIO OUT (BFHA) iiF (XLREL, 5¢
NN L))

FT—FTAFAF v 2FEF. T—F«F

F v URIV3. AICEERSNICERESZHAL

FI.

HHTBEHESIE. MONITORRA wF TR

RUFT,

10. REMOTE (UE— kO hO—)L) #F (8

EY)
AHEOERRBRENTTRERZRYU E— DY O
-y hEERELED,

[CEFR]
AEICUE— NI bO—)LAZw bOER /WD LZE
I3 EEGF. FMEDERZY > TH ST TLEE L,

11. SDI OUT 1/2imF (BNCEY)

HD SDIES (ZAXRTFTy RA—T 1 ) FfelF
SD SDUES (TURTFw A =T« F) 72 S
LET, RmFHOSDENESEF. XZa1—
MOperation >Input/Output >SDI Out1
Output. FfelF>SDI Out2 Output TA~ /7
JEYIDWZ D ENTEKRT,

[CFE]

B S BB DREID 7 —ADERICRESN TS T &
ZHESELTH D, BRZEANTLEE,

(750887 —J)VZER UfcIC. AR E SN EBkERDE
BEANDTEZHITITHULHRT.)

POZEFT. BRIEARECHEBKEZER T 255(L.
75QEET —TIVENEBIER I CRER UIcRI(C, e
mruC<rEEL,
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LCDEZ 5 —BHREE (RT—5 AKK)

LCDEZ&—I1E#HREmEE. DISP SEL/EXPAND
(RBER/ TR R) R 2 U TERR
LET (OR—=),

Media Near Full
DN = ] 15min
TN (S—] 05min

1. Z74IVY AT LRR

2. F7A4IWT+#—< v hERR

3. REET

PB: XT« PEBELTCVD EERREINE T,

NDF : ¥4 L0—bH /> ROV TTLU—ALTE
—ROEERRENE T,

EXT-LK : NEDY A Ad— RI T RU—F—hH
TCIN HFICER LI BB ES IOy 5 LT
WD EERREINET,

HOLD : ¥/ AO—RI IR —F—DHEE
—RBL Yo SVT, SEDIEFSTNS
EERREINET,

4. YRT LEREET

ORI DY AT LREIBEE CFBEHDI U v

TDY AT LAERENERREINE T,

5. B8 7#—<v h&RR
SCERIBOERE J 4+ —~ v hEElFBEHRD T
Uy IDBE I+ —~X v MORRSINET,

EON E o VA

16bit HD420 HQ
DVCAM
MPEG IMX 50

24bit HD422 50
MPEG IMX 50
XAVC Intra

XAVC Long

6. BEUN)DA—5—
BREEEUANIVREEBEUNIVARRENE
Io 1] ~ T4EEEFF v RV ~4%ZR0U
EEE

7. Ny T U—TRERT
Ny TU—EENT A I LEEROIREIFTE O BF
B CHRRSNE T,

8. AT« PHRERR
EERX T« PDERENAOY b &(TIN—=T3
TCTERRENF T,

9. BERRIVUY
EREBDNREUCETCREERRLET,
® UL [IS—/B&EYRT L] (156R—I) &
CELEEL,

10. 2V y J&FR

SoERFIE ELERF DT Uy TICHIFoNEIU Y
T8, EERERSRIE. RICESIRSNSDSIU YT
[ERHF5NE TV Y TEBRRINK T,

11. 94 LT—5FKR

DISPLAYZAA wFDIRI> 3 VICKD, T2

L—y3y, 4L0—KR, I—F—tEvhE

YID|R THRRLUE T,

FALT—FIIRERTUCVS T —FDIEEE

(F. RDLSICERRINFET,

TCG : YA LO—

TCR: BEYALO—R

UBG: &1 —Y—tEw

UBR: B&EI—T—tFvh

CNT: hov5—

DUR: FalL—v3v

CLK : BZIZ= (PRESET/REGEN/CLOCK &
wIFH CLOCK [CEREINTLD)

54 L3— RRRAFICHOLDR Y Y HREN
JeEEF ROT#—NX Y FCTRRSNE T,
HOLDM S 2 7= B3R U CREPREZfERR T
& BEORRICRDE T,

00’ 00!00! 00

FA L= b DDV —HEDMRFHRAET
HHTEEIDD Y NTKRT

12, BEERR
HDRRDREENRRSINE T,

13. 8887+ —~ v bR
iR 74—~ v hKRCFBEHDI U W TDEE
BRI+ —< v bOFRRINET,

AT—45 AEH

AT = AEECld. FHEDRE PIREZHEET
THENTERT,
AZa—hHFRENTLELEE. MENU
CANCEL/PRST/ESCAPER A v F 7% CANCEL/
PRSTRIICHE U LIFD &L RT—F ABEDERTR
SNFT, B|LLETDCEIC, RT—F XEE
HHIDI|HDET,

AT —5 ABEIE. ROBEE CEBERSNTNEY,

AT—YRAEE RTHNE
(DIERE

Camera Status & (CET HERE S IRRE
[E[EN

Audio Status A —T 4 A AEAICET HERT

[EE EIRRE

System Status ECERICEET DR TE LIRRE
[EE

Video Output  EFZAHAICEYT DEREEIRRE
StatuslEE

Assignable PHAFTITIAA v FICEIDY
Button Status  THNTWLDHEEEDZTT

[EE
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5 #ZE EE&R

AT—YRAEE FrAHE
DRERE

Battery Status FEFSNTWS/\y T U—DIK

B !

ULy

Media Status ~ ECERA T o 77 DIRRE

[EBIE

Network 2y hD—TICETHREERK
Status 1EHIE R

Network A== JCEATDHREE

Status 2EE  IRRE

Audio StatusiE|E

Audio Status

Level Source Ref Wind Filter

CRl ||| I
criz [N cH2 Line

. Front Mic

. AES/EBU ---

. AES/EBU ---

EQNEIE! B

Camera StatusE|E

Camera Status

Gain Iris.

Zebral
18dB On (80%) F5.6

Shutter Zebra2 Focal Length
On (102%) 75.2mm

Depth Of
in Switch Zoom Speed
Lo o, e

v
Off
Gamma HDR Setting Focus Distance
STD5 R709 HLG(Natural) 4.3m
Whit Field
Gai

CH1/CH2 &FvrRILODF—FT 144X
CH3/CH4 b ANV —R BEADUANIL,

BRrOBEEE T )L —D5&
TE

System StatusEIE

System Status

System Frequency Picture Size Gamma

23.98 1920x1080 STD

Rec Format Rec Function
XAVC-| S&Q 26/24

File System Clip Continuous Rec
exFAT Off
Simul Rec Picture Cache Rec Proxy Recording Mode
off ff off
Title Prefix Number
ABCDEF 00017

FnIEE B

Number Iy T2DBFHIBEERD DER
E

Gamma BREINSGammahrdU—

Proxy JOFy TS EEED A

Recording S A TRE

Mode

Video Output StatusElE

Video Output Status
ace Freq S

Picture Size C. Sp: uper
spi1 1920x1080P(Level A)  YPbPr 3G  ---
spi2  1920x1080P(Level A) YPbPr 3G  On

Homi 1920x1080P
video HD Sync

YPbPr 1.5G On
YPbPr --- On

Battery StatusEIA

Battery Status

Detected Battery
BP-

Manufacture Date

GL95 Jan/18/2014

Remaining
54%

Charge Count

52
1.93Ah DC In
13.2v 12.8V

EUNEIE] Eis

FKmIEE i

w

DI SDI OUTtmFDHAIERTE (B
YA HHOEE. BHL—
A=) {—A 2V R—=2X)

Detected BTN/ Ny T U —0DFEkE
Battery

Remaining B2 (%)

Charge FEBZE T DI B
Count

Capacity EEE (Ah)

Voltage BT

Manufacture /N U—8LEFHH
Date

Power Source EBIRHEIGIR

Supplied HHREREBE
Voltage

HDMI HDMIimFDHAIERTE (K@Y
A X AR B AL — b X —
J—A 2V R—=2X)

Video VIDEO OUTimFDEAIERTE (H

NEYA X A—){—A2iR—
)

FnIEE A

System VAT LERE

Frequency

File System 77 ALY AT LA

Rec Format EEE|IA—<w b

Clip U TAVT4ZaT ALY
Continuous  J¥&BEDA > /4 JRE

Rec

Title Prefix Uy T2ORIHFEB D
Picture Size BT A X

Simul Rec EIRFECERIEBED A 7 TRE

NS StEA
Gain dBEMIDT A V7 v TE
Shutter BTV v vy —DIRE
Gamma GammaAhFdU—&EA—T
White ROA MGV RE— ROEE
Gain Switch  GAINZA w FDIRRE
Zebra TISDRE
Iris 7 A1) ADFE
Focal Length fEREBEE
Focus T F— AR
Distance
Depth Of HEFRE
Field
Zoom Speed L XDZOOMME VITFRES
NcA—LAE—R
HDR Setting HDR®D&RE
[TFE]

BIFEDHDR LICENSE (CBKZ-SLHL1)
ERARKICOHRTEINE T,

Rec Function OnICi&x> TL\DHEHRECEREFD

RTE
Picture Cache EZF v—Fvrwval v
Rec BEDA >/ F THRE

Assignable Button StatusiEIE

Assignable Button Status
0 5
ATW Hold Zoom Wide

Online
Zebra

CC5600K

‘
2 Lens RET
3
4

Media StatusHE|E

Media Status
Remaining

210min 100%

EQNEl= B

SXSA A0v FADXT 4 P DRBE
(\=EEOBRERT). X7«
77%dn (0 ~ 100%ZFKR. 0%
TRITEHERE, CDRBED T IR—
bUTWBAT 1 P DHER)
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i

FnIEE BB FnEE BB FrIEE 589 REER  HRE B8
SxSB A0v bBDXT 1« P DERBE Device Name FEINTVDET LD Streaming A==V ITDXEERT KU Address CCM7  #ERFEDOCCMDIRA b
U= EBDBREET). AT« 2 Dest Add. 2 Error RURT  &FFPP RURD
77%am (0~ 100%7Z&T. 0% [essu— \BFES > Streamin A= IDREELETR— 7= EhE > CTL\ DRI REMAY
TREHESE. TORBEDYT— ':ddress(Modem) e BHOFT, ELHE
= = — =3
FLTWEXF 1 7 DHET) Wired LAN el ANy D — 2 D Numberof — REEEFDANU—Z2ID ?_W’ALEL\%)D\ BLT
SD Proxy PROXY SDA— RZOw k(D X% it Distribution  3:/E4% NERAT
T4 T DEBE (- D EY _ o Fle Transfer 57 1 LB OB RE Auth. CCMa—  CCMICHERET BTesHD
RR). AT« 7H (BUSTE Wired LAN LANT —J)L7z e UicH i€ franster g PSRRI Failed P—%/ 1-Y-ZFrF)/ X
T BDHERT) Remote ﬁﬁfﬁ@i%: MREDEI  Tansferto: | 77 A IEEEDT—)—% JRAD— D—FHEES TS
SD Uity UTILITY SDA— RADY RO i RIS— TeboDET. E
T PORRE (\— & RRE). P . BIRLANEFEDIP7 R X LU<SEESNCTLISD
AT PES @ETEgan  Address(Wired) Ry NDI—H 55T NE— RIREEDF BEsRL C<reEl.
HERR) = . No Inet AVF— Ry hI—JCERHRT
REXRE  RE 588
Access XYy bhgE TFECBh. Ry KT—
AT PHTOFY FENTOREAR. Network Status 2E(H off COMIEE v NO—5 0547 BTS—  HORENEE-TL
7_773\\\%%3_—\3*1353—0 ﬁlljt%?{ > '\:E_ FD\Z— 7@4}% éﬁjﬁglléb\\@ NnZET,
NWCIlemgfnfdeStalus SI‘\'/TE'HI‘E‘EEP'T'S/UDP Number of Distribution FDE:T@_G 7\ W I\'j— 7 @é&ﬁ%
Network Status 1EIE e Connected CCMIER: Rw hDI—09547 mEL TS,
P ARE Y ME—ROAYT Cert.not  CCMEEBH CCMOIIBRENEMT
E CCMITHEE LT, Valid BENT  FHDFTA. BHNE
S CCMD SDFIEIN T 8E 5— EDRIE DT 8eM:
. BRETT. hhET. BMEE
=— = Connecting CCMEE#E CCMADES (F7cl3 ERREL TS,
"oy |5 eeaim | 1op 168150 ai G R Eyre— (G ) LK S LT
= I "\“AW ent Ay POmITIAYRE ) REE VBREETT. EBEGE
ode Status (B0 SR E T
=] = H 2\ —_ . \ N
Settin Ry NI—5 DEERRE ST L. Connecting®a
J PERE ] (6~—2) =S FREDZAE LIV
Wireless Network D4 VL ARy hDJ—2D5% CCM Name v RJ—595A4 7 RE— AFCCMOT KL 22
R RBSCERERDCCMODE EHRE> TOBTTHE
Device Name BESNTLBUSBIA VL Streaming X RNU—ZVJDEISKE HAHOHFT. ELL
ALANEY 1 —)LiSD% Status 7 RUADEESNT
=0 =
m Streaming ~ BREBERULTCVDA M-IV tzéb\ﬁﬁ”’”btqﬁ
IP Address DA VLU ALANEFGEDIPT K Size HBEOBET A X = —
(Wireless) A Streaming Bit FERRLCLBR U—So  ong CCMER Fv o o1
MAC Addr. USBD AL ALANE Rate HBEDE W RL— o Ty
(Wireless) Ja— R TFICEE SN : — Py PO IRED
TUBMEOMACTY KLz Sueaming FEERL CLid AR == FIDRIETT . CCM
Type TREDIER! [CEmTBICIEFRY b

Wireless Network EF LADERTEIREE

D—UREZEHICL
TLIEE L,
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18 #Z EERR

Ea—J 7425 —HEHH

iR (BoizhECiRfSHET) SRUBLER.
Ea1—D77 A 25 —EEICIEAREDBROIRE

DISPLAYRA wFTYIDMRA E T,

FRI DIERIFAZ 1 —DOperation >Super

+0.00

[CERTCHRRINET, IMmposeDERE®. BEET XA v F CDIRE
BRDEKR FERREFE2—T 7 A5 —D ([CEELTVET,
/
B LRI,
299)(099m) €1.6)| |[@ @ Cont StbvJw 1l 2. w1.||| 60ch 120m|n
38— W:A) (12000K) (5600 (57 545 70 5w @ = "l m—13
37— (/2000 W14
36—|tas 1) 15
35———(NDf 7 ———16
34— @8 18
& —19 9,
21
33— (AEE+0.0)

wo
N
|
>
5
5

| S—

L — 3 22
(Clip|Name 000000000000000000000000 | 24

3‘] ——([RecCt)STOP
30—=
TCG—00:00:00:00 O e [15x5AY 120min [5x58Y 120min [[Proxy) 120min
| |
29 2827 26 25

1. TORTVH—KRR

TEDTITIVIIRT VT —HREEB IOV

ADIORT YT —HEEDRERENFRREN

ESERS

EX: UYADIIRTVEI—HONDEE

XD AWDTIF VT I RT T — ke (2 18)
MONDEE

X3ID:AEDTIZIVIO AT 5 —HEE (3 1H)
HONDEE

XAD: ABEDTIF VIO AT 5 — e (4 18)
HONDEE

EX2D 1 LY ADI I ATV F—BKUAEKED
TITIIORT VT —HEE (218) Ol
HONDEE

EX3D 1 LYADI I ATV F—BKUAED
TIZIIORT VT —HEE (318) DOl
HONDEE

EX4D 1 LY ADI IR TV F—BKUAEKD
TITIIORT VT —HEE (418) O3
HONDEE

TIYIWI U AT S —(EDigital Extendert
BEZEIDNF P TAFT TIVARAvFTEY S/
FI7ULEFT,

[TEE]

AO0—8&IAYVIE—VaVERMICTEDE, TIYILT
TDRTVH—"AVICTBHTEFTEF A

2. A—LRIY a vRR (LY XEBERDH)
A—=LUVVZADAX—=LRI 2 3 H0 ~ 990D
B CRRSINET,

CHEADL Y XCEL > THRRSNDEIFEDD
EXC

3. BRERTR
ROA M SVADBREDRRENE T,

4, T#—HARIYavERR (LY XEERFO
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T4 —NX v hNCELED dfeLE R

TO7 5 REUSXSHEU—H— RPART
BRATEEVAEY—H—RIFT4—T vy b
N th.

EE Xy E— IPERRENFIOT, A v—

VST, EATEBZXSOXEU—A—RIC

SR T REL

[CER]

o XEYU—N—RZETF—Yv hgdE EHFERINIR
BT—5. By bPvITIT7AIVEEEZD. INT
DT —FHEESNET,

o AETHEMATDXSATEY—H—NE. FEDT 5 —
Ny MEBERER LTI 7 =Yy FLTLIES W, ftb
DHERT I+ —< v bUTBEIR. BED T4 —< Y
hEHEEN, FETBET 1 —Y v hTDNEDD
DEF,

SRR T A —< v b

iR CH. BOI—ADH—RROY MMIFE

UTESXSXEU—=H—FRD T+ =X v hOATHE

—Z\_‘jo

([T3ER)

o BERBRUY LRAVBEERRFRICT 7 —< v M
TEF A,

o JF—Xw I, B3—HDA—RROY MMKE
UTESXSAEU—H— RADEHREFRIH T EE
hue

5% D (DECER PI BEB B ZZ fiESR
ERG)

Ea1—T7 A2V T—BEDEHEAT « 7IRER
BB C. FARAOY MMIEBURSXSSATEY—H—
FOXRBZHRIT D LN TERT,

RESRESNTCVBETZ T+ —< v b G

Ew hL—b) THRE UICBEC iR aE b
Bz, ZNZNOROY FARDAT 1 P D%RE
hoEELCHEBEMTCRRLET,

Media StatusEIE (15X—) ZRREED
& BEEA—SY A THERIDEDHTE
*F7,

[T

XEU—A—RHTOT I hENTLBDHAR. (H~¥—
IDRRENKT,

SXSAE —— ROIHREFEA

o SCRAC 2D AEY —H— RDFRECERATAE
BEIDAS SN ZEEDE. EEAYE—Y
Media Near FUllB*&RRE1. WARNINGS >
TERUE 2 —T 7 A 5 —BEORECERR
DREETT—FTEELFT,
EEDHIXT A P ICTIRULTLEEL,

o SLERZMET L C. FRECEROIBERFREDSETH0
(LD E. XvE—IHMedia FulllcZhb
SELERMEIELE T,

[CER]

DS AEU—H— RICKE00EHE T U v T725053

TEFT,

R CTEDI U w THD LRISET D & ERFEZRRN0]
[CHED . XwvE—IMedia FUllBRREINFE T,

SXSATEYU—"— hZEE
ERG)

ASHDRETXEY—H— FADT—FI(CE
BOREUBEE. XATEY—— FOEED
WEITIEDF T,

BEMKNEIFSXSATEY—N—REHBA LIS
TlE BEZRITIDNESHZRIRT DA Y



037 | 2F ZEfE  SXSAEU—N— ROEDEN

T—IWE 1T 7 A VI —EHHICKRINE Bl MBEFIVU Y TZE T+ — v bUESXS
ER XEYU—H—RFCOE—-LTRT,

EEBZRTIDICF. MENUDFEHZEBE LT
ExecuteZ@ERU. DRI ZHUF T,
EEBMNIAEDET,

HITRX v E—IPRREIN, ACCESST VT
AL YITRALET .

BENMETIDE. BT AYE—IHKRREIN
FT. MENUDEHZFHLTA v Z—I&HEL
EC

BECTEN dEEEE

o JOF U FENESXSAEU—H—RP, T
T—HREURSXSAEU—H—RIFEET
EFBA. BEA Vv E—INRREINEITOD
T, Xyvt—=JIR>T. JOFU N
DN BIDSXS XEU—H—RICHELT
<rEEL

o TS—PFEEUSXSAEY—H—RIZE.
T#—NXv hzUBT EBFATESEEN
HOHFET,

o —HDUU Y TDHMEBTEHFWVBEEDLD
DET, BETEIV Y JFEEREICE
bh&ET,

o BR7ZE{TLCHIEDIRL Could not
Restore Some Clips &EXwE—IHFRRE
NBDKRDITIEDTESXSKXEU—H—RIFE. BL
TOFIETERICREDHZANDDFT,

[ BERA7IJUS—3avVy I o7
(183R—) ZAWT. REEI Uy
TZMDSXSKXE Y —H— RNOE—7
Bo

[2] BREDHDDSXSAEU—H— RZEXMET
T#4—~Xwv T D,
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28 HEE

eXE T — Y IRTF

RET —5 DREFIERTEDSDA— RIERD
EBDTY,

SDHCXEU—H— K" (Speed Class : 4 £/
UHSIERIL, BE 4 ~32GB)
¥ AECIFSDA—RFERIBULTVET,

SDA—RZETF—<w I
(EE) T3

THETHIHTSDA— REFERT D EEE
T#—Xv hHWETTY,

K THEATDSDA— REF. AEDT 5 —< v
MEREZFERLT I+ —< v FLTLEELY,
SDA—REEBEUCEFICEEX v E—IHE
mENEHEED. 74—y bULTERALTL
rZEL.

1 X Za—@0peration >Format Media
>SD Card(Utility) Z3EIRT &.
T4 —X v hEETITHHE DD DOMERE
HEDRRENET,

7 MENUDE#%E L TExecute &R L.
DEHEET,
T —<w NMAEDET,
FFhX v b—IhEREN, ACCESSS Y
THF LY ITEILET .
TF—Xv MR TITDE, B AXAVE—
IRERRENET. MENUDEHERULT
Xy t—IEHELET,

[TER]

SDA—RZET#—<v hg2dE. IRTOT—FHVEE

SN B TEF A

1ISDA— FDHID KLY

BRSBTS

Media StatusHEmE (15X—) TSDA— KD
BREZWERIDENTEFT,
AT T+ —< w b UTeSDA— RZMD#EEERD
AOw R TERATAICEHSD U/ I 7y
TZEERD., BFEVICHEHEET I —~ v U
BULTERLTLIEEW,
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28 HEE

—V

AXF AP TPITI—%&FES

[CEFR]

e JOTTvYaFIVABDSXSAEY—H—FEFFED
BULEEN - MAMZERZSNDBDTIFHDEE .

o INTDOAEY—H— FOEWFZRILT DD TIEH
DEBA. BIEESAHFDXEY—ICEEUTIFHEL
EFECBELEDELEE L,

XODAEU—"—F

AIFEDXQD ExpressCard 7”4 74— QDA-EX1
ZERATHEICKIDT. XQDAEY—H—R
ZSXSAEU—N—RAOY MMTANT, SxSX
EU—H— REEERICECER - BENTAET.

@ XQD ExpressCard 74 74— QDA-EX1DfELDTEIC

DWTCELLIF, PITI—ICNBOEIRGAEZ =
BlrEEW,

[&EE]

AT DXQDAEU—H— ROEREICK O TIE. LUTD
BIEZEBITABTVNCEDHDET,

o BEBE

o AO—8&IAVIE—Y3aVRE

J3—~Xwv b~ #HE) BIC(EF

T THHTXQDAEY —N— b ZERTD &
Eld. Tx—Y v MORETY,

THETREAT HXQDAEY —H— Rld. A0
TF—Nv MERBZEFERLTI 4 —~< v hULT
LIEEW. XODAEU—A—RZEEBFUEE
[DERA Y BE—IDERRSNHZEGD. T4 —
Ny hUTERULTLES L,

T4 =X v hENTWVWELXQDAEY —h—
B FEERIOMERTT 7 —< v hENTeXQD
XEU—H—PFZEREETDE. T4V hE
TOERA Y=Y, FEET7AIVVRT A
HEEDCEZHOB DX v E—IHRRIN
ESER

] XZa—MO0Operation >Format Media’Zz%
R 5.

7 Media(A) (O RA) EielEMedia®) (2
Ow RB) ERIRT 2,

3 MENUDE®#%E L TExecute =R L.
DFEHIZHT,
T#—X v heRITT DN E DD DHETE
EHRRENE T,

4 MENUDEH%E L CHEREREDExecute
BERL. DEHEET,
T4 —< v MMAEDET,
(T A v —IPFEREN, ACCESSS
THA LY ITEITLET,
TH—Nv b TITdE, BT AYE—
IPERENET . MENUDEHEIR LT
Xy —IEHLET,

[T32]

XQDAEU—H—RZT#—~<v hgdE. TOT7

SNEEGRDHEHT. INTOT—IHEESN. BT
EF A

A IV E 21— —DEH

SCERAEFDXQDXEY —H— RZEARERID X
Ov hMIEELTC, A IVE1—5—7%=
USBT—JILCHER L TERALTLIEE L,

BTETCTF—X vV NUEXT 1777
fD#EEMD A Oy FCTHEARTBDICIE

B UHNyI7 vy TZED . BEVICED
e CTIr—< v hLEBULTERLTLZE L,

SDA—F

AT, BIFEDXT « 775 T5— MEAD-
SDO27Z{EAT DT Ik D TSDA— R7ZESXS
XEU—=A—FRAOY MIANT, i - BE
PMTAE T,

[T3EE)

SDA— REMDAT 1 P2, FNZNXEU—N— KR

O MMIANEBE. FICANEXT « P DHEHS .
‘D BOANIEAT 1 P (FERESINE B Ao

ERATRE/FSDAH— RDOXDES DT,

SDXCAXEU—H— R (SDRE—RHSR :

Class10) "

SDHCXEU—H— K (SDAE— RIS 2 :

Class10) ?

1) 774V RAT LDexFATDEEICERRIEET Y,

2) TP AV RT LD FATDE = EABIEETY .

® AT PP I TI— MEAD-SDO2DEWNDTEEDNT
UL E. XF o P75 T5— MEAD-SDO2 DENRER
BHEZCELIEEL,.

[TEE]

o SDA—RZEFERUCEERBEZTOHBE. EULIENE
UIFWVWC ERBDFET,

o VYW IEFREWTDY—LAUVABEIFITER A

o SDA—RZEFEAULT. XAVCIntrad #—< v b TRl
T HIHBADEER - BEFFRIESNF T Ave

o SDXCH—RZEFERULCRO—&IAvITE—V3aVik
EEIDETE. RO—E—VaVigEFTEFHA.

J7—~Xwv ) 98I

FHETHIHTSDH— R =ERT S EE(F.

T4 —X v SO ETT,

A TEATDDH—NE. FEDTH— v
B ERL C T4 —NwhUTLEE W, SDA—k
ERBUICEE(SFRAV E—IDRRSNGE
B TF—YRUTERLTLIESE L,

T#—=x v hENTVEWSDA— k. KTeldHl
DIEKRTT 4 —N v bENESDA— RN ERET
Dl TA—NY MRTOEREX v -, F
el ET7 7AWV RTLADEEDCEZASED
Xy —IPRREINE T,
ROFIBCTT#—< v FULTLEELY,

] AZa—M0peration >Format Media’Z&
RI B,

7 Media(A) (2O v RA) ZizlEMediaB) (2
Ow hB) Z&IRT 2,

3 MENUDZE#%E L TExecute &R U,
DFEHZHT,
TH—< v NERFETBHNE S D OHRRE
EARRENET,

4 MENUDZ#7%E L CHEEREEDExecute
ZERL. DFRHEHT,
TH—<Xvw hDRETODFT,
T A v E—IHRRIN. ACCESST
ThA LI TRAOLETD,
TH—=NvY DT ITEHE, BT XY TE—
IDRRINET . MENUDEHZEFRLT
Ayv—IEHULET,

[CER]

SDAO—RZET#—<v bgDE. TOF T bSNCER
BHEHT. INTOT—FIDHEESN. BT TEE B o

AEE IV E 21— —DEH

SEAEGFDSDAN— R EAKRIDZAO Y MMIEE
LT, A& IV 1—5—=USBr—JIL T
B U TERAL TS0,



040 28 HEf AT AT TITI—ZED

BEETCT =X NUEXT 177
DDA Oy NCHEATDICIE
BEDUHINw o7y TEERD. BEVICHED
BETT+—<w NUBLTHERL TS,
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38 RECHE

J#—~ v MDERTE

XZa—@0peration >FormatT. 77 )L o BE#E2997 L5994, BRU25LS50ETOYIDI]A

AT L YRATLBERY. BrOETH T4—
Ny NERELER T,

€& X I—DEECDONTHULIFE [y b7y TX
Za—DERRE] (101X—Y) ZTELREL,

T7 ANV RAT L7 #ERT
)

T7AINV AT LWEERUE T,

] X Za—®0peration >Format >File
SystemZEIRT B,

7 MENUDEREBLT. I7AIYRT L
BERL. DEHEET,
FEEHERINET,

3 E=FIBICIFExecute’E. hIFTBICIE
CancelZ&ERU. MENUDEHZ#HT,
ExecuteR17#. AEIFEEMICHIEEILE
§_O

[CEE]

508% - BEPRFCEY LRAIVEERRHICT 7 ALV X
T LZYIDMR DT ELTETEA.

VAT LEREEY)DIRA
2

MR U TYRT LEREZYIDIBRE T,

[CER]
o SCER - BEPRICEFYLARAIVEERFRTFRICT AT A
BERBEVIDIRZ D EFTEX B Ao

#®F. BBNICEBESINTE .

o YRT LEREZEVID]A IBE. TORKM LA
[CEALTCVcETZ 74— v MMCEEIMICTID R
DHFEI,

] AZa—MOperation >Format

>FrequencyZEiRT %o

7 MENUDEHEBLTYRT LEREEZ
RU. DEHEET,
BREENFETINET.

3 E=FIBICIFExecute. hIETBICIE
CancelZZRU. MENUDZHEHT,

ExecuteR{T#. AHFEEFMNICHBEHUF

a—o

ETFZF 74—~ hzyID
LY

[EF4 D3~y MEER] IR—D) %

SRU. MEICIHUTCET A T4 —< v b2y

DIMZET,

] A Za1—@0Operation >Format >Rec
Format’z: &9 %o

7 MENUDE#EEBLTETA T4 —< v k
EERU. DEHEMT,
EREEh SRR NET,

3 E=FIBICIEExecute. hIFTBICIE
CancelzZ &R L. MENUDEH%=IT,

ESZ 74—~ v MERER

EFAREELY AT ARIBRBOEIEDOEICE DT, UMTOETZ T4 —< v hORENTIEET

ER
VRT LR T7AIYRT I EF4T7+—<X v b B4 X
AZa—@M0peration AZa1—@0peration  XZa1—@0Operation
>Format >Frequency >Format >File System >Format >Rec Format
exFAT  UDF  FAT
59.94/50 O - - XAVC-11920X 1080P 1920% 1080
O - - XAVC-1920% 1080i
O - - XAVC-1280%X720P 1280%720
O - - XAVC-L501920%1080P  1920% 1080
O - - XAVC-L 50 1920%X 1080i
O - - XAVC-L 50 1280%720P 1280%720
O - - XAVC-L 35 1080P
O - - XAVC-L 35 1080i
O - - XAVC-L 25 1080i
O O - HD422 50 1080i 1920% 1080
O O - HD422 50 720P 1280% 720
O O O HQ1920X%1080i 1920 1080
O O O HQ 1440%1080i 1440% 1080
O O O HQ1280%x720P 1280% 720
- - O SP1440X1080i 1440X 1080
59.94/50 O O - MPEGIMX50 720X486/720X 576
O O - DVCAM 720Xx480/720% 576
29.97/25/23.98 O - - XAVC-11920X 1080P 19201080
O - - XAVC-L501920X1080P  1920X 1080
O - - XAVC-L 351080P
O O - HD422 50 1080P 1920% 1080
O O - HD422 50 720P 1280%720
O O O HQ1920x1080P 1920% 1080
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3% RELHAE I T4 —Yv bORE

SDI OUTimF. HDMIEFJImFDHES T 4 —X v MERER

SDI OUTiwmF. HDMIEAIHFH ODHAESIF. X = 1 —D0peration >FormatDRE IR UT

TROKSICHATNE T,

AZa—®M0peration

AZ31—MD0Operation

Format Input/Output
Frequency  Rec Format(d—7"w (3#&#) Output Format
SDI HDMI
50 1920 X 1080P 1920 X 1080P (Level A) 1920 X 1080P
1920 X 1080P (Level B) #EES
1920 X 1080i 1920 X 1080i
720 X 576i 720 X 576i
1920 X 1080i 1920 X 1080i 1920 X 1080i
720 X 576i 720 X 576i
1440 X 1080i 1920 X 1080i 1920 X 1080i
720 X 5767 720 X 5761
1280 X 720P 1280 X 720P 1280 X 720P
720 X 576i 720 X 576i
720 X 576i 720 X 576i 720 X 576i
BES 720 X 576P
25 1920 X 1080P 1920 X 1080PsF 1920 X 1080i
720 X 576i 720 X 576i
1280 X 720P 1280 X 720P 1280 X 720P
720 X 576i 720 X 576i

Format Input/Output
Frequency  Rec Format(d—7"w I3&#) Output Format
SDI HDMI
59.94 1920 X 1080P 1920 X 1080P (Level A) 1920 X 1080P
1920 X 1080P (Level B) #HIES
1920 X 1080i 1920 X 1080i
720 X 486i 720 X 480i
1920 X 1080i 1920 X 1080i 1920 X 1080i
720 X 486i 720 X 480i
1440 X 1080i 1920 X 1080i 1920 X 1080i
720 X 4861 720 X 480i?
1280 X 720P 1280 X 720P 1280 X 720P
720 X 486i 720 X 480i
720 X 480i 720 X 486i 720 X 480i
BES 720 X 480P
29.97 1920 X 1080P 1920 X 1080PsF 1920 X 1080i
720 X 486i 720 X 480i
1280 X 720P 1280 X 720P 1280 X 720P
720 X 486i 720 X 480i
23.98 1920 X 1080P 1920 X 1080PsF "iES

1920 X 1080i (2-3PD)

1920 X 1080i (2-3PD)

720 X 486i (2-3PD)

720 X 480i (2-3PD)

1280 X 720P

1280 X 720P (2-3PD)

1280 X 720P (2-3PD)

720 X 486i (2-3PD)

720 X 480i (2-3PD)

a) JOFVEEHR. BRUTA LU ALANEREAED Z > DEE(L1920X 1080ilCHIDIRDOET,
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38 WESHE: T5—<v hOBRE

VIDEOUwmF DT 4 —~X v NEREKR

VIDEO OUTIFH 5 DHAESF. XZ a2 —D0peration >FormatDEEEICI U T RERDK DI
HAENET,

AZa—®M0peration

Format

VIDEOOUTES 74—~ v I

Frequency  Rec Format(d—7"w & (3&H)

TOFUECER DA 7 L ALANE T EE

AZ31—MD0Operation VIDEOOUTES 74—~ v

OFF ON
50 1920 X 1080P HD-Y HD-Y
HD-Y HD-Y
HD-Y HD-Y
Composite Composite®
1920 X 1080i HD-Y HD-Y
Composite Composite®
1440 X 1080i HD-Y HD-Y
Composite -
1280 X 720P HD Sync® HD Sync?
Composite Composite®
720 X 576i Composite Composite
Composite HD-Y
25 1920 X 1080P HD-Y HD-Y
Composite Composite
1280 X 720P HD-Y"” HD-Y"”
Composite Composite®

Format
Frequency  Rec Format(Od—7F w2 Id&ls) TOFVER DA 7L R LANEREE
OFF ON
59.94 1920 X 1080P HD-Y HD-Y
HD-Y HD-Y
HD-Y HD-Y
Composite Composite?
1920 X 1080i HD-Y HD-Y
Composite Composite?
1440 X 1080i HD-Y HD-Y
Composite -
1280 X 720P HD Sync? HD Sync?
Composite Composite?
720 X 480i Composite Composite?
Composite HD-Y
29.97 1920 X 1080P HD-Y HD-Y
Composite Composite?
1280 X 720P HD-YY HD-Y?
Composite Composite?
23.98 1920 X 1080P HD-Y HD-Y
HD-Y HD-Y
Composite Composite?
1280 X 720P HD-Y"” HD-Y "
Composite Composite?

a) 1080i SynclESEHHLET,
b) 1080PsFESEHH LET.
0) B (R—) \— ViK—X) [FSDI OUT/HDMID R ERETA >/ 4 T [CEB L% T
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38 RECHE

RRTAM TV ILVIDILK

SRR+ —< v MCHDZRETD &, ®iEY
ATZIVIUVVIRINATATZVIUVY
(HDR) E—RICTD &, FdA4FZvIlL Iz
IR L. BT.2020f8H D& Casr o HA%T
AFT,

AHEBE(CIFRIFEDHDR LICENSE (CBKZ-SLHL1)

PHETT,

[TFE]

o MPEG IMXEKXUDVCAMD T 7 A )L T #—< v hCI&
TIRLTWEE A

o HDREZEHIE. SDT#—< v MESIFEATEFE Ao
E5 74—~ v bHSDDHE. HDRICEREUTRRT
HDT#—<wv I\G)*J]HHE‘CHjh*ﬂ?‘g“

o FAFZVIUYIE— ROBREZEET 2HE(E.
EOFv—FrvIalw IHEENOfDIREETIT>T
<fEEn
Operation >Rec Function >Picture Cache Rec >Off

FAF= v IE—R
EREIT D

1 AZa—M0Operation >Base Setting
>Shooting ModeZEIRT &,

? MENUDEHEBILTIAF=v oL
T— REBIRT S,
HDREBIRT B\ A IAF=w LY
F—R. SDREEIRT B ERERDIAF= v
HUYIE—RICEBESNET.

HDREXEDHESR

RTERREF. AZ2—MD0Operation >HDR
Setting CHEER CEFX T sFLIE. 108 R—Y
ECTELIEEL,

HLGT « AT A 72 R biRE

HDRHLG)#EEZFER L CWLWDEE . Ea—T 7
A VI —PLCDEZ Y —([CRRTNDIED D

Y RSRASHDERDYAFZ v I L IR
FOELBRADCERDDFERT, CDXDFE
A, HIGT 4 ATUA TPV A MMERET., Ea—
T7AVF—PLCDEZY—ICEKRT DIED
OV ESRANZBEYICAEIT S ENTEXT,
HLGT « AT+ 72 X b&BEIFHDR Setting
MDHD Rec/OQuth*HDRHLG)ICERETNT LD

EE(CEFHNICBASINED,

FEHLGT 4 RATUA TR Ngem 7 H A
TIWRAYFICEDHTT. BEITIHUTHAE
DAY/ F 7TV vFTYDB|RI DI EN
TEFI,

[TiEE]

AHEEFE 1— D 7 A VY —PLCDEZ Y —DFHBRE
. SCREGOENERICESERINEE A
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38 RECHE

L\

J

FTEZERL. BICREEDREZFSHIC
(F. KRISIHUIET S v oINSV AERDTA b
NSV ADBFEEDNETT
FETEISHFBRINOHAREPIREEF. &
BOAEU—(ICERBSN. BERZV > THRS
SNET,

Jov ISR ZEFHET
2

RDRDOHIBEICHABNNETT,

o AEENDTERTDEE

o RIFBFEALIEN SIEICERTDHEE

o FHEDEENKIEICZE(L UTSIKR CERT
EE

e XZ1—MOperation >Gain SwitchTGAIN
AAVFICRELTVD T A ME (LM/H/
Turbo) ZZEB U & &

BRE. BRZEZBUANC

WEFHDOFE A,

Sa COREUETY

TovOoNSVADBEEREREE. TJovoty
b TSv ISV ADIRICETENE T, T
SvIINSVRAIF, REAZ1—DBRMEICELD
CFHREISHCEDHTEFI,

TOBER. TS5y oINSV ADOBEEHEEN
TEF A

o SCERH

o RAECIRT— NS

o vy HI—FE—RHSLSE— FDBE

| OUTPUT/DCCRA v FECAMIZT B0

2 AUTO W/B BALZA A w F7ZBLACKRIICH L
T, B=#T,
SRS [Executing...] ERREN. [OKJ
[CEDNIIIET T,
AREFEEHNICAEY—(CEREBINET,
[CFE]
o JSwINSYREEHR. KDIFEEMIELIREIC
BFOET,
o JSvINSURARD, A YDEZ BN EE
HNICEE, Ea—T7AVF—EERLEICTY Y H—H
HO|RNF TN, BETEHDIEA

2y IINSVADEERH BN TE
FNEE(E

I35 oINSV ADBENERICKT LD >
feEEE Ea—T 74 VY —BEECHI3HH
IS5—AvE—IDRREINFT,

IS—Xvt—Y Fik

NG: Iris not Closed L > XDEDHERE S
Dofefesh. BETEL
holc,

NG: Timeout FESNIFRRELOIHLINT
AEMET LED DI,

FEDIS— Ay E—IPRRENCS. BE
TSv ISV ADREBZEAS T EE,
BORUARZASI CHIS— XA v E—IhK
TENDEEIE, NEBRRZET DMEDDHD R
ER

€ NMERICDONTIE AVFFYRAIZaTIL BIF)
ZCEBELEEL,

[CER]

LY XD — I IVHLENSIRFIC U oD DR 1T
WEWE DY XDID DNECIREEICIE ST, TS5 v I
SVRARIIS—THEDET,

VIS VR RDA MNNS ADEREE

ROA NS RZEFHET
8

BEARHNAZED O EEICIE. HTHREUEL
TLIEEL

| UFD&3 21 v FRRET B,

e GAINAA wF | L(TEBDRIFINSVI A
VEICERTE)

e OUTPUT/DCCR-A wF : CAM

o WHITE BALRA wF : AFTz(FB”

1) XEU— BICREELZESNDDIE. XZ21—D
Operation >White Setting >White Switch<B>
HMemorylCERESNTVD EEDHTY,

) BBESEEICADET. FILTERDEHDRTE
EYIDIBR B0

3 WEHOBENEEFCREDETBITK
DAY=V ZBEE. X—LT7vTLT

BIEICHZIRT,
WEEODELDOBWVED (B, BE) TR
R8I L&BTEFT,

B/\RAEFHDEEE. HDEBD T,

BEETYY—ZHRLETDRATE
BZLDOREF. BEDOSE. FlE@D70%,
CORBEAIC, BEEED 0% EOBIE
DEBE,

|
v

[CFR]
RAEANICEEBEAR Y MEANEVKSICLTLE

=W

4 Uyzomp#EET 5.
FETROEAETHEE | KO AEELE
[Cabhtd.
F— P A URTRD ZERT D158 -
VXD B8 FETHRAA v F =
EEHCHED Do

5 auto W/B BALAA v FZWHITERIICHE L
T, E=BET.
FEEA(F [Executing...] EFRRETL TOK:
WEEROERE) | ERRSNNIEHKETT
ER
AEBIE. FIE| TERUEXEY— (AR
f2IEB) [CEEMICEIRENE T,
[TEE]
Ly mgde. \YFoIVRECITED DD E
Fo TDEIFBAIF. UYRSHNTVDRO DY

AVDFHFH (G IS. SHEERREINTND) ZHE
LT<LrEeEby,

NINIFVD F— b TP AUADIREZERDR L.
BRIRNBE<IEDTeDBRD <IEDehTBHT &,
® U LYADERHBAEZECEEE,

ROA NSV ADEERFEN TE
ENEE(F
ROA NSV ADBEARERITHKT LED >

feE=F, Ea—T7 A V9 —EmEIck3UE
IS—Awb—IPRRENET,

IS—Avte—Y Ek

NG: Low Light ~ BDBELNILIMET T2,
LY ZXoRbZRITeh. &
A7 T,




3T RELREE TSV IINSVRSIRITA MS Y ADHEEE

I5—Xvt—Y Ak

NG: High Light EOBMELAILAET X5,
Ly XEgdh. NDT 1)L
9_%2260

WERRIAOBRENSIE
THRETEED oz, RAD
BEREZRHELT. XEU—
ZEBHT Do

NG: Color Temp.
High

NG: ColorTemp. #HEFRAOERENMETE

Low CHRETEEN o, HREAD
BREZERHELC. XEU—
ZEHT Do

NG: Out of REEEEEBEDENKE

Range <. BEHEEBR T

&, FEETEED oI,

BEARDADEBENHRT ET
FHETELED DI,

NG: Poor White
Area

HERFBANTREINMET UK
Mofeo

NG: Timeout

FEEDIS— Ay E—IPRRENCS. BE
ROA MNS Y ADFBZEHAS TLTEEW, 1
DRUARZERS CHIT—X v E—INERR
SNBDEEE. NEBRRZET DMEDDDET,

€ RNBERICOVTClE, XVTFYRARZATILETE
<fEEL,

RO A MGV A7ZHET HEEH
IFNEEF

WHITE BALA A F7ZPRSTICLZE T

NDZ « LY —DEIDRAICEDET
EREZEEI D

BSHCC (BMIE) 74 )L5—ENDT 1 )LF—
(5R—Y) [CEIDYTBTECKDT, ND
T4 E—DYIDBR(CEDE CERREREE
THTENTEFT,

1 X Za—MmMMaintenance >White Filter
>ND Filter CTempZ2OnIZsEET D (125
/\0_;/\‘)0

) BRHICCT 4 L5 —=FITERDEBDIK
IV 3 VESCEIDHTSEFEND FLT
CTemp<1>7%, RIY 3 VES2 ~ 4(CE|
DT HEEEND FLT CTemp<2-4>%3%
R B,

3 MENUDEH%E L TAZDEREEZR
%,

A pBECRUT. FIE)E3EEOET,

BXBICC (BFEIE) TAILY—=Z7
AT TIVAA v FTYD]RZ B

BRINCCT 1 LY —DEI DR HREZ 77U A
FIWAAVFICEIDHTDIEICKDT, 7
AT TIVAA Y FEHFIOICRARTED
DRI 32 (A~ D) [CRESNCBRE
(3200K/4300K/5600K/6300K) ZtNDIRZ 2
ENWTEXRT,

1 X Za—MmMMaintenance >White Filter7ze
EIRT D,

2 CCOoANE—BRELEVRYY Y
Electrical CC<A> ~ <D>7ZER U,
MENUDZFEH7%Z[E U THEDEREZEIR
9%,

BREZFELUEVEEF. Electrical
CC<Co. <D>DFRERFC [ ZRIRL
E

PHAFTITINAAvFEBLTH., ZDIR

VY aVDRERFERSNE . &R
[F 1DOIRIY 3V ZRE LIS
ElF. 3DDORIZ 3 VOYID|R(TIEDOF
a—o

3 BBCHUT. FIE)EBDRT .

4 PHAFIIVAA v FICBRHCCT 4L
&—DE)D IR #AE (ELECTRICAL CC) %2
DYTH (136~—),

ROA RNV ADAEI—[CDL
C

XEU—[CERIBENBIE. DB RZY] >
TeREETH. BERDA M\SURZREITD
FCTHRESNF T,
MRIA BINSVADAEY—IF. Al BD2RER
Hi&s O WHITE BALAA v FDFRE (AFTz(EB)
[CHIHTDXEU—IS, NDTAILF—CEDHR
BEZEENICTESEHIENTERT. &
BF4ADDND T 4 LY —ZWE L TWVWSDT,
GEt8E (4X2) DFBEZELECEX T, e
L. RO\BE. XEU—DOASIENDT « LY —
([SEE LR B Ao
e XZa—MOperation >White Setting
>Filter White MemoryZZOffICEREET D T &
[CKDT. Al BERHFDXEY —#7% 18I
FBREULEEE
Fle. XZa—D0peration >White Setting
>White Switch<B>ZATWICERET D &.
WHITE BALZ A v FHBOAIE CATW (BENE
BRDA MNSVR) BEIfEL. BREARHBDZE
EICIH U CTERDIR T A SV AN EENER
LET,
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Vv —F—RCDULT

THOBFY vV I —CREATEDY v vF—
E—RE BRTEDY v v —RAE—RER
DEBDTY,

[TEE]

RM-B1707x&EDUE— IV bO—)LA Ty MEGRE.
FEE— R (Speed) DHEIRTEFT .

BEE—N

BEDRVESHZEHRIRRE LIcWEEEE
[CEALET,

BTy v v I —REZHRET DSpeed (X
E—R) E—REHEBETY v —REZR
EJdBDAngle (BE) E— R ZEBRTERT,

BfYvvI—DEE

AngleE—H
180°. 90°. 45°, 22.5°.

FCS (3RS U P A+ v) E— R

TV —EEZ. KFHEOBREROHENR
SICEBRUCVWEEFEICERLET,
RERIREIE Y v v F— A — RO&E(F. A0—
S8&TAvIE—Y 3 (S&Q) HEEDZH T/ F >
[CRDT. REDKIICEDDET,

11.25°

AT L Vv —AE— R (84 : Hz)

BRES seQ: A7 SRQ: AV
5094 6000~ 7000 —

5094P  60.00~8000  60.00 ~ 8000
2997P  30.00~8000  30.00 ~ 8000
2398P  23.99~6000  30.03 ~ 6000
50i 5000~ 7000 —

50P 50.00 ~ 7000  50.00 ~ 7000
25P 2502 ~7000  30.00 ~ 7000

SpeedE— K

VAT VvyI—RE— R (B8R
R

59.94i 1/60. 1/100. 1/120. 1/125.
59.94pP 1/250. 1/500. 1/1000. 1/2000
50i

50P

29.97P 1/40°. 1/50%, 1/60. 1/100.

1/120. 1/125. 1/250. 1/500.
1/1000. 1/2000

25P 1/33%, 1/50%. 1/60. 1/100.
1/120. 1/125. 1/250. 1/500.
1/1000. 1/2000

1/329, 17487, 1/50°. 1/60.
1/96. 1/100. 1/120. 1/125.
1/250. 1/500. 1/1000. 1/2000

23.98P

a) AD—&ITAVIE—YavVigER. XZ1—0
Operation >Rec Function >Frame RateZZ2> X5 s /&
BEEDOKREWVMEICREL TV GEIFERTERE
Ao

SLS (RO—RE— Ry v 5—)
TR

REREOREFZRS UTcWEEITERLET.

AO—RAE— Ry vy 5 — DRI L — LA

L. AZa—DO0peration >Slow Shutter

>Number of FramesT2. 3. 4. 5. 6. 7. 8.

16D S5ERLE T,

[CER]

o 2AO—8 U4V IE—YaViREhE, SLSE—RZEEE
A9dZLnTEEEA

o SUERARICSLSE—RNZEFY FTUIED, BETIL—L
HEeEEITHENTEFTEA.

Vv —FE—RK/"T v
F—AE—RZERETD

[CER]

o RONBEBIDEERG. Vv yI—AE—FHNELED
[EDN. WODFREE. HERRELEILEDET,

e BIRCEDY v v I—AE—RF. RESNTWVDY
AT LEARBICE O TEEDET,

SpeedE— ~FEANngleE— FDYID
|z

] A Za—®D0peration >Shutter >Mode”
ERT D,

7 MENUDZE#H%EEUT. Speed=/zla
AngleZZERU. DFEHZIT,

Vv —FE—RBKLOV v vI—
AE— R (BEE—R) ORE
—EBRUEY vy Y—AE— RiE, KOS
BRSO ToREE BRI NET,

| SHUTTERZA wF %, ONDENLS
SELECTRIICI®T
Sy H—DEEDRENE 1—T 7 A
S —EEICH3BEETINED,

2 FIE|OERIHZBAIC. HI—E
SHUTTERR A v FZSELECTRIICH T, &
BEDE— REFAE— ROTREND S
T. COBREEEDET,
FRTDE— REAE— RBFETENDE
ald. LTOIEFTRRIMIDBDOET,

SpeedE— K (VX T LEEEL : 59.94iD155
DRI
|

tuso-»moo-» -»1/1000-»1/2oooj
ECSE—hk

[CFE]
AO—8&IAVvIE—Y3aVE—RROTU—LL—K
DFREICLDTIF 5IN—=V). BEDY vvF—2R
E—RFOERTELLLEDTEDHDHRT, BIRTELEW
Vv wI—AE— R BRIUBGRDEVLY v v 5—X
E— RICESHDOET,

XAVC-I T080P/29.97P. 7L —LL—K60TR

O—8&74 vIE—YavViREATIBEOH:

e XAO—8&UAvIE—Y3avE—RK F7
1/40—1/50—1/60—1/100—-...

e RO—8&IUAVIE—Y3VE—N FV
1/60—1/100—...

TV wI—AE—RK(ECSE—R)D
Bl
axX AE
| vrws—F—REECSICHET S (31ES

|72
E)

72 MENUDEHERELT. AZOEREES
TEE B,

Yy I—AE—RKSLSE—R) D

==

ax kB

] AZa—M0Operation >Slow Shutter
>SettingC. ¥ ¥ w¥—E— RZEONnICEHE
g—%)o

2 A Za—®D0peration >Slow Shutter
>Number of FramesT. ®EDT LU —LH
EERT D,
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T— 74 UADEE

EHXDOWEREBEIEFHD S THRDEEP. X
Ry bS5A bHETOSNREHEDEDISIUL
EZHSETEE, WERDORARMAFICELOT
(37— b7 AU RADREZEEZE T DUENDD
EER

FT—bh7AUXDIEE—
NZEET D

FT—hPAURATUNVAR T EE(CERT
DEEE—PERELE T,

1 XZa—@0Operation >Auto Iris >Mode%
BEIRT D,

7 MENUDEH%E L TEWEE— REZIR U,
DERHZHT,

EWEE—R  EifF

Backlight WCRREEDIRF(CEUICE—
I\

Standard BEDE— N

Spotlight FIDEFDHEEHICAIRY b

A DB Ieo>TVNDEE,
HENZEHITDE—

F— b7 AU TOINEE
ZINIVZEERTET D

1 X Za—M0Operation >Auto Iris >LevelZ
BRI Do

7 MENUDEHEE L TLAILE—99 ~ +99

DEHETERL. DFRHZEHET,

WERERLUA)L 58

—-99 2RO DL LEESDICERET
®

+0 BEDLAN)Y

+99 2RO LU EBRD 8 ICERTE
ERR

T—h7AURDAE— K
ZEE I B

FT—hPAURTUNVZRET D EEDEE

REZRELFT,

| X Za—@0peration >Auto Iris >Speed
ZEIRT Do

7 MENUDZEH %R L TEIfERE %
[—99] (BHEL) ~ [+99] BHEL) D
ETRRL. DFHEET,

7

LY A0 DE#EEZ=ZE
ERR)

L X DEEEMEF. BB L TORDE

HICERECTEETD,

o +0.25 ~ +1(0.25%d) © #1+0.25 ~ +1#D
PDRTEHTIED,

e —025~—1(025%d) : #1025~ 1O 7
BUEHCED,

Fle. Z—h7PAURDNRELDEEZHRTE
LCHBELIEBTEFET,

| X a—MO0Operation >Auto Iris >Iris
OverrideZzOnIZERET o

7 MENU ON/OFF2 A wFEOFFICT B

3 MENUDE#%E L CEEBELEEET 5.
[CEE]

TDEE, YpyI—E—RHECSUADE— RIS
BoOTVBT EERRLTREL)

REOEEBIF. Ea—T7AV5—EHHE
DPAVRRIY 3 VvFRR(17R=I) T
fEERT & ENTERT,

o ROZERMEETHICTBHBAIF. MENUD
FHEAKIEEN SR CREFAEICE
LET,
+0.25. +0.5. +0.75. +1DOLYFNHIC
BRELET,

e ROZFAUEHCT DHEF. MENUD
FHEFEIEERN SR TR ABICEU
EER
—0.25. =05,
[CREULFT,

—0.75. —10oLFNH

ZBEUCREEFERZYOFT THRIIN
FI, BEEZZEELTCH, ERZAND
TEUICHREBICRD EJ,

T—hh7AURRED 1~/
NDOZERET D

| %= a1 —®@Operation >Auto Iris >Detect
Window IndicationZZOnICERET %o
Ea1—7 7425 —EELICREEREIN
TWBF—bTPAURT 4V RODKRRSE
NFRI,
FT—bTPAURDT 4 ROEBICRRULT
BLEDFVNEEIE, OffCRELE T,

2 A Za—M@O0peration >Auto Iris >Detect
Window2:ZiRd 8.

3 MENUDZE#EE L THREDF — ~ P4 U

A4V ROZEBRRL, DEHZIRT,
1 2 3 4 5 6
XDMEENTERCHZIRET D
Varz@&siE, REROBEEDEMELED. &

BOREEDD 4 ROZRERCTEF T,
A Za—M@0Operation >Auto Iris >Iris Var

Width. Iris Var Height. Iris Var. Iris Var
H Position. lris VarV PositionCeE LT
\Qaray A

1B RTE

Iris Var Width D« > RODIE

IrisVar Height D« > FoOaE

Iris Var H D42 RODEABADAE
Position

Iris Var V D« > RODEIAOAME
Position
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38 RELSHE  A— b7 UADERE

AXZ2—7ZETIdE. FIRSTERLICA —
EPAVURD 4 ROPRRENE T,
BICRTUCBLKBENFWVEEIE, X 21—
MOperation >Auto Iris >Detect Window
IndicationDEREZOfICEE LE T,

SEEONELICRDORE
BRCtED

EEEOBBENA > CEfcdA— T AU
HEAUTECEHMICELZEDTE. EDi5N
EVDREBICHED CERDDFET, TDXRDE
BalE. IS4 boU Y THEEZONICERE

ToE. HHUNIVRIEDBDICIU v TZH
3C. Z—hrTPAUINDHEEZRHT D&
WCEFXT,

XZa—@0peration >Auto Iris >Clip High

LightZOnICERELF Y,

PXW-X400KCfTEL > X
D7 AVRXT A 2/ FHEE

| P URBEE— REBR R A v F A
(F— M) fIICT B,

) PAURTAVREENIN—D I LF vy
THEHL B

3 FPAURSAVREERNIT—% RS54 )—
BETEL. BETS.
B AEICET E. XA VDR ET,

REEtABAICET & 74 VA D ET,
VY ZAREDT AU Y T2 BIEHS.
AEL TS,

4 HpFvvIETICRT,



050

38 RECHE

T #—HNADEEE

PXW-X400KFIBL ~ X7Z R LTV SHBED
T4 —HADRFECDONTHALET,

[TxE]
BERIEICLD T4 —HWADBBEMIET B/, MIBE
(c0) (IBICIFRIERLBTVET, MREOHEHE

MF&ETzldFull MFE— RTIRF I 25BaE. Ea—T 74
VI —THERUENS T+ —ARZEDLETLIES L,

Full MFE— RCHRIET D

T4 —=NAV 2 I%%TT (A (S51< EHBIC
NZa7ITIA—=NRAZEDEDFUll MFE—
RICHEDET,

[T

TH—ARAUYIEEFICASA REEDE. T5—HR
D EBROAEICHEIFCRELET.

Ea—T7AVF—ZRIENS, Tx—HRU
VOEBIULT I+ —HRAZEDEFT,

Full MFE—RTIE, UV I DEEBEEENENT
To Jd—HADEDEHEIEI T+ —HAUVT
DAEFIRIBICHIRLET

=%y
Ea—T7A4>25—DOPEAKINGDERHZET
& E—FVIREDBWVTC. EZY—EBRD
WMEHEAEIN. XZa7ITDT+—HAH
EHBRZICHEDFT,

RSN DRESICIIRE LT B A,

A —NAU YIS

Ea1—T7 AV —DEGZERIENS. T+—
ARV IZBLTC T+ —HRAZEDEET,
MFE—RTIF. UV I OmEBEHERFEDEED
%jc

DTy aAd—hTI7F—
A

PUSHAFR& VZBLFE T, —BFICA— b
TH—NANEELET,
D TIvyad—hT4x—NRFE TH—HA
WEOIERRTIRT L&D,

MF77 2 X bRERE

MF7Z 2 X bBEZZONICL THL &
(135R—=I8R). Tx—HAUVITD
TF—ARAEGDBZLEDBRCTET— b T 71—
AADEE L. BEPREBOFESEITT LT
D4 —HNADMEBE (T 5 —HADELIAH) Z2
TWLET,

MERBDHE T VTR TMEZ Y A BMIKD
FT—bTF—HDRAEEFHET LE T,

AFE—RNTCHEID

TA—=NAUVIERFICASA REE,
FOCUSRA wFZA(F—RH) ICTBHE. BIC

FT—hIF—NRZEBHEDIENTEDAF
E—RIZEDET,
AFE—RTIF. UV T DIERIEREEN LD
F9,

NOOE—M2ED

D #—NARBEE— ROMFERTCIFAFD EEIF.
MACRORA v FZONRIICTHENYIOE—H
[CIED. YOORGZSHIEE TDT +—7]
ZREDEIREICTED &E T

NOOE— M Full MFE— R TERERNITIED
&9,
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ae= UNIVDFEE

AUDIO SELECTRA wFZAUTOICT D& &
F v VRJVCERSND 7 FOTEHESDA
BUNIVISEERICHEESNE T, Koo FE
THEITDIEHTEFT,

[CEE]

AUDIO SELECTRA v FZAUTOICLTH. TIYFIVER
BEEDANUANIVEBEBHBENE B A,

FERFHRROER L ANILD
H#&

—20dBZEZRICHELET.
BEUNIUX—F—D0 dBETERRINSLEE
[F. AHBEEDEKRCTT,

BAAT

BEOER

AUDIO IN CH-1/CH-2im
TR ODEREUNILZFE)
HEID

| AUDIO IN CH-1/CH 2 F~ADAHES
IR, FELWF v RIUICIENT S
AUDIO IN CH1/CH2Z A w F%#REARIC S
50

1. 2F v RLEBECER. AETDHE
(F. @mADAUDIO IN CH1/CH2R A v F 7%
REARICT %,

) FIE TRARTF > = LDAUDIO SELECT
2 wFEMANUALICT B0

3 FIB| CRARTF v RILOLEVELOEH
T, EEDANBEDE EDEELAILA—
45— =20 dBETETRENB &S CHET
%o

sCiR UNVDIAEICERT 9 DM
DR

XZa—MMaintenance >AudioC. AUDIO
IN CH-1/CH-2ImFICANDENDEEDECER L
NIVDFFEEZEDDFRHFTITIDON. BERTSHZ
ENTEET, EXZa1—BEHDRTFEEEDE
HDOMMIFUTDESDTT,

[TiFE]

AES/EBUT I ZIF —F « FIESEANT DBEIF. &
HTERRUNIVERZTS LI TER A,

Rear1/WRR Level : 7+ >x)L 1 D2z

RIEME DEH

Side1l LEVEL (CH1) D&

Front MIC LEVELD&E
Front+Sidel LEVEL (CH1) D&EH+EMIC

LEVELDFEHDES)

Rear2/WRR Level : 7+ 22U 2 DRz

SRIEE DFRH
Side2 LEVEL (CH2) D&+
Front MIC LEVELDZHd#

EE OFFH EE oFFH

Front+Side2  LEVEL (CH2) D& &EMIC Front MIC LEVELDZ 3+
LEVELDE HDiEE) Front+Sidel  LEVEL (CH1) DEHEMIC

- LEVEL DEHDEE)

LEVEL (CH1/CH2) DEHEMIC LEVELD R HDER) = E
RUHBE MIC LEVELDEHD0JICRENTL D EF +
VRV, 20BFEEEF CEFT T, MICLEVELDEH
DAEZEHER L TN S, LEVEL (CH1/CH2) DX HTHE
LTLrEeEL,

MIC INimFD 5 DEF L
NV FEFET D

| AT 2F v RILDAUDIO INZA v F 7
FRONTICSRET B

) FIE TRARTF v =)LOAUDIO SELECT
214 vFZEMANUALICERET Do

3 MICLEVELDEHEBUT, BEOASE
BOEEFFUNIUA—=T—H—20dBET
KRESNBOLDICHET Do

soixk LUANVDIRZICERT 2 DEH
MDER

AXZa—MMaintenance >AudioC. 7O k
NAODOANTHEEDEERLANILDFEEZ
EDDFEMHCEIDHTINZRECEFRT. &
XZ1—IEEDFREBEE DFEHFOMMITLLTD
EBDTT,

MIC CH1 Level : Fv =)L 1 DaEiRLANIL
DERHM

REE

Sidef1 LEVEL (CH1) D&+

MIC CH2 Level : F+ =)L 2 DL AL

RTEB DEH

Side2 LEVEL (CH2) D&

Front MIC LEVELDZ d+

Front+Side2 LEVEL (CH2) D&FEHEMIC
LEVELDFRHDiES)

[TEE]

MIC LEVELDE+&ELEVEL (CH1/CH2) DXRFHDES) = E
RUTHE. LEVEL (CH1/CH2) DEHD0] [TRSNT
WdEFvRILT. 20EFENEIRCEFTEAL LEVEL
(CH1/CH2) DFEHDABEZ R LTH S, MICLEVELD
FHTHRELTLIZE L,

Fv )3 AICERZ
50EX 9 D

| sEFroRL3. scEEnNBESE.
AUDIO IN CH3/CH4R A v F CEIRT D,

CH3RAvTF F¥URILIDEFHR

FRONT 70V A 20K DOER

REAR AUDIO IN CH-1i#FIC AN
SNHEFRES

WIRELESS DAVUVARA 20K DE
=

CH4ARA YT F ¥ URIVADEFEHR

FRONT 70V hRA 20K OER

REAR AUDIO IN CH-2i#FIC AN

SNBHEFRES




052 3F BRELHFHE: BEUANILOFEE

CHARAvTF FvRIV4DFTIFHR
WIRELESS DAVYUVARA IOV DE

==}

/) EEEEETB(CIE. AUDIO SELECT CH 34
A4 wFZAUTOICT %o
FEFAE T DICIF. AUDIO SELECT CH 3-4
A wFZMANUALICULT. FEIFTUTD
BREZET Do

3 LANLBEEFS DEHE, X"1—0
Maintenance >Audio®Audio CH3 Level
BXUAudio CH4 Level TEIRT D,

Audio CH3 Level : Fv>=xJU3DEEERLAN

1Y
SREE DEH
Side3 LEVEL (CH3) D&
Front MIC LEVELD &+
Front+Side3  LEVEL (CH3) D&d+&MIC

LEVELDFHDiES)

Audio CH4 Level : F v x)L4DECER LN

b
RIEE DEH
Side4 LEVEL (CH4) D&+
Front MIC LEVELD&E ¢
Front+Side4 LEVEL (CH4) D&Ed+&EMIC

LEVEL D& HDiEEEN

BRETvURIL3 4DERELNILA. T
TERUEDEHTHBECTEDHRDITIED
FIo
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A LT —5DEE

YA LI—NZERET D

54 LO— FORERRESEHEE. 00:00:00:00
~23:595929 (8 : 3 W TJL—L) T,

1 DISP SEL/EXPAND/RY =B LT, LCDE
ZH—TZERAT—IAKRRIHIDRZ B,

7 DISPLAYZA wFETCIZT B

3 PRESET/REGEN/CLOCKZA v F%PRESET
(LT Do

2L F-RUN/SET/R-RUNZA w FESETICT B
YA LO—ROREMDREULET,

5 FFEERY Y THIEEEEL, FEEH
REVTHEBEILT, TNTCOMERE
T2,

#E7Z00:00:00:00lcU v hTDICIF.
RESET/RETURNRY 7= UE T,

O HEOMBICHE Uik, F-RUN/SET/

R-RUNZA v FEIDHA 5.

F-RUN : 4 LO0— RIFBICHET D

R-RUN : ¥4 LAO— RIFEERFICEET D
[TEE]
EOFv—FrvIalwvIE—RDBBEREEEE.
F-RUN/SET/R-RUNZ A v FZSETICLTHY A LT —5
DEREZTICEFTEFR. M LT —IERETD
Sald. E9Fv—FvwvIalbvIE—REFTICLT
<rEEL.

DF/NDFDYID X

X Za—MMaintenance >Timecode >DF/
NDFT. DF(ROvZ7TU—LE—R) /NDF

(/2 ROvITIU—LE—R) ZUDIRI D
EDTEFT,

YA LhOd— g ED(CE

F-RUN/SET/R-RUNZ A v FHR-RUNICERE S
NCLBEEE. ¥ L0— RIFER U T
SNET, LU BRTAT ¢ 72338 LT
SIZETDE. BUTDXT 4 PZANTHY
A LO—RlE&ERLEEA.

CDELIFEEF. PRESET/REGEN/CLOCKR
A wFZREGENICT D LT A LO— FaEifiE
BHTENTEFRT,

YA Ld— RICERZIZEAND (I

PRESET/REGEN/CLOCKR A w F7Z&CLOCKIZ S
BE. FALO—RICREADPADET, R
2 IFAHEOABEETORZIDRIRENE T,
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[T3ER)

o A0—8&T4 v OE—Y 3 VRS DB R EE
HEBSICEATEF A,

o 20—854 v IE—Y 3 VERRICORSTRE R
BEEEMICTDE. AO—&IA v IE—Y3VIEH
BNICHERINE T,

o ECIRP. BER. YARAIERTHRIE RO—-8&T 1Y
JE—YIVERECEF B o

o AO—YvyvF—RERE. AO—&IAvIE—T3
VERECERE A

AO—8&TAvIE—Y3VigeEd
FaA

[BARIE] (55X—Y) [T TR ZITV
?a_o

SiRERBRTSE. Ea—T 7 A VY —EHED
[S&Q Stby | FRH [@S&Q Rec] [CIEDFE T,
WEOERSEERIC, TALLYS >, Ea—
774V —pEDYU -5V THRALET,

BREZIR T BICF, EREIEORIFZITVE
a-o

(TR

JU—LlL— RIS UME BN T L—LL— P ICRE
THE. RREBILREET > TH SRRERLETHETD
BENREDFT,

AO—&0AvIE—Y3avVE—R
DFERER

SCERMFHETIC. A Z 1—MOperation >Rec
Function >Slow & QuickZOff[CERELE T,

SCERFRDBNFHIFR

e NEYA LO—RITRU—F—DHEE—
BlE. F-RUN/SET/RRUNR A v FODEREICES
D579 R-RUNE—RICEDET,

o BETLU—LU—hEELDERTIL—LA
L— hZERUES. BFEEEERSNEE
huo

o Ly oL 1—8REFTAEE o

o LRIL—LL—hZEREDY vvF—X
E— FOREELDZEMEICETITDHE,
¥y I —RAE— NIRE A REERDEVNME
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[CEESINET,
Bl TU—LU—h32TY vy —AE—R
1/40DEEIC, T—LU—RES5(CEE
THEY vy I—AE—RIE1/60[CEESN
Do
Fle s L—LU—hEDEVY vy 55—
AE—RZEBIRT D LIEFTEFTE s

e OV IEFNNIDEEA.

Uy TAV T 42T R
L Utee7 (& o TR
)

WBIFEERAER. BLEOOICI DO YT
DR UIET 7 AILEVTERSNETH. &
UwTAVT 4 ZaFP ALy OMEEZERT S
& EREFBLEZROBRLTH, HEENELES
FlFERENDF CTERLIZI DDIU Y T
EWTBDIENTETT, BT U Y T=EHZ
LEMULKBVWEE RclFEIETEDIU Y
THOLRZEHUEVWTEERUIEWEE(TE
FISHERET T,
SEOFBRICEL Y IR — Y —T DR
SNBeH. ECRRBRUEDRRDESZ CTI .
THEEIF. FROETA T4 —<w b (41R—
V) [CRESNTVDBEICEM T,

XAVCH

XAVC-L

MPEG HD 422

Uy TAVTAZaTALwv oD

=)

ax AE

] AZa—MO0Operation >Rec Function
>Clip Continuous RecZEiRT %,

7 MENUDEH%EE L TONEZIRL. DEH
T,
AEFIAVFT A Za T ALY IE—RIC
O, Ea—J7A 5 —EmETIlCont
Sthy] DFRTHETUET,

[CEE]

o JUwITAVT 4 Z a7 AW IIEEDSERECIFHEARE
HENERICERIT S EEFTEEZEA,

o JUwIAVT 4 Z a7 A IFERPICAIDRERSD
FHEEZBMICTDE, U TAVT A ZaP Ay
JFBEECHEREINE T,

ASSIGN. 1/2/3 XA w3 . ASSIGNABLE 4/5
AA wFEONLINERZ (ICOUY TV T 1
TaAFPRAVYORREDT Y S F T EEIDHTSD
CEBHTEET,

® U PYAFINALA w FICHEEESID LTS
(134%—) BTE AL,

U TAT A ZaT7 A v Ik
2 DA

[BAERE] (55R—) [T TREZITL
F9.

SERERIAT DL, Ea—T 7 A VY —BEED
[Cont Stby] &' [ @Cont Rec] FRRICED
b&xd,

BREOEFBEERIC. TALLYS VT, Ea—
T7AVS—RIEDSY V-2 TR UET,

[CEER]

e ERfCIFEERFHE ([Cont Stby | RRD AT LTk
BB) [C. AT PZERDbHUIED /v T U—PERZERL
E ATU T DEBEDREICIEDFT . TELUNDKESZ
EOTXT « PERIEET D EIFTEF R A

Uy TAVTAZaF AUy IE—RZEETULTHH X
T4 7ZERDbHLUTLEEW (60R—V),

B, [Cont Sthy] Wil (1B #) LTWSEE(F. X
TATPERDOHEIENTEFT,

BRI T I BICIE. SERELEDRBFZITVE
ER

[CER]

RE2VEEERL TH SEERZFEIELTIRE W,

Uy TA T4 Za TP AL v D
E— RORFER

SCERIFHERIC. X Za—MOperation >Rec
Function >Clip Continuous RecZzOff(CE%RE
LET,

ECERFP R TC (S ECERITFRER DB FHIER

SCERP R (FELERTHERIC I T DREZIT D &

1DDDIEM oo Uy THIMERENEF B A,

ORICEERRZITD & Fhlcixo U w ThEREN

FT.)

e JUWTRE (DU TDOvT, HIFR. &
e lFREIDEE)

o XOv hDYIDIEZ

o SLER A4 —N v bDEE

e POWERRAwTF AT

o HE

o TLARA)VEENDYIDEZ

2MDSXSKXEYU—H—R
([CEIFFICIRMEZECERT ©
([EIFFECERTERE)

ETZ 74— v b (41X=) BFEROL

FTNHOICRESNTVD EEE. B URERZ2

KDSXSATEY—N—NICEHRI DI EDTE

T, BEZTVEDSIRGD/ N\ I 7w T

NOBEFLEICERT HHAETT .

[T5]

o SOXEU—DH— R, ERERICERDH— REART
T4 = N (D) THTEERIELET.

o TPAILYRAT LHUDFE— RDEE(CIE, BB
BTEF A,

o SDA—RIEATEF A,

AZa2—D AZa2—M0Operation
Operation >Format >Format >Frequency
>Rec Format

XAVC-1 1920 X 59.94/59/29.97/25/23.98
1080P

XAVC-1 1920 % 59.94/50

1080i

XAVC-11280X720P 59.94/50

XAVC-L 50 1920%  59.94/50/29.97/25/23.98
1080P

XAVC-L 50 1920%  59.94/50

1080i

XAVC-L 50 1280%  59.94/50

720P

XAVC-L 35 1080P  59.94/50/29.97/25/23.98
XAVC-L 35 1080i 59.94/50

XAVC-L 25 1080i 59.94/50

HD 422 50 1080P  29.97/25/23.98

HD 422 50 1080i  59.94/50

HD 422 50 720P 59.94/50/29.97/25/23.98
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AZa2—D AZa—MDOperation
Operation >Format >Format >Frequency
>Rec Format

HQ 1920x1080P 29.97/25/23.98
HQ 1920x1080i 59.94/50
HQ 1440x1080i 59.94/50
HQ 1280x720P 59.94/50

[EIFFECEREREDERE

1 A Za—MOperation >Rec Function
>Simul RecZ2EIRT %o

7 MENUDEH%E L TONEZIRL. DEd
BT,

[CEE]

o [EIRFECERHERETS & DISIRECIR AL T BRI CERT
BHTEFTEFRE A

o [EIRFECEREEREER R (CDIFIRECEFIEREZ BT T D
&, EISFECIRRERE X BB (CERRR S NE T,

o SCEFAR. BER., HARAIERRPIE. EIRFECHEREAE
ERECEFzHA.

[EIFFECER IR DR A

| H—Rrz2OY FAEBDRASICSXSXEU—
N— RERET S,
SXSAOw FABEUB DACCESSS > ThH
SILET. FePa—J 749 —EA
[ESXSROW RABKUBDT A IVHET
ENET (198—),

) TEARE] (55°—Y) [Cit->TREE
75,

[CEFR]

o EBE5NDAT 4 PICRRDH e, EEAHELE
[CETVeb T 2i55(d. BRERETDIEIET
EFE Ao

o ERECEPIC. EBBN—HDOXT 1 FPHTILICHED
feBE®. IS —HhREUCERZ#T CEER<ED
feEEE TOXT 4 PADEIRISFIESNET T HL
EODXT 1 PADEERIFME SN,

R8T I BICIE. SRELEDREZITNE
a—o

B ECERDREEEDARER

SCERMFIC. XZ 1 —MOperation >Rec
Function >Simul RecZOffICEREULZE T,
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JOF5—%

TJOF27—-5 BERREORET—5
(H.264) £BFT—F (AAC-LO) THBREINT
WET, ZUIFILTF—=FDRDODIC, ERER
EDEREE T O+ T = ZNAIT D EICK
D iR BIBEEEZWERLT D ENTERT,
TJOFIF—=FET U TDEERIFICPROXY
SDA—RFROw MIHEA LFZSDAH— RICECER
SNET,

PROXY SDA—RXOw b

L
18
SDA— RSN 7O+ 7 —572Z3Y
E1—5—ICFdnAA T, TLRICHRENEZHE
RUEh. "RETE 754 ViREZTD L

W TEFT,
TOFYF—FDEIEISXSA T —N— &
BRLCITOEIITIEL, SXSXEY—HA—RK
NODECEREIFRIC, BIRTEFRZRITISL
W CEFT,

AHECTOHTOFVECERICD
LT
o EHIEEERBHESKS X E U —H— REEAZN

TLIEWLE TOF D RIDERIFRIBSNR
ﬂ/‘Uo

o AEDERZANTHHSH358%. LCDEZ
Y—/E1—T 7 A5 —EmEIC [Poy] (Proxy
SDROw b X T« PIRRERT) BRI L. 7
OFVERNITEDRDICIEDF T,

Poy] MU, KTCIFBEKTRICIR ZRIa L
fcima. O+ 7 7 A)VIFERRENFTE .

o SDAO— RZFHEND SR EEIE. BT
PROXY SDA—RXZOw hDACCESSS T
HYEAI LTV &=L TS, D
BREZYSD. FfclFT7OFTEsR/ TA v
L ALANE e ZZ DI LTS IEE L,
TOFTERR T A L ALANEEEE
OFFICTB(lFtEY bP Yy TIXZ2—TRD
BEZITDOTLIIEEL,

- Operation >Proxy Recording Mode >
SettingZzOff
- Maintenance >Network >SettingZOff

o JOFTEER. FEIFDA VL ALANZERH
BEZEBRICUCTWVBIREETSDA— PDIREE
LZ{TD &, FNUCESER (E91-1C0) bk
TENBBEND DT, SEPICTOES
PERRENHZE. SSXEU—H—BAD
SRIFERBICITONT TN, TJOFT T7A
JVFEHRENFBADTTERLSEEW. T
DEEERRETEOBRZES T 4T dE
U ENFET,

o EOFv—Fvvialbwvo, A=)\
Lyo, 20—-8&74A v IE— 3 VEHES
FOAN—ZVIZEMICTHE. TOF
VECIRISFRSNE B Ao

SDA—FICDNT

JOF2 T =Y CERTIRETSR
SDAH—k

o SDHCAXEU—7h—K* (Speed Class : 42t/
UHSIEM S BE - 4~ 32GB)

o SDXCAEU—H—R* (Speed Class : 41 L/
UHSIER I &BE& © 64 ~ 256 GB)

* AETEFSDAO—RFERBELTOVET,

SDA—RDT =< w b (#I8AE)

A THDHTSDA— RZERTDEE.
TF—X Y SO ETT,

T CTHEATDSDN—RIE. AED T+ -y
PEREZRERLTCT 2 —<w bULTLEE L,
SDA—RZZEB U EEITEFEX v E—IDK
TSNHBED. 74—y bUTEARLTL
[fatay A

| X Za1—M0Operation >Proxy Recording
Mode >SettingZEiRd &,

7 MENUDEH%E L TONEBIRL. DO%EH
BT,

3 AZa—M0peration >Format Media
>SD Card(Proxy)Z#EiRd %,

4 MENUDZ#H%E U TExecute Bk L.
DEHEET,
T4 =T v NERFTBHE S HORRE
ANEREINET.

5 MENUDZH#%E L TExecute HZIR L.
DERHZEHT,
Tr—<w NMREDET,
FATh X v — I SR (%) hEme
N ACCESSS Y IhA LY I TR LET.
TA—<w NMET DL, 5T X v t—
IhERENFT. MENUDEHEELT
Xy e—IEELET .

[CEE]

SDH—RET#—< v hTBE, TRTDF—IHHE
&N, BT CEEBA.

BREREDMEST

Media StatusEE (15X—) TSDH— KD
KREEMERIDIENTEFT,
AECTTH—N v hUESDAH— K7
DD AOY NCERT HICIE

S UHNyI7y TZERD . BEVICED
B TIx—< v FUBEBLTERLTLZS,

JOF2 7T —Y %5089 @

JOF+Y 7 —Y7ZEREiERd DICE

SXSXEU—N—REEELTSDA— RCTO

FUT-IEERIDENTEFT,

] A Za—M0Operation >Proxy Recording
Mode >SettingZ#EiR9 %,

7 MENUDEH%EE L TONEZRL. DEd
BT,
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3 JO+vF—yERASDA— REPROXY
SDA— RZOY MIEAT B,

A iR EEnT B,
SXSHEU—H— RICAUIF LT —FhiEE
FENBDEABIC. TOFYF—I T 7 A
JUBSDA— RO [/PRIVATE/PXROOT/Clip
F LY N—([CREEENET.
BEARTTEE. TOFYF—IDIR
HEEMICET LET.

JOFY7—=5ZAUISILT—F
CIFRICEIRCEER T DICIF

YA FTIVAA wF(CProxy Rec Start/Stop

HEEZBEIDHTH T EICKD SXSAEY—H—

REFEERTFIC, BIRTSDA— RICTOFY

F—HEERITDIENTEEXT,

[CFE]

o JOFITF—FBMEREEHICTOF BECERRA
RRESNZHBEIE. KRPOTOFY T—5 (5%
NFICZOIRFEHNAMITSNE T, TDE. B
I TRIENMTONC LTI, TOFYT—H D
DLEFEODFRT,

o JOFYERFECEPIE 7O+ BIHECIRDIE TERIER
ZIIIFEE Ao

O34 5CEDOHIBREIR

DINOREDEFF., JOFVERIFTEFYE

Ao

o A MJ—=Jh (XZa1—MMaintenance
>Streaming >SettingHOnM & &)

e Interval Recth (X Za2—®MOperation >Rec
Function >Interval Rech\OnMD & E)

e Picture Cache Rech (XZa—®DOperation
>Rec Function >Picture Cache Rech‘On®
EF)

e Slow & Quick Motionst (X Z2—0
Operation >Rec Function >Slow & Quick
MotionHA*OnMD & FE)

o XY NI—=DISAT Y ME—R(XZa—
M Maintenance >Network Client Mode
>SettinghOnDEE) KD, XZa1—D
Maintenance >Network Client Mode
>Preset 1. Preset 2. &KfcldPreset 3
>NCM with ProxyhiDisable® & &,

o XZa3—MO0Operation >Format
>Frequencyh'23.98P. hDOperation
>Proxy Recording Mode >Sizeh*HD
Auto(9Mbps). F1zlFHD Auto(6Mbps)D
ET

o BB ERIERTIR T ICBRA MG (XA 22—
(MOperation >USBZ#R{EH)

IR NS T 7 A )LICDNT

o HERFIE[.mpal EIEDET,

o FA Lhd— FBEKRICEHFRSNE T,

o T L— LD IEBERICEERSNE T,

o GPSEBENBIIFEZE(IC. BIRIULICER. S
KULog? 7 A IUHEBFICEEERSNE T o
Log ™~ 7 1 JUI& TRoot/PRIVATE/SONY/GPS]
[CREFESNE T,

JOFY 7 —Y DEciRaE DR

X Za—M0peration >Proxy Recording
Mode >SettingZOffICERELE T

SDA—RDZEEFEHNELTVD
CTEE

EEBBORNEZHOEDESHERRINT T,

JOF2ECiIRRORERE

AZa—M0peration >Proxy Recording
Mode®dSize. Audio ChannelCZNZN. 7
OFVERTI4—N v bDOTA X, TOFVI(C
BRI DA —T A AT vV RIDREZEET
BTENTEFT,

[CFR]

X Za—MOperation >Proxy Recording Mode >Size7#
HD Auto(OMbps)&EzldFHD Auto(6Mbps)lCLT. &
T LER#EZ29.97. 25, 23.98DVVFNHIC LIZBAIF.
SRETA T4 —< v bOET A XH1280X720TdH >
TH., TOFVTF—FDET A X(FE. 1920X1080IC76D
EX

O/ 5CiR DR E R

AZa—M0peration >Proxy Recording
Mode®Frame Rate. Bit Rate CTZNZ1. IR
BIU—LL—b BEE Y bU— bOREE
ERITHIENTEXT,
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TSI FT—5

TV IXIT—H L IR - SearDEr

EIERD RSN TVBDXMLT 7L TT,

TSV VIAIT—=IT7AILT. HHHU

HERLUICOU Y TRZPY 3y NY—T 2%

AUT, Bz ENTEFRT,

TSI XFF—5(& [Content Browser

Mobile] 77U —2 3 V&2 FER U CGERET

HTENTEFRT,

[CFRE]

o JUWITEPY 3w N—UZDERICIFE. XZa—
MMaintenance >Language TRE LILEED T 74~
My hEERULTL RV, AEDSEETE SR
PEBEMEATDIE. XFPERBICRRINEWVEGE
oD ERT,

o AXFBCI/UYTZPY Iy N—UZEERITDE.
—EBDXFENMED T #+ >~ MBS 5N Ea—T7
A VY —EEICE USERRSNHEVT ERHDFET,
LCDEZY— (RT—FRERE) [CE. PILT 7Ry
b BT BSOHRTCEFT,

gy JERRIC TSV
VORI T T A )%
HALADA—F—DXEJ—I[C
FrdrAD

| EBICSOXEU—H—RICTS V=2 %
FT—FT7A )7 RFT Do
TSV IRIT—=5T7 AUl
[General/Sony/Planning] D5« L7 k
U—[CREFSNTVERT,

J SSHAEU—H— RERDY FAFTIEBIC
BAT B,

3 XZa—@0Operation >Planning
Metadata >Load Media(A)F/zl&Load
Media(B)Z:#EiRT Do
T7AIVUX MEENRTENETT .
DR MCFRROAMED TS Z 2 TAS
F=Y T 7 AIVPRRENE T,

4 MENUDEHZEBLTI7AILUZ RS
SEHABENT P AIEBIRL. DEH%E
Y,

5 MENUDE#EE L TloadE&RL. D%
HFEIHULTH S, ExecuteZERU T, DF
BT,

[CEE]

BIFED DX T ¢ 7775 75— MEAD-SDO2Z{ER LT

SDXCH— R\ TSV VI AXITF—H T 7 A )L

AHET, 122U, SDHC/SDA— RS DFEHAHFT

EFEHAo

IPANTE TSV Z2 T X
5T =5 DsFllIBHRZHEST
ERR

TEDODAEY—[CHRHANIET SV ZVTAS

F=IDT7AIBPERBE. Y4 MUEE

DFFHIEHRZHEE T D ENTEFRT,

] X Za—@0Operation >Planning
Metadata >PropertiesZZ:EiRd 8.

7 MENUDEH7%E L TExecute H&R LT,
OEHEET,

TSV VI AT =5 DsHBIBERNERR
SNEY,

15H 5%

File Name T7 A%

Assign ID 74D

Created T 7 A ILDERBRF

Modified T 7 A IVDRAEEFHTHE

Modified by 77 A JLDEFHE

Title T 7 A )UTIRES NI Title]
DAA (ASClIFEX DI U v
7T%)

Title2 T 7 A )V TRESNICTitle2
DOARE (UTF-8FERDI U v
%)

Material RTUTIII—T) D%

Group

Shot Mark0~ 77 AJLCEZRN/C
Shot Mark9  ¥av h¥—20~Tavh
N —29M%H]

A NTUPWIN—T BUTSVZVITATT—
SEFERLUTER LI U Y T8

MENUDEHZEIL CTUR bz Xo70—)L
THIENTERT,

FIPANTE TSV Z2 T X
YT —YEBET D

] X Za—@0peration >Planning
Metadata >Clear MemoryZ=:&iRd %,

7 MENUDZH%E L TExecute F&IR LT,
OEHEET,

HEDBREDET,
HENTE TI &, [Clear Planning
Metadata File done] PFRRENF T,

TS5V FT—=H5T
1w TR7%ZHTET D

TSV IAIT—=H(C(F. RO2EEDY

Uy IR Esmi s CEDTER T,

e Ea—TU7A VY —EELEICKRREINDASCI
D ATR

o RRICTU v TRELTERSNDUTF-8E
TLDAAFR

A Za—®M0peration >Planning Metadata
>Clip Name DispTEBHD T U w TRZERR
THINMERTDIENTEFT,

TSV IXITF=ITOV Yy TRZEHRET
dE. Uy TEDRRRENE T,

[CFE]

TSVZVIXREIF—=EFTO Uy TRZEREIT DEEIC,
ASCIFER DRI EUTF-8ERDRH A S BERS
NTVBHEFUTF-8FERDRIN T U w TRELEDF
o TSVZVIXIF—5T. ASCIERDEIE(E
UTF-8FERXDRZIDEESHh—H U EZE L TLEWVLES
[F AZ2—DREICEDSTERSNTVD I U Y TH
DERRENE T,

Uy TRAXFHDECn B

THFARITA4Y—ZFERALT, <Title>5JD
ABZZELFT,

TN IED DO Uy TRNFH T,
[Typhoon] [FASCIFER (4432FRUF) TRk L
TWET, [BEEREREE] FUTF-8ET (448
A4 RUF) TERHRLTWVET,
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[SplFANR=R, <lFHTZ2RLET,

<Ixmlgversion="1.0",encoding="
UTF-8"7>+
<PlanningMetadata,,xmlIns="http://
xmlns.sony.net/pro/metadata/
planningmetadata',assignld="
P0001",creationDate="
2016-11-30T17:00:00+09:00",
lastUpdate="
2016-12-06T17:00:00+09:00",
version="1.00">+"
<Properties,propertyld="
assignment",update="
2016-12-06T17:00:00+09:00",
modifiedBy="Chris">«
<Title,,usAscii="Typhoon",,
xmllang="ja">BR&R kk:
</Title>«
</Properties>+
</PlanningMetadata>+

[CEE]

o RRICT 7 A ZERT DHBEF. ITAE TDIHYL
17U Tspl PRIRENTVIEWAIBIC[FANR—ZZA
NFIC1DOOXELTERULTLES W,

o LIFOXFEIU w TRICERATEFT B, EATD
& [CEBENF T,

"Hr<> T\

o Uy TRIERTEDEMNFEIF44)\1 b (Fle
[F443F) TG,

UTF-8FENT44)\A bEBZ DI U Yy TRETEET D
& 44N RERTOXFIIN O U Y TRICERSINE
ER

ASCIFER DO Uy T2DHEE L TVNDIBEIE. ASCI
DX FETOXFINNT U w TRICEAEINE
ER

ASClIIFEsl TRt UTe3t=5)). UTF-8FENTEik LTeXX
FHH. LWFNBIU Y TREULTHERTERWES.
Uy JRAGRERR LD ET

71w TZDKE

| vuvoaEERUETS Y=V Xs
T8 T 7 A EREDXE | —(CFHA
@ (115/\0_:/‘\)0

2 X Za—M0Operation >Clip >Clip Naming
ZPlan(CERET B,
EERZEITDIUIC, TSV IATT—
I 7A)VICER Lfc o U w T, 7
F—)\— () &5 LES (00001 ~
99999) MIINENITEX CEEIERSINE
ED
Bl BEEREEE_00001. SRR Lk
_00002. ..

BUESNHO9999(TELED.
fECO0001 [CERDE T,

ROFCHIR

[TFR]

DTSV VY IAXEFT—IZEGHRIFHAALTH, BLESE
L E T, MUBESODZEE(E., X=21—0 Operation
>Clip >Number SetTfT o TLfZ&E L),

Uy TR2DRRENDER

ASCIFER EUTF-8FE DM D&RI7ZERE U
TWBEEF. EB5DFERORARZLCDES
Y—EEFCFE1I—T 7 AV —EEICEKR
goHh7ZE, XZa—MOD0peration >Planning
Metadata >Clip Name Disp CERT S &N
TEFT,
ASCI FERDRBIZERTR I D EE(E
TitleT(ASCI) ZZERLE T,
oUvTRE TBREREE _BUES]
EREDFEITH. BEEICE Typhoon_#@UL
BS] BPRRINET,

UTF-8 B DA ZRTR I DEEF
Title2(UTF-8) Z&RULZE T,
Uy TRlE TERRREE_BUES]
EED, HEICRRINET,

TSV IAIT—=HT
V3w MNN—URZEET
2

TSV VIRIT—=HITY 3y NR—T%ZH
ET9d%HA. Shot Mark0 ~ Shot Mark9m
FIZERET D ENTEFI .

Y3y MNR—IZEHRIDEEIC. TSV
IXITF—HITERLUCY 3 Y BN—TURBNF
M CERRIT DT ENTERT,

[CFE]

Y3y b= 1. 20HFBOBIFCRIBTEFT,
Y3 v MN—UBXF5 DAl

THFAMIF«4Y—ZFERLT. <Meta
name>% 7 DHRBZZELF T,
WO 3y hN—IZBXFEITY,
ASCIIFER (32XXFLUIR). FelFUTF-8FE= (16
XEIT) TERRLE T,

[spl IFAR=R, <lFTEERULET,

[Z5)

ASCIFEA DI FXFUEZENTLNIL, ZDX
FHDRARIF16XFICEDE T,

<xmlgversion="1.0",encoding="
UTF-8"7>«

<PlanningMetadata xmIns="http://
xmlns.sony.net/pro/metadata/

planningmetadata’s,assignld="
H00123"creationDate="
2016-11-30T08:00:00Z",lastUpdate="
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o ANU—Z=VIICBTITDE. XY NT—0054A47F
VRNE—RICKDARNI—Z2T (82R—=Y), EZ
YUVT, TOFVEHBRO IO T 7 A I)VEEFTER
Bho

o EZHUVIh. TJOFVERBFICTT 7 A )UERE
FICRANI—ZVIZRFEIRT DE. INODRBEIEE
1EUFET,

 AMU—ZVI%R%

XJ D

A==V I7ZFIET D

X Za—MMaintenance >Streaming
>SettingZOfflICT 5 &, AMU—ZVI%E
LEUET,

Streamingh'OnM & E(C, Streaminghi7
AVENET A FTIVAAYFZRIET
BRAN—ZVIZEIETEFT,

TIAREDTAVLURALANE R L TWVDHE
(6IN—=), BRUTAVUALANZAT—
VIVE-RTAUT—3Y MERLTWVES
B 7IR=D) [ClF. AMU—ZVIEXE
DFRE. ANI—ZV I DR fELEZEWebX
11— @R=I) ST DTLEBTEFRT,
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SREEZ NU—SVIETS

*y D=0 054T7 hE—REGHICL.
AHEEY Z—Rxy FO—IRXRAFT— 3>
(RI58) MDConnection Control Manager (15
[CCM)) FI12IFXDCAM airziE it UTES C
ET. VY Z—DQoSEfii7ZE o fcmmEF A b
U—ZVIPaREICEDER T, FIEBHED=RY
hND—O%ZRETHET, LOBEECREE
UfeRMU—ZVITHhTRAET,

[CFE]

o Ry RI—URXRAT— 3 VICFVI20LEZE
mALrEEL,.

o BHOXRY NI—IZFERULTRELEANI—ZY
JZTIICE. TNZTNORY ND—TICREDF+
U7 oEfREERL TS,

o BHORY ND—UZFERLUIBE. BREY—2ICKD
TlF 59—y hEY hU—bEBRBIEHDET,

e XDCAM air [&. VZ—hR#HI 250 RI—EXT
ER
COY—ERZTHAITEDICE. BIEZHINNET
ER
— B L CLVEWEEN S D EITDT, -
RIHCDUVTXDCAM air DY A b THERLIEE
(AN
https:.//www.xdcam-air.com
Ffe. XDCAM airD 75 A )\ —iRU ¥ —[CDWV T,
DFOYA hESRULTLEE 0,

- FURRRK
https://www.xdcam-air.com/site/tos_eu.html

- XDCAM airD TS5 A )\ —RU > —
https://sony-imaging-products-solutions.co,jp/
pp/sips/en/index.html

- JO7zvyaFIDDTSA )y —RUY—
https://www.pro-id.sony.net/#/privacyPolicy

o FULIE VITEAEEROCBEBLEDELEE
(AN

| sgrzy ho—sicEET S,
2ULIE, [AHE FINA RDTA LR
LANEEE | (69%—Y), BKO. [ V55—
2w NERE] (73R—) BTBLZEL,

2 XZa—®MMaintenance >Network Client
Mode >Preset 1. Preset 2. Ffcl&Preset
ITEGEDR Y N —UZRTET Do
EREDxRY NI—ORERFTIZY bR
TEE UTCPreset 1. Preset 2. &F/fcldPreset
3ICRECEFXT,

158 W&

CCM Address  £##RSEDCCMD T KLU R %=
ASITD. GhRRRRFRF

P77 RL2R)

CCM Port BEHEEODCCMDMR— hES
"EANT D,

User Name A—F—2=Z AT D,

Password IR T—RZASIT D,
AN UTEIR D — RIF*FTE
mENdH. SHIFTF—7%
HUTWBEIF. ASBUR
NENRREND,

NCM With CCMEE#FBFD 7O+ 508

Proxy DB/ BN ZHRET o

Camera CCMERRFDAX S

Control O—JUEFa] /TR Z587E
jéo

Camera CCMEERFBFDAI FiledD) \ >/

Setting N> J8Fa]/ RNeFa]7Zs%
T Do

[CFE]

o IRNTDEBIENANTINENE, Ry hD—
DOTAT U NE—RERECEF A,

o XZa—MMaintenance >Network Client Mode
>Preset 1. Preset 2. FIzl&Preset 3 >NCM
with ProxyZZEnablelCERET DL Ry hDT—
JOSAT Y NE— RBBEMFHEETH. 70O
FUEHMNTEXT . NCM with ProxyDEERTE =
BICTBITE. XZa2—DOperation >Proxy
Recording Mode >SettingZZOn(Cc LTL &L,

o XZa—MMaintenance >Network Client Mode
>Preset 1. Preset 2. &FfclEPreset 3 >NCM
with Proxyh'\Disable[CERESNTLDIHBAE. i
FICRY NT—=T0 547> hE—RZONICT D

& JOFVERIEELELERT,
FUIFIVT 7 A )VDEEREME L TLDIBA.
BREZOMCTDETOFVERZBHELET,
e XZa—MO0Operation >Proxy Recording Mode
>Proxy File >SizeZ#HD Auto(9Mbps)KTzldHD
Auto(6Mbps)ICEEE L TWDEBE. NCM with
Proxyl3sECTEFE o
NCM with Proxyh*EnablelCE&EEHT. HD
Auto(9Mbps)ETzlFHD Auto(6Mbps)ICERTE LT
Ha. REEFEFINEIH. TOFVEREE
IONFEEA.

X Za—MMaintenance >Network Client
Mode >Preset Select CFIE| TRE LT
Uty fOWFNH 1 DZEEIRT D,

XZ a1 —MMaintenance >Network Client
Mode >SettingZzOn(C g %o

XY D=0 054A4 7 b E—RHBERIC
DO, Ry ND—=ORXRAT—Y 3 VFklF
XDCAM air&E# LR 9

2 RI—=IRXAT— 3 VDIRIEICKD.
SATANI—=ZVITDRHATNET ., &
feo Xw RD—ORXAT—Y 3 v B0k
BUE—~I> RO=)b. Al 7A)LDR
Z/HUOHUNTEFT,
BIECDOVWTELLIF. Ry hT—2RXX
T—2 3 VOEURERBAEFCIFXDCAM air
DN TETELEEW,

8. Network Client Mode®Setting (On/

Off) 3. AHEDF I AFTIVAA v FICE
DHTCHDTENTEFT, BIDHTIPAIC
DWTIE, [7PHAFTIVAA v F(THEERE

EIDHTB] (134X=) ZZELEEL,

o RV KNI—UITATY NE—RICBITIDE. BF
DARI—=Z2T @IR=Y), EZFUVIEFTE
F Ao

o EZHUVIRICRY ND—U 0547 M E—RIC
BiIT9DE. EZYUVIRELELET,

o XY KI—=UISATPYME—RTDORANI—ZVT
FlF. TPAIERECEFBA. A=V TR
BIETDETFAIEEERTEE T,

o JFA)URERICRY NDO—U 0547V ME—RT
DANI—ZVIZBIRTDE. T 7 A JVEEFFLE
LET. ANU—ZVI%EIETHET 7 A ILEnE%E
BRLEY,

o R NI—URXAT—Y 3 VTHREAELA N —=
VJDEY h— B TJOFVEROT+—T v b~
[CKD. LIFDKSICHIBRENF T
- JOFVERD T4 —< v hHL 1280%X720

IMbps/6MbpsDBH A MU—=2JDEY bL—
MME TMbpsIAFICHEDET,

- JOFVERODT+—<w bH 640X 360 3Mbps
TOBE A== JDEY bL— &,
3MbpsIFICIEDE T,

o Ry ND—U0SA7Y ME—REZ, TOFVD
T#—< v hEBEEFTEFEA. BEEITDHAF. —
EXRY NI—005A4T Y ME—REFTICLTLE
[aIAN

XY NID=00Z4A472 ME—RT
T7A)N7ZEXRT D

W hI—=IRXAT—Y 3 VOCCMEFH#K7Z
XY hI=005A 7Y b E—RTERLUT.
CCMTRESNIEY—I\—A\T 7 A VXY B
CENTEFT,

| smxLrwI P ILERS,
o JOFVEREEXTHES
[WebXZa—CT70Ox3 T 7 A )L enx
T2 DFIE| ~ 5 (77_—IBH])
o FUIFIL TP A EEET BES

[CER]
o BEDRXMU—Z2T @IR=I)FlFRY hD—2
O34TV hE—RICBITTER A,

(WebXZa—CTAHUIFIVT 7 A )74
EID|DFIRE] ~ 6 (78X—=IBH)
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? Transferzs v 79 %,
EHESEIC [NCM 1 RX Server] BERRSE
ER
[NCM : RX Server] ZEmx5CICIEELE T,

3 Transferz¥ v 79 2,
CCMTERESNIET—I\—~, BARET 7
A IVDEEZERIBRUE T

[CFE]

XY ND=D05A4AT7 Y hE—RTIHEWEED, XLz
[NCM : RX Server] [CTEF T,

COBAEF. BmXFREBELED, Ry ND—005A47 >
R E— RTCCMICESR. CCMTRESNEY—/{—~
EXZRIIALE I,



084 5% XvbhIU—URE

Wi-FiUEIJVZERT S

BEOLoCkDEHZAICASA FIdH L.
RECRYVDBRIEZZEILT D ENTER

DA VUALANERR, AN—h T4 2P57
Ly PEEDTINA A5, FHEICAB S N

Wi-Fi RemoteBEIE (R —  CUrsorEiE

WiFIUEIVCP o ERT BT ENTEET, ¥, NOE VLGN S i
Wi-FiU £ %Y 2 SEmN SAMERIE Wi-FiJ EO>1EWeb* = 2 —0DCam RS
TEXT, sLiOFAR/ R PIRFEHRTE =R Remote Control (86 X—3) ' oHFR . Jp\ Left. Set. Right.
BIECEETE BT, AN IEHICE TEET, MainEiE Down. Cancel/

Back. Menu. Status.
Thumbnail. Option
(SHIFT+SET)

ETHBar. AgEZEIL—VICEEL CER
TOBEFLEITBEN T,

o AT —YRAKR
o BRERERN

[CER]

WIi-FIUEOJV 2RI D

Wi-Fi RemoteBIE&. T/ A ADBEEY - XI(C
WU TCEETDEDDE T,

| rigee 70 20T 4 L RLANER)
(69R—). BRUTAV—=w N
G (73%—) DFIEICH ST, A%
AV —2y NCERHT 5.

2 FRARTISHT—EEEL. [hitp//A
¥DIP7 KL X (Maintenance >Network
>|P Address(Wireless)) /rm.html] (C77 2
TAXT D,

Bl D IP7 RUAD[192.168.1.1]1 DIFE
(& 7 FLURIN—=ICThttp://192.168.1.1/
rm.html] EABDLEFT,

3 ISYY—@EmEIC. 1—Y—2E/ (R
J— K (XZa—®MMaintenance >Basic
Authentication (126 X—3)) ZA9 %,
BENT & T/ A XITWi-Fi
RemoteBEINFKRRINE T,

LR&(F. BEFROESDICRELTLE

[N

o AN— RT3 VAHADR—=IZRRUIZWVEEF. 7R
VADTREZ [rmshtml] (. Ty NEODR—I%
FRUEWEEIE [rmthtml] [CBERZ TAALTL
ZEV. BRI [rmhtml] EAFTNE. &EX—=JIC
BEMICEELE T, T/\A RICELD>TIFERICEE
ULIEWBENSD D ET,

o RDBAEIF. Wi-Fi RemoteBIE & AEEDKEEN—E L
BLIEDTENBDFET, ZDHEEIF. TT39HF—0D
FRZEEH LTI,

- EFEhicAgEBERE Uicsa

- ERRICAEERIEUIBEA

- TIA RZBERUICIEE

- D30 —-TED RORIELIEEE

o BFIRENEULSEBVEA. Wi-Fi Remoteh e LK
LIBEBDTERBDFT,

Iris. Focus. Zoom. S&Q
FPS. Shutter. White.

Gamma. Auto Iris. Gain.

ATW. Color Bars. Auto
Black. Auto White

AT —FARR

o BERERS Y
F Rev. Play/Pause. F Fwd.

Prev. Stop. Next

AT —F AR
PYAFTITIVAA vFRR

TYAFTIVAA wF0.1.3,

4.5
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Wi-Fi Remotel@iE (¥ 7
L hERR)

MainiE|E

= Camera Control

Stby 03:22:22:19 =i

o AT —HAKRMR

o PHAFTIARA vFFRR
PHAFITIVAAYFO. 1. 3. 4.5

o BEHRERT
S&Q FPS. Shutter. White. Gamma. Auto Iris.
Gain. ATW. Color Bars. Auto Black. Auto White

PlaybackiEE

= Camera Control

sty 03:24:17:14 =

o AT —HAKR
o BAERERY Y
F Rev. Play/Pause. FFwd. Prev. Stop. Next

CursorE|m

= Camera Control

Sty 03:24:22:14

o AT —HAKRR

o H—YJURERY Y, XZa—/AT—H KR
Up. Left. Set. Right. Down. Cancel/Back.
Menu. Status. Thumbnail. Option (SHIFT+SET)

AssigniEi&

Sty 03:22:37:15

o PHAFTIVAA vFRR
TYAFTIVAAvFO0. 1. 30 4.5
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WebXZa1—hHHBEERETHD

Media InfodSD CardEENFRENE T,

DAV U ALANE R UTe T I\A ADT SO —
DOFEICT I ERTDE. FEDWebX
ZI1—DPRERSNE T, WebXZa1—TDA V¥
L ABEEICEIT EEREY T 7 VDX
EE{ID CENTERT,

WebXZ1—%FKR9 D

| e 70 2004 L RLANER)
(69R—3), BLUAVF—Rw M
&1 (73°—Y) OFIEICHEST, =HgE
AV —Zy NCERET B,

2 FRAZDTSOT L.
[http://192.168.1.1:8080/index.html] (C
FPOTRATH,
d—Y—%&[User namel &/XXDT—R
[Password] Z A9 DBEENFRENE
CB

3 A—F—HE)RT— REAHLT, [OK]
ZIEIRT o
TP ORARADI—F—2B LU/ AT —
RICDWTIE. A= a—DMaintenance
>Basic Authentication (126 X—3)) T
i raral AN

HEAXA 21—
A RT TSI — =B L. [httpy//Ak

DIP7 RUA (Maintenance >Network >IP
Address) :8080] ICF U AT DE. AHED

WebXZa—BEEE OB %25 735 E5
EXZ1—DFRRENE T, RELWERZ

FvITLET,

IEH(C(FSettings. Media Info. Job List.
Cam Remote Controlb'&d D F 9,

Settings
FEOREZITVERT . AEEIOIEBFRDE
HBHTT,
128 NS ST
Wireless AMU—=v AU—Z=T
Module J74—Nv T#—~v b
>Streaming  MERE 7E [Streaming
Format Format]
(86—2))
Wireless JO4v JOFV T4 —
Module T#—Xv b XvEE
>Proxy RIE [Proxy Format]
Format (87—
Wireless Network PPN
Module Client Mode 7 System
>System Settings®sE  Settings]]
Settings BHEOO—  (88X—)
i (Load
Certification
MDLoadm%
VTHELT)
Wireless LAN DAL X DAV L RALAN
>Station LANEZE 5%%E [ Station
Settings Settings]
(88—2))
Wireless LAN D4 FL2Z DAL ZLAN
>Status LANERTEIRRE SREDHESR
DR (88R—2))
Wired LAN  B#RLANETE BRLANSE
>Wired LAN [Wired LAN
Settings Settings]
(89R—2))

B[S AR ST
Wired LAN BHRLANGEE BHRLAN
>Status REEODHEER  BRTEDHER

(89X—3)
Upload BUXERTE BXERTE
Settings [Upload

Settings]

(89R—))
Media Info

AT 4 TP OBHRZERTUCD XT 4 PH SERE

o7 AN ZERITDEEZRTLET,

e SD Card : A#MDPROXY SDA— FXOW b
[CHASNTWVWBSXT 47
BEULWIPAIZET TV Y TTBHE.
BRUCTD 7 AU BEEINE T,

[TEE]

BEVDIHERZFDOS, TS50 F—D/\—Y3V(C
KO TCRBETEHEVEEDDDET., CDHEAEF
[Content Browser Mobile] ZfER LT ZEW,

o Slot A I AEDH— RROw MAITHEATN
TWVWBDAT 4T
e Slot B : AEDH— RRAOw MBICHATNT
WO AT 47

Job List

ERPD T 7 A L7 EHET D Job ListBEZxR
RUFRT (90R—=2),

Cam Remote Control
Wi-FIUEOVZRRUET (84R—V),

OSS Information
EZFEERZRZRRUE T,

AN)—==2TT 54—
N v MR [Streaming
Format]

FIAZATEZIUVITENBDA MU =L,
A=y FEEIFO-DILR Y bE@BUT
AR—ZVIMETHANI—LDT 5 —
N v MPEEEDREZTNE T,

BRER

o AVC/H.264 Main Profile. 4:2:0 Long
GOP
o T XELIFDRE TER

==
=N
o AAC-LCIEHa

o UV TV IR 48 kHz
o v ~L— 1128 kbps for Stereo
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TS5 UITERFE

TFIARTCTEZSU Y ITENDEEDT 5 —
Ny hERELET,

S|

=

REE

Type

ANU—=VTH
DRGDTEREZE
NI 2.

MPEG-2 TS/
UDP/
MPEG-2 TS/
RTP

I5H W= REE

Monitoring EZ4 UV JHED

Size IR A X &
Ew h—hEER
EI Do

480x270(1Mbps)/
480x270(0.5Mbps)

EZSUVIRAD
BREDTLU—LA
L—bhZEXRRT D,

23.98fps/25fps/
29.97fps/50fps/
59.94fps

Monitoring
Frame Rate

EZSUVIRAD
BR&OE Y L —
hEFRRT Do

TMbps(VBR)/
0.5Mbps(VBR)

Monitoring
Bit Rate

[TFE]

o v hU—NFFEIETHD,
HOHET,

o EDTU—LL—ME24fps [CHIGLTWLWEE A,

e Monitoring sizeT640 X 360 : 3Mbps (VBR) [CI&3xt
IHULTWEE A,

REBZBRDHED

ANU—=2VTEE

AN =SV IREBDT # —< v hRXSE

Size

A==V JHA
DRIGDT A X%
RET Do

HD Auto’z#EiR
LeiBda. SxSIC
LIRS NDECER
T#—~Xv bDE%
TEPELETDY
UwIDT#—
X MMIEDL
T. 1920x1080H
1280x720(C5RE
ND.

HD Auto/
1280x720/
640x360/
480x270/
320x180

Bit Rate

ANU—=VIH
DREDE Y

L—hZRET Do
ERTEDE Y b
L—bl& SizedD
REICKDELD,

IMbps/6Mbps/
3Mbps/2Mbps/
TMbps/0.5Mbps/
0.3Mbps(Mono L)/
0.3Mbps(Mono R)/
0.2Mbps(Mono L)/
0.2Mbps(Mono R)

Destination
Address

A== 7
T =5 DX
H—)\—D7 Kl
A7EANITT B

A RREEE
P77 LR

Destination
Port

RIXRFET—)\—D
AhU—=2J(C
AT HR—hE
SEATTT Do

1~ 65535

Audio
Channel
Select

ARY—Z=2TH
AICEEDAudio
ChannelZEiRd
2o

Ch-1 &Ch-2/
Ch-3&Ch-4

ZRELET, REFTUEY hELT3IDE

THREFCEFT,

=B S SREME

Oon/Off A KU—=2Jf{= On/Off
EDA Y AT
PI0Z D,

Preset JUtwy b Preset1/
Presetl ~ 305 Preset2/
FEIRT D, Preset Preset3

(FEditZzy v T9
BDERECTEET,

[CFR]

o StreamingZOnIZHRE UICBA.
FRATEFEA.

o AVHF—y MEHTHE BET—YEZTDFFX
ESEED

TS U VTN

ZDIEHT—INRAVNT DOREMENHD T,
EEADPA N —ZVIF—IEZETETCNDIL
ZHERLTLEE L,

7 RUADFBEZ AR EICIDBER UIEWVIEFICT—
FEFEUCUR DO DD E T,

o Ry NIT—UDWRICKD, IRNTDTIU—LZEBE
TEEVBENBDET,

e HEDHLLY—2VDIBEICE. BEANRIEDET,

o ANY—ZVIBREFYAXTINEVEY bU—h
[CRREUCZG. INTDTILU—LDBETERVEG
ahedbET,

CORFEEFIEBIHICIESize TRONEWVWT A X
ZEATLIEEL,

e 500kbpsA FDxRw bD—0 DFEEZE SERADBE.
Size&Bit RateldI FDOEBSMTHRE L TLEELY,
- Sizeh'480x270D & = (&, Bit Rate0.3Mbps(Mono

L), 0.3Mbps(Mono R). 0.2Mbps(Mono L).
0.2Mbps(Mono ROV FNHZERTET Do
- SizeH*320x180D & E(E. 0.2Mbps(Mono L).
0.2Mbps(Mono R\DEESHZRET Do
CDEEDETHADTU—LU—MF10fps. 7—F«
FOYY TV IREREHIF48kHz, Ew bL— &
56kbps MonolCERESNE T,

e Bit raten'0.3Mbps(Mono L). &Ffzl&0.2Mbps(Mono
LD%BE. Audio Channel Selectld. Ch-1 &Ch-20D
Ch-1. FfclFCh-3 & Ch-4DCh-3[CHRESNE T,

Bit raten*0.3Mbps(Mono R). &7zl&0.2Mbps(Mono
RIDZE. Audio Channel Selectld. Ch-1 & Ch-2D
Ch-2. &Ffcl&Ch-3 & Ch-4DCh-4[CERESNE T

JOF2 T4 —NX v MERE
[Proxy Format]

AEDSDA— BCEREND TOFT T 7 A)U
DT F—X v MREZITVE T,

BRER

o XAVC Proxy (AVC/H.264 Main Profile.
4:2:0 Long GOP)
o TA XIFLIFDRETER

==
=M~

o AAC-LCHE#E
o YUTUVIERE - 48 kHz
o v hL— 1 128 kbps for Stereo

1BE

E

REE

Proxy File
recording
Size

JOFv 774
AlgROT A X&
vy h— R
EI D

HD Auto(9Mbps)/
HD Auto(6Mbps)/
1280%720(9Mbps)/
1280x720(6Mbps)/
640x360(3Mbps)/
480x270(1Mbps)/
480x270(0.5Mbps)

Proxy File
recording
Frame
Rate

JOFvT77A)
RO T L — LA
L— hZERRYT D,

23.98fps/
25fps/
29.97fps/
50fps/
59.94fps

Proxy File
recording
MBIt Rate

JO+2T774)b
AIR&EDE W b
L—hZERRT Do

IMbps(VBR)/
6Mbps(VBR)/
3Mbps(VBR)/
1Mbps(VBR)/
0.5Mbps(VBR)

Proxy File
recording
MAudio
Channel
Select

JOF2Tr7A)b

([CECER T D4 —

TAFTF xRV
RET Do

Ch-1&Ch-2/
Ch-3&Ch-4

[TEE]

o By hU—NMNITHIETHD., BREMBZBZ DIHED
HHFET,

o 24fps [CEHIHLTVEB A

o JOFTT#+—< v MREDSizelHD AutoZziER U
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feBE. SSATEU—H— RNDEEER T 4 —< v bDE
EPBETDIUYvIDT+—< v MIEIWT, 7
OFY 74—y MORESNE T,

o JOFTT#+—Nw MREDSize ZHD AutolTERE L

TeRUETZOFY T 7A)VIE. TZoF—Content
Browser MobileCTBATEEWEEN B ET., 7O
FUIFAI)ERERUCSDA— REIVE 21— —I[C

BEEALTCHELTLIEEL,

2 AT LFEIE [ System
Settings]

Network Client Mode SettingsDztERE =
O—RUL&FT,

XY NI=T0SA 7>
NE— NERE [Network
Client Mode Settings|

¢ Load Certification : LoadR& >/
O— FFHCCMDERAZE [CCM_
certification.pem] &, 5 UHSDH—
DIV— KCEBERAATLEEL. CCMODEEHA
EIDVTEF, VIEABEZREOICSHEL
abhELrEEL,

DAL ALAN %7€
[ Station Settings

72D A7 U ALAN [THER I S DERTEZ
TVE T,

I5H =

Subnet mask  FTEEDTITRw AR TZA
719 %.
DHCPHOffD & FICER

T ORARA Y +DT— b
DIAZAIT Do
DHCPHOffD L EICHR

Gateway

DNS Auto DNSEHEUSREY Do
OnlCgd&. BEAIICDNS
B—)\—D7 RLURZEIST
éo

FORANAY SDTSAY
U—DNSH—/\—Z A9 B.
DNS Autoh'Offd & EICHR

Primary DNS
Server

Secondary DNS 77O ERRA > bDEHVS

=[] S

Host Name DT ) A AZ (EEAT),

SSID Access Point CEATESSIDZ
FRT Do

Key T ORAIRA Y bDINAT—
RZEATIT Do

Show Key OnT. AIHOXFZERRT
Do

DHCP DHCPRET %o

OnlCodE. BEICAREIC
IP7 RUAZZ|DHETD,
FENTHHEDIP 7 RLURAZA
HIBBEIE. OfflCT D,

IP Address KEEDIP 7 RURAZATTT Do

DHCPHOffD & EICHRD

Server J—DNS —/\—%Z A7
2o
DNS Auto*Offd & E(CHERD

Submit TAVUXLAN REZBETET
éo

WPSHeEZ R ULIFWAT—2 3

T—RTP7IERARA Y MTEHR T
%)

| Poezmasy b E— RTEBETINAR
BERTD (70R—),

7/ Station SettingsEEDEE #EET 2.
BT BT U ARA Y hOBRECADY
THREETVET.
® FOBARAY MDREICDOVTIE. PIEAR

4> hORILERAEZ CBELEEL,

3 SubmitEy v I,
e L IEE D EE LS.

4 X Z a—®mMMaintenance >Network
>Wi-Fi ModeZEiRT %,

5 MENUDZEH#E L TWi-Fi Station&52iR
L. DEHEET,
TORIETIE. AEFRT— 3 VE—R
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5 MENUDZ#%E L TExecute FER U,
DEHEET,
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RENET,
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O MENUDEBEELTA v b—IEHT,

YLRA)VEETIF. HIERULZD
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| x=a2—oThumbnail >Delete Clip >All
ClipsZZERT o

7 MENUDE#%E L TExecute &R L.
SEHEMT,
BREENETINET.

3 MENUDZ##%E L TExecute &R L.
DEHEWT,
TRTOY U v THEBREN. 52T X v —
IHETENET.

4 MENUDZEHEBULT A v t—IHHT,

Uy TZEAT D

X Za—0OThumbnail >Transfer Clip. &Ffzl&
Transfer Clip(Proxy) CSxSXEU—H— Do
Uw 7 (FUIFILT7A)b) PSDAH— RIZEE
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ETEFT,

Thumbnail >Transfer ClipDREFIEIF. [Z
WBOU LXRA)VBECAVUIFILT 71 )L%ZeR
EID] (78X—) ZTELREL,
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ZEET D] (7T7R—) ZBRIIEEL,

Uy JOFMIBEHRERTI D
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BEMNKRSNE T,

Clip Properties

TC Index 00:05:00:02

2 Start 00:05:00:00 || size
00:08:19:23 || FPs

Duration 00:03:19:23

Ch/Bit
Nov-30-2016 10:58:42

3 Modified
Dec-1-2016 08:50:25

1. REDIY v TEI&
BRUTCWS Uy JORKREET Y w TOR
BEORTRINE T,

2. 4 L0—RERTR

TC Index : RSN TVBDEERDY A LI—R
Start © ECERFRIARDY A LO— R

End : BB TRDY A LD—R

Duration : IXERAEFRS

3. NREREEFERE

4, Uy TH

5. Ef7+—~<v b
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Size : EHIYAX
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Audio Codec : B 1—TwZ
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>Set Clip FlagZz:#EiRT %,

J MENUDEHEBLTOU W T IS %2R
RU. DEHEHT,
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Add OK OK
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Add KEEP  KP

ERUIEOVU Y TDY LRAIVICT U YT
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Uy T IS TRREERD I TP YA T
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B
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J4)5— 82U w JHEE
CRIMIDIYU Y TZRD
AD
(528

T7 AV AT LDFATICERESN TS . CDRRE
[FEATEREA.

| x=2—®Thumbnail >Filter ClipsZEiR
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7 MENUDEH%E L THOAHTRDY
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RIEME ROMBNRDIU W T TSI
OK OK

NG NG

KEEP KP

None FU (DIAFIELY)

BERUEOU YT IS TTRDAFEND
Uy TEHEMRRSNE T, COBEZ D«
WE—RoU Y TEEEFURT,

ROIABZRERYT DICIE. RDOWVFNHDERIE

ZTWVWE T,

e RESET/RETURNRS >~ 7Z# T

o XZa—MThumbnail >Thumbnail View
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Uy FICTVTEIANY—
T F1TDBIFRT D

Uy TOERDUED T U—LICTyEYA
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ZMIHBRT DI ENTEFR T, Ty VR
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RAVBETTVE T,
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T7AIVRAT LADFATICERESNCTLD & TORRE
[FEATEREA.

3w MY—20ORM

1 A Za—®OThumbnail > Thumbnail View
> Essence Mark Thumbnailz:&iR9 %,

2 MENUDEHEELTAIBRRL., DEH
ZEHY,

3 TyvbYRAY—YLRAEETY 3 Y
MN—0Z 3T U—LDTLRA )7
BEIRL. XZa1—@OThumbnail >Set Shot
Mark7Zz:#iR9 %,

4 MENUDEHEE L TROVFNDEEIR
L. DEHEET,

SREME E3
Add Shot Mark1 Shot Mark1 =S 152
Add Shot Mark2  Shot Mark27Z 1132

BIRUIETU—LAICY 3y bY—U DT
5NEY,

Y3 v bN—UDHIBR

1 AXZa—®OThumbnail > Thumbnail View
> Essence Mark ThumbnailZ:&iR9 2,

) HBIBY 3y NN— I DEEEEIRT B,

3 IyvEYRAY—OYLRAVEECTY 3 Y
hR—OZHBRT DT L —LDY LA
WZERIRL., XZa2—MThumbnail >Set
Shot Markz:&iR9 %,

4 MENUDZEHEE L TRDWVFNDERIR
L. DEHEHT,

RIEE BhE

1 A Za—OThumbnail >Thumbnail View
>Essence Mark Thumbnail &R T %,

7 MENUDEH%EE L THOAFHTRDT v
Y AR—OEERL. DEHEET,

RIEME nE

All Tyt ANY—UBMTUL e
IRTDTU—LDTR
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WCTWBD T L —LBKRUE
BEIL—AICLUYIRY—
c—T BTV TULEWS
Uy TDIEET L — LD
xR

Shot Mark0 ~ & 3w hY—UD\0\e
Shot Mark9 7L —AHWH

Delete Shot Mark1 Shot Mark1ZHIkRd D

Delete Shot Mark2 Shot Mark2 ZHIkRd %

BIRUETLU—LDY 3 v bXY—2UHEIBR
INFET,

Ty EVAN—TOYLZRA
JVBECOIU Y T (TL—
L) 70D

Ty EVAN—OYLRAIVERIE. Uy T
(1D EDT vy EYANY—IDEIREN TV
DHBEIC. Ty EVAN—IDMMENTVS
TU—LRZEY LARAIER TRRULET .
Y LRA)VEEZRTULT. ESSENCE MARKR
F (0R=) ZHITH. ROFIETEKTR
FTHIENTEFT,

[TEE]

T7AIDRAT LADFATICERESN TS & TDHRE
[FEATEREA.

BRUCI Yy BV AN =T TRDIAFN
Ty VAN =Y LRAJVEEDRRE
nNE9,

Y3y bN—00~Y 3y NN—0790D&HIZ
EERUCTSV VIR T—5ZERBLTY
Uw D%z Uicsald. U MOERIEEN
EFEUCRBICEDF T,

Uy TORKRECRET
2

Ty VAR —IYLARAVBE CEIRULZT
U—L7Z0 )y JORKREICT D ENTER
ED

KRRECUEWI U—LDT LARA IV ZER L.
AZa—@Thumbnail >Set Index Picture Ci&
RUIET =L 27Uy TORKRBEICEHES N
F9,
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Properties e EE All Clips XFATPDIRTDI Yy TZHIRT
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Ly hPYIXZa—ZFERULT. HEPH
EICNBFERDREZTVE T,

Ty hPYvIXZa—F ABETHEZS—
[CRIT D (149X—) TEHTEFT,

2_User Operation

> Back

[@4 Paint (ReimEL

Format Media
= Thumbnail

Input/Output
Super Impose

£¥ Maintenance
B File LCD

Rec Function

Proxy Recording Mode

A Za2—H&

EZEAZa2—IEHICDWVT

UserX=Za—
I—Y—hty hPvIAZ2—ZFRD
BB CREITDETIFERTOIAZA—T
T, (104R—2))

OperationXZa1—
BEICETORTE (EEEEMSN) #T5&
TCHEHATDHIAZ1—TY,

PaintAZa1—
BEICRATOREZTDEEICFERHTDHA
Z1—7TC9,

Thumbnail X =2 —
Iy TDYLRAIVICEETDEEZT D
EFIFERATDOAZ1—TY, (98—
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[T
Thumbnail X Za—(3&. &A% )LEmE (92—
) BRRUTWVDEEDIMERATERT . TLARA

JUBEEZFRRUCTWEWNEEEIE|N T,
Maintenance X1 —

AEEDA YT FVAPY AT LNEIERSED

HEZETDEEIFEHITOHIAZ1—TT,
FileXZa—

BRI 7 AIIBREZTDEEITERTEHA

Z1—7TC49,

OperationX 21—

IE[S] "= SHRSE

Format VAT LERE 107

Base Setting HAF=woL Y 107
T— RDEE

HDR Setting HDRERROHDEE 108
HR/HIIRFORT

Format Media XF«47J#x—<wv bk 108

Input/Output ALHESEE 108

Super Impose  A—/{—A>IR—X3& 108
E

LCD L[CDEZY—8&FE 109

Rec Function 4$ffEcizE— RERE 109

Proxy JOFVT—IERE 109

Recording

Mode

Assignable PHAFIIWAAvF 110

Switch NDOREEEID T

VF Setting Ea—JrA45—% 110
E

Marker N—hH—KR 110

Gain Switch  '4 VE=RE 111

Auto Iris A—bPAURERE 111

Zebra TISHEE 112

Display On/  Ea—JrA2F—%k 112

Off TEERE

"I"LED Ea—DJrAV5— 113
"I"RE

White Setting U4 MSVARE 113

Offset White A 7mRTA MERE 113

Shutter Vv I—RE 114

Slow Shutter XO—Yvwvy—3%E 114

HE BE ST

Time Zone FEERT 114

Clip Uy TRE 114

Update Media X7« 7EEIER7Y 114
J7—k

GPS BB (GPS) 38 7E 114

Planning TSI XFF— 115

Metadata YERE

USB USBXF o 7~ 115
E—E

Flash Band Jovya){URE%R 115

Reduce fHIEERTE

PaintX”-a1—

=[] B BHS

Switch Status  fHIEHEE. T AMES 116
ON/OFF&EE

HDR Paint HDREZE 116

Setting

White ERERT 116

Black 25y UNVERE 116

Flare T U7 HEIERTE 116

Gamma(HDR) HDRANZFR 117

Gamma HURHIERTE 117

Black Gamma TowvoAUIHEIESE 117
T

Knee ——THIERTE 118

White Clip MROA MUY TRE 118

Detail(HD) T4 T—)UERE 118

Detail(SD) T4 T—)UERE 118

Aperture PIN—=Fv—EEE 119

Skin Detail AFUF4T—IUFME 119
BXTE

Matrix X U ARIERE 119
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1BH WE SR 1EH BE SR

Multi Matrix ~ YILFI MUSIZAMEIE 119 Auto Shading #—hJSwvo¥yxz— 126
BT T4V IMRIERTE

V Modulation VEYalL—Y3v 120 APR APRZE 126
ZI_?’r ¥ IR Basic BasicEREERE 126
& Authentication

owKey — O—=%-YFab= 120 Nework  xvho—smmEE 126

Saturation 23 VHHIERRTE

Saturation YFaL—Y3VEE 120 Network *v hI—=0T547 128

Mode o ClientMode  ~ hE—FRE

Noise JA ZHTIUREE 120 File Transfer  Wi-Fign&sRE 129

Suppression Streaming ARU—=VIRE 129

Clock Set NERFETEE 130
Maintenance)(:l— Language Ay t—IKRNRSER 130
T

TBE BE SR Hours Meter Y% JUBSEHERTE 130

White ROA MY T—F4> 121 Network Xy hDO=2JUvh 130

Shading JRHIERT Reset

Black Shading JSvovyT—F«<> 121 Fan Control 77 VHlHERE 130
JHIEERTE VF Display Ea—JrA4v49—%k 130

Battery Ny T U—8RE 121 Setting TR AE

DCVoltage  BRDCEIRBE 121 Option YIhDIPFTYS 130

Alarm S—LRTE VETE

Audio F—F A FBE 121 Version =Y 3 VERE 130

WRR Setting A VLURAFa—F— 123
BE FileX=a2—

Time Code A4 LJ—REBE 124

Essence Mark TwvEVAX—U8H/RE 124 =l BE SR

Camera ALO—S—8ERE 124 User File IA—5—-T7AI)LEE 132

Config All File ALLT 7 A )URE 132

Preset White ZU‘E‘V hRDOA Mg 125 Scene File TP A LBE 132
= Reference File UZJ7U>VAT7A)L 132

White Filter T+ LY —87E 125 g

DCCAdjust ~ DCCRE 125 Lens File LY ZXT7AVERE 133

Flicker JUVHN—MERE 126 UserGamma HYYI77ALRE 133

Reduce

Genlock Jr0Ov IEE 126




101

78 AZa—FRREFHRE

Ty h 77w T X_Za1—0DE

Ty hYwIXZa2—%FK
NI B

MENU ON/OFF R wF7Z0NIZF D HMENU
MYV ZERUETD,

AERAXZ 1 —F—RIZHED, BEICXZ1—
UZ MORRENET,

BUFIE. OperationXZa—[CA—VILHiHD
BOBEEAITT,
AXZa—UR K~

l Operation

»@ Operation SBack
1@} Paint Format :
52 Thumbnail Format Media

! Input/Output
£¥ Maintenance Super Impose

B File LCcD

Rec FunC}ion
Proxy X ording Mode

XZa1—IBEEEERTUY

[CFE]

KT #—H2R (Focus Mag) E—RICIE->TL D & Y
R W IAZ 2 —([FRIECEET B Ao Focus Magh'Elb
HTONTWB T YA FT ITIVAA Y FTHKRT #—HX
E—REMRLTLEE L,

A Za1—7BEITD

| MENUDEHEETH. ©. SRovERL
T. BEUEWXZ 1—ICA—VILEED
T3,
XZ2—UR NEDAZ1—BERRT
FIC. BRTEBA= 1—BENEREN
=9,

J MENUDEHFIIESETRY VA#T,
A= 21— BEEREEDRRSNET.
DR VBT A= 1 —BERIREEE
ETTHTEHTEET,

o XZA—EERRTUPREA/TERC
7. BRCEZEEN—EICRRCER
VBB, H—VILE FRICBETSE
ETRH RO ULET

" Format Media

* | Input/Output
Super Impose

XZa1—IBAENFIETIHD
ETFICKREINF T,
XZa—FERITUY
o EIRUCIBRICHBENDDEAIE.
BICHEIFRREINE T,
o MIBNIEWVEAIF. AICIREDER
EENRRINED,
o BackZEIRITDE 1D LEDREEIC
BbFI,

3 MENUDEHERTH. 4. LRy EmL

T, BELWXZ2—IBBICh—VIL7%Z
BahE. MENUDRHEICIFSETRS 2721
U CTRET 2.
XZ1—IBEERTU7ORICRELY Y
WERSN. H—V)UHEEROMB (S8
LET,

ANIRF

~aOperation
S Back

Format

59.94

exFAT
XAVC-1 1920x1080i

File System
Rec Format

BELUT

o HiH SIRAEDREEDRRSNE T,

o BackZESN<RY VI, &
([FMENU CANCEL/PRST/ESCAPER
A wFZESCAPERIICH U NFD &1
DIOBEBICRDFET,

4 MENUDFHEETH. 4. LiRke> %
LT, BELEWEBCA—YILEEDE,
MENUDEHETZIFSETRS V&8 L TRE
T3,

EIR UICHE ORI DR, RIS
RENTVBBICH—VILD BB LET .

»aOperation
S Back

Format

File System

Rec Format

ERET U

o ERERTUVIERARNTRRCI, ERK
H—EICRRTEFVHEEIF. A=V
Z FFCBETHERRARIO-ILL
EER®

o EROEMHANAETVIEE DG S (Bl
-99 ~ +99) [, BIRKITU7IFRRE
NFEBho XFH/\ASA FERRITIED
REZEDAREIFRETCH D EZmL
EER

5 MENUDZEHZZEETH. §. SRy ERL
T, BELEVEEED. MENUDEHE
TeGSETRS > #3E UTRES .
BENEESN, ZEHDRENFTEN
=7,

EfTIEE CExecuteZ &R U
TBRAEDRITINET

Feld.

EITRIICHESE NN EFIERDSE. FIE3T.
EITHICHESNREFIRERZEIRT L. Lo
el XZa—hVBA. HEEERX v E—IDRRT
NFEF. Avt=JILE>T. RTIDDFv
JEIVTDH7EERLTLIEE L,

XF5E A1 B

T7AIREE, X5 ERET HIREZER
UleBa(lE. XFHDANEENRRSINE T,

1

User File: File ID

[ ABC[® abc [e 123 [ 143 |
Blbcdefghi jk I m

nopgr st uvwxyz

| MENUDZEZZERILTASLIELXES A«
TEERLT. MENUDEHF[FSETRS
VBT,

ABC | AN ZFE
abc : B\
123 : 5

S BT
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A=V LB ROBICEE LET.
Space : N—YVILDAIEICAN—R7ZZ ATJ
LETD,
—/— A—VILEEBEUET,
BS : A—VILOEDXYEEHIER LT,

3 AP o5. DoneEERL. RET
%)O
YEHIAREES N, AHBEEIHEI ET.

ERERBZHDHT

| MENU CANCEL/PRST/ESCAPEZ A w F %
ESCAPEMIICIHL TIF o

A2 —EBFZIR T I8

| MENU ON/OFF 2+ wFEOFFICT B
MENURS > 72387,
BEONATBEICRDET,

AXZa—=0Ov T R
)
v NP Y IAZa—DFRREOVI LT,

UserXZa—fE[IZXRSBDHIENTER
ER

XZ21—7Z20vI92

| MENUDZHE®BLENS. MENU ON/

OFFAAvFZELTFIC, By hFPvT
XZ21—7ZKRI Do

X Za—MMaintenance >Camera Config
>User Menu with LockZZ&RR g 4.
[CEE]

o MENUDEHZRUIEN S, MENU ON/OFFR
A vFZEBUTFDHE. Camera Config >User
Menu Onlyh*User Menu with LocklCE)D#100D
ESC

o MENUDEHZHEFICMENU ON/OFFZ A v
FEBUTTD, FIEEMENURS > 238U T X

Za—FRmnUcBElE. Camera Config>User
Menu with LocklFRTRENE Ao

OnZZRUTMENUDE H 72T,
Ea1—TrA VY —BEEKRD. EIES
ADEEICYIDB|DDET,

IRDEIESZ AT Do
AFTTEDEUEIFA4HTD0000 ~ 9999(T7K
DFET, FIRREFO000TT

HiEZ AU TMENUDRHZRT &, H—
VIVHVROMICEEILE T,
IRNTDHZEASILED, SetlCh—V )LD
BEILE T,

SetlCH—VILh®DIRRET. MENUDFEH
T,

ANDEELHRT,

BRENT 7 Ule X v E—IDKRREIN,
UserXZa—EIFDXZ 1 —FRICy)D R
bbxE7,

[CFR]

o R"KICRItEY "NV IAZa—%&UserXZa—(CE

FUEWCTOYIdDHE, ZDRY Py TIAZa—
EBUKREZE 7 T A F TIVAA v FICEIDHTTEL
<HEHFET,

o TRICRIKREZTTAFITIVAA v FICEIDHTT

WDIRRET. ZOHRECALUEY MNPy TIXZa—7%&
Ovo3ddE PYAFTIVAA Y FICEIDH T

BEDERIEFRHIICOff[CIED E T

Ty Ry IXZa—

PHAFTIVA
A YvFADEIDH
CrIAEkkRE

Operation>Rec Function
>Picture Cache Rec

Picture Cache Rec

Operation >Rec Function
>Clip Continuous Rec

Clip Continuous
Rec

Operation >Rec Function Slow & Quick
>Slow & Quick Motion Motion
Operation >VF Setting VF Mode
>Color Mode

Operation >Display On/  Video Signal
Off >Video Signal Monitor Monitor
Operation >Display On/  Lens Info
Off >Lens Info

Operation >Auto Iris Spotlight
>Mode Backlight
Operation >Marker Marker
>Setting

Maintenance >Audio Front MIC

>Front MIC Select

Maintenance >Network
Client Mode >Setting

Network Client
Mode

Maintenance >File
Transfer >Auto
Upload(Proxy)

Auto
Upload(Proxy)

AZa2—00Ov I =R T 2

| MENUDZHE®UEN S, MENU ON/

OFFAA vFZBELRIC, By b7V T
X1 —"RRIT Do

XZa—MUser >Camera Config >User

Menu with LockZZ5R/R g ©,

[OFRE]

o MENUDEHZUIEN S, MENU ON/OFFX
A vFZEBUTIFDHE. Camera Config >User
Menu OnlyhiUser Menu with LockIZ8ID D
ES8

o MENUDEHZIHEFICTMENU ON/OFFR A v
FEMUTFSD. FEMENURSY >V Z#LTA

—a—RmnUcBEIE. Camera Config >User
Menu with LockldZRRENE B Ao

Off 2R U CMENUDE H 72T,
Ea—TrA VY —BEERRD. BIES
AJEERICTIDBODOET,

AZa—Z0v o UleEEDIEIESZ A
119 %,

ATTTEDEUEIFA4HTD0000 ~ 9999 T,
HEZADUCMENUDEHZHT & H—
VIVDVROMICEE LE T,
IRTCOHT7ZEASILED, SetlChH—V )LD
BEHULET,

SetlCH—VILhidDIREET. MENUDEH
ZHY,

ATIDEELE T,

AZa—Z0Ov I U EEDEIES EA

HUEESH—HUIEHBE. Ov IDEER

TETEDA Y E—IPRREIIN, £X

Ta1—RRICYDBOOFET,



13 78 XIZa—RREFHRIE : Ly b7y T XT3 —DERREE

[CFR]

o XZa—7ZOvI UlcEEDEIESEAA LI
BSDA—HOHEF. Dy IZBRTETEvo

o HEEIES(E. BSNcEEDEHIT. FlCaine
Kl ELZHIITHLET. RNfceElF. U—
EXEOICBEVEDELEE L,
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UserX = 1—DiRE

UserX Z 2 —MEdit User MenuTIEE DB
PHIBR. IBEDANIEZ EEZITL)., UserX
Za—ZLDFEVPTLIRETOCENTER
ER

Operation X Za—. PaintXA=a1—,
Maintenance XZa—DEEDIER. LV
—BBDFileX Z2—MIEEZER LT, UserX
Za—ICBIMT ST ENTERT,

UserX Za—([CIFIEBZ 20BX CER CER
9, TIHBHERICFOERESRSINTVEITH.
ZDOBEDVEBFHBRCEREWCo. FRIC
19fEX CIEEZEMNTERT,

[CEFE]

AZ1—0OvIHFRETET Ao

Edit User Menu Format Media
S Back Media(A)

2 Media(B)
Format M
b CaralUity)

Rec Function SD Cart(Proxy)

Input/Output

Clip

Assignable Switch
Camera Config

I6H MEZEMNT D

Edit User MenuBIEZZ&
NCRA

UserX— 2 —0imE(FEdit User MenuBEE T
TVET,

| MENUDZE#HEEBILTX =2 —0DUser
>Edit User Menuz:&iRU. DFEHZHT,

2 |User pm Edit User Menu
»m Format Media
Rec Function

. | Input/Output

" | Clip

Assignable Switch

il | Camera Config
Edit User Menu
Operation

Edit User MenuBEENERRINE T,

| MENUDZ#%E L TEdit User Menu
>Add ltemZEIRL. DFEHZHT,
EIND TR EENERENET .

7 MENUDEH%RE L TENY 3EEEER
L. DEHEHET,
BT B MEERINT DEEHERSNE
o

Add Item
S Back

Al

Format

¥ Frequency

¥ File System

¥ Rec Format

¥ Aspect Racip (SD)
¥ Audio Length (IMX)

3 MENUDEH%E L TENY BB EZR

L. DEHZHT,

INCOMBZENT DHEIFAIICTF T Y
JEMITET,

BT 2B ZEET 25%5(E. EINT D
HEICTF T v IZMITFET,

4 MENUDZ=#%EBILTOKEERL. DEH

ZHY,
IRH /HEDEMDSE T UEX T,

[TEE]
BUERE #MBEZ 2SR T DL TERBA. FE
MUIRE MBEDRMNZERE TS EFTEF A,

IEHDMEZiRE S ©

KNI DEEZFRICRETDCENTEFT,
] Edit User MenuZzZ&RR9 %o

7 MENUDZ=H%E L TIRES 2EEEEIR
L. DEHEHET,
REMEED 2 NDRTENET,

3 MENUDZEH%E L THREMEE 2 RO
Edit Sub ltemZEIRL. DFEHZHT,

Edit User Menu Format Media
9 Back SBack

Format Media LD
Move
Edit Sub Item

Rec Function
Input/Output

Clip

Assignable Switch
Camera Config

Edit Sub ltemBEENFRENE T,

Edit Sub Item
S Back
Al

¥ Media(A)

¥ Media(B)

Format { 1-2 |

™ SD Card(Utility)
¥ SD Card(Proxy)

BAICEVEEEF. INTOMBICF T Y
IV TVETY (TRTOMBENERREIN
DIRAEE) .

HEDF T v IZEHNT EUserA Za—[CK
MENBELIEDFET,

4 MENUDZEH%EEIL TOKEER L.
wRY,
FENETUET,

DEH

IEH7ZHIFR 9 &

] Edit User MenuZz&RmRd %o

7 MENUDEH%E L TRET BIEEEER
L. DEHEMT,
REMEEU R MR TENET .

3 MENUDZH7%E L THREEE R ~OD
DeleteZ#EIRL., DFEHEIHT,

Edit User Menu Format Media
S Back SBack
Format Media
Rec Function LD
Edit Sub Item
Input/Output
Clip
Assignable Switch

Camera Config

IREAHBRESNE T,

IEHZRET D

] Edit User MenuZz®&RR9 %o

7 MENUDEFH%E L TEET BIEEEER
L. DEHEMT,
REMEEU R NETENET .
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3 MENUDEHER L TIREMEE 2 ~OD
MoveZZEIRU., DFEHZHT,

Edit User Menu Format Media
S Back SBack

Format Media Delete

Rec Function Edit Sub ltem

Input/Output

Clip
Assignable Switch
Camera Config

BETDIREN/\A 54 N, BE)FTZ
Y =AN—J LRDRREINE T,

Edit User Menu
S Back
Format Media

Rec Function
Input/Output
Clip

I_” " Ili | -

BEFEZRI =AY —T iR

4 MENUDZEHEBLT=AY—2 L85’

BElcEbhE. DEHZEHT,
IBEEI BB UE T,

Edit User Menu Format Media

+Back Media(A)
ST :I;(g:(z)(uxim )
IOz ) Cart(Prox)};
Clip

Assignable Switch

Format Media

Camera Config

UserX Za—Z=T 15
BFODIRREICR T

| MENUDZ#%E L TEdit User Menu

>Customize ResetZERU. DFHZH T,
Customize ResetBHEN'FRRINE T,

7 MENUDZFH%E L TResetEZIR L. DF

BT,
REENRRENE T,

3 MENUDEH7%E L TExecute &R L.

DFERMHZHT,
UserX Z a—h\TBHERFOKREICRD &
e
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UserX = 1— (TEHERFOER)

THEEROUser X Z 2 —([CFUTFDEEHIZENTVET,
e Format Media (108X—2))

e Rec Function (109X—2))

¢ Input/Output (108 X—2))

e Clip (114}%—)

e Assignable Switch” (110_—2))

e Camera Config” (124_—3))

1) BB <0>7ZkR<
2) #B(EUser Menu OnlydDd*

UserX Z 1 —DREICDVTIE. [UserXZa—DiR&E] (104R—V) ZTEL T,
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OperationXZ=1—

ARFET VI —5A VTRRENTVSREREF. HERODERETT .

Operation >Format

Operation >Format
BRTDVATLERE. T7AIVYRAT A SR IA—N Y b BRI ANT hMERELFR T,

FRITDVATLBRE. T7AIVVAT A BRI+ —~N v b, g7 AN MR ELE T, I8H REE AE
S| REE NE Rec Format HD422 50 1080i T7AIYRT LWUDF, YR T LREEHED
Frequency 50.94/50/29.97/25/2398  YRAF LERHEEIRT 3 (Execute TET). HD422 50 720P 59.94F1E50DEE
o HQ 1920X 1080i

[TFE] HQ 1440X 1080i

VAT LERBOEE(SER LT, TDOVAT LBER HQ 1280X 720P

BTLFRE U TW/cRec FormatlCyIbiEbbE T, MPEG IMX 50
File System exFAT/UDF/FAT T7 AWV AT L7ZYIDER D (Execute TE DVCAM

1o HD422 50 1080P T7AIWY AT LBUDF. Y X7 LBEEEH
Rec Format VAT LEEHOEEICRNUT BT+ —< Y hEIRT S (ExecuteTE HD422 50 720P 2997, 25FfclF23.98D&E

ZDd.

1o

XAVC-1 1920% 1080P
XAVC-1 1920X 1080i
XAVC-| 1280% 720P
XAVC-L 50 1920% 1080P
XAVC-L 50 1920% 1080i
XAVC-L 50 1280 720P
XAVC-L 35 1080P
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i

HD422 50 720P

HQ 1920% 1080i

HQ 1440X 1080i

HQ 1280%720P

MPEG IMX 50

DVCAM

D7 AWV RAT LBexFAT. D RT LEREH
59.94FcF50DEE

HQ 1920% 1080P

HQ 1920 X 1080i
HQ 1440 1080i
HQ 1280%720P
SP 1440X1080i

T7 AV RT LDFAT, VAT LREREH
59.94FfcF50DEE

HQ 1920 X 1080P

T7AIVDRT LBFAT, YR T LEREA
29.97. 25FfElF23.98DEE

Aspect Ratio (SD) 16:9/4:3 SDE—RDFP ARG hM7ZERT 8,
Audio Length 24bit/16bit IMXT #—< v bEDF—F 1 AEEFEOE W b

HeFEIRT Do

Operation >Base Setting

BREICEATSIA IV IV IERELFT,

XAVC-11920X 1080P
XAVC-L 50 1920% 1080P
XAVC-L 35 1080P
HD422 50 1080P
HD422 50 720P

HQ 1920% 1080P

T7 AV RAT LD exFAT. AT LEREH
2997, 25FTcld23.98DEE

[CEFE]
AIFEDOHDR LICENSE (CBKZ-SLHL1) fSAFICDHRREINE T,
B[S HEE AR
Shooting Mode SDR/HDR SDR : HERDIFENLE T A FZ v I UV I DR

BE— NICERET Do
HDR: 472w oLy IR UTIRIGE—
NICERET Do
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Operation >HDR Setting

HDRERKDHDDEFSIN. BRUHIIRHZRRLET .

Operation >Input/Output

AN/ HNESERELF T,
IE[S HEE AR
SDI Qut2/HDMI Off/On SDI OUT2ikF. BKRUHDMIHRFHBDXF
Super 15| (R—I\—A VIR—=) HH%=F >/ FTF
éo
Video Out Super Off/On VIDEO OUTIHFH DX FIER (X—/\—1 >

R=2)BHZEF> /AT B,

[TEE]
BIFEDHDR LICENSE (CBKZ-SLHL1) R ICDHFRTREINE T
I5H REE AE
HD Rec/Out HDR(HLG)/SDR Operation >Base Setting >Shooting Mode
HHDRD & EIFHDR(HLG). SDRDEEIFSDR
HRREINKT,
Color Space BT.2020/BT.709 Operation >Base Setting > Color Spaceht

HDRD & EIEBT.2020. SDROEEIEBT.709H8
KRSNFT,

Operation >Format Media
XFAPEITF—X v hUFET,

Down Converter Edge Crop/Letter Box/

Squeeze

SDIESZHITDEEDESERE— N =

RT 5,

Edge Crop : 16:90E(&ROMHmZE v b LT4:3
EfRELTHEAIT D,

Letter Box : 43EID L TFZY I LT, B
EHFRIC16MREZERTRT Do

Squeeze : 16:98& = G EICHIINL T4:3
BERELTHEAT D,

15H RIEE NS

Media(A) Execute/Cancel AOv FADSXSAEU—hH— RZ¥EET 5
(Execute TRIT) o

Media(B) Execute/Cancel A0Ow bBDSXSAEU—H— RZ{HIET D
(Execute T=HIT) o

SD Card(Utility) Execute/Cancel UTILITY SDA— ~ROw bDSDA— R7ZHIHE
{£9 % (Execute THEIT) o

SD Card(Proxy) Execute/Cancel PROXY SDA— RXROw bDSDA— RZEHEA

{£9 % (Execute THEIT) o

Wide ID Through/Auto

SDHAESICDA RERIESZAMT o E

IH7EEIRT 2o

Through @ D4 RERIESZMIME FICETDFH
FHAIT B

Auto : DA RERIES M SqueezeD & E,
FTHESICOA RERIES ZAMULTES
I

Operation >Input/Output

AN HEHESZERELERT.
LS| EE NE
Output Format VRT LEEROFREICIHGUT HAT+—< v MEEIRT D (Execute TE
EDd. 1o

IR T 4 — N v MMCKDEREBHEED (42
R—I),

Wide Mode(Ext.) Auto/16:9

AFMESHSDDEE, DA REEERDHIE

FEZERET Do

Auto : AJMESDTUA REEIEEN Squeeze
DEE, PART hEZE169E U TR
Do TNLSME. 43&EUTEERT Do

16:9: BICT ANRT ~b7Z169& UTEERT D,

Operation >Super Impose

A=)\~ VR=XENBDNFIERN—N—ZRELF T,
=[S RIEE NS
Super(VF Display) ~ On/Off Input/Output >SDI Out2/HDMI Superakfz
Super(Menu) On/Off [FInput/Output >Video Out Superb’OndD &

E(C, SDI OUTiwF&TzIEVIDEO OUTiwFhH
SOEHICA—)\—A VR=AENHXFIER
ZRIEECEICAY A TT Do

Source Select Camera/External EFFASY —RZENASE (Camera) [CT D
%‘SDI INIEFDSDANNESICT DHERIRT
SDI Out1 Output On/Off S%)DI OUT1RFDSDEMNMESZF Y /4 TF
SDI Out2 Output On/Off S%)DI OUT2ImFHSDENESZEAY /" FTF
HDMI Output On/Off HISMI&%?D‘5@5:'7]1%%%2’7/2’7@'50
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Operation >Super Impose
A=)\ VR=AENDXFIERN—N—ZRELF T,

Operation >Rec Function
el E— FZERELE T,

S| REE ANES 158 REE NES
Super(Marker) On/Off Input/Output >Video Out Superh*Ond & Picture Cache Rec  On/Off EoOFv—FvvialbwIE—RZELFY /7

EICVIDEO OUTImFHSDHEAIC, Input/
Output >SDI Out2/HDMI SuperBiOnd & &
([ZSDI OUTimFH 5 DHEFICA—)\—A R —
AESNBN—N—KRREAY /FTT D,

T3, (COREZONICTDE. MDKhE
FE— RORENOMCED.)

Operation >LCD

LCDEZF—ZRELE T,

Cache Rec Time

SR 4 —N v bOFREITIHU
TEDD,

Picture Cache RecDEFENONDHZHIC. ED

Fy—FrvyalyvIBEZERT D,

@ FULIFINBROIEIFv—FvrvyalbvoE—
RERTE] (176R—V) mTELEEL,

BE REE NS
LCD Color —99 ~+0 ~ +99 LCDEZY—EEDEDRES ZHET D,
LCD Marker&Zebra  On/Off LCDEZA—DN—H—FRnELITSHRRES

/AT B

Interval Rec

On/Off

A=)V TE—RELY / FTTB
(CORFEZONICTDE. fDRARECRE—
DFRENOCIED.)

Operation >Rec Function
BRI E— FZRELE T,

Number of Frames

Format >FrequencyDs&E(C
IHUTZEDD,

Interval RecDERENONDIZEIC. A5 —)\
JUIREZBEMD 1 BIDECHER T L — LABZRET Do

2frames/6frames/12frames

iR T4 —N v DT L—LL—RD50P,
590.94PDEE

I5H REE & Tframe/3frames/6frames/ SR —~N v hDT L —LL— H23.98P,
Slow & Quick On/Off 20—-&94 “{OE—D AavE— F’Ez“//? 9frames 25P. 29.97P. 50i. 59.94im&LE
Motion J9%. (COREEONICTDE. MDRHE  |nterval Time 1/2/3/4/5/6/7/8/9/10/15/  Interval RecDIBENONDEAIZ, A >5—)t
FE— FOREHOICES.) 20/30/40/50 (sec) JBRASDSRERIE (1 > 5—/\L) BRET
Frame Rate ST —~ v hDERECIHL  Slow & Quick MotionfRENONDHZEIC., R 1/2/3/4/5/6/7/8/9/10/15/ 2o
TEDD, O—8& A4 v IE—YaviEelOTIU— 1A 20/30/40/50/ (min)
L—hZEREIRT D, 1/2/3/4/6/12/24 (hour)
1~60 TP AWV RAT LDexFAT. B8R T4+—<w b Pre-Lighting Off/2sec/5sec/10sec A25—=)\bLy JIRERIBRICET A 54 b~
BXAVC Intra. XAVC LongD&E ZRASEHRFAMFICROSEDIHZE
1~50 J7A)VYAT LHUDF, BRI 4 —< v b R AT BBENEGEFOFEEIRT 5.
MPEG HD 422 50M (1280x720). 50P/25PMD Simul Rec On/Off ARXOw ~&BAOw bADEIRFECERIEREZ A
ks VAT Do
1~30 77 AIVYAF LexFATFIEIEUDF . &2 Operation >Proxy Recording Mode
]I+ —< v SHMPEG HD 422 50M IO+ ERELET,
(1920x1080). 29.97P/23.98PDEE p— —
1~25 T7A )Y AT LDexFATET2IFUDF. E2 SE AEE s
~ 74V AT Lhlex - .- - — -
575 —< v RAMPEG HD 422 50M Setting On/Off TOFVERZET Y /T T Do ‘
(1920x1080). 25PMD &= Size HD Auto(9Mbps)/ JOFVEFR T+ —~N v bDOY A XZEIRT
Clip Continuous Rec On/Off OUwTAVT 4 ZaFPAVYIE—RELY I]—|2D8éu7t§(()6g/\’vl?gs)// e
A TR, (COBREEONCTBE, 1D ]28OX720E6MbPS§/
ISR E— ROBEDOMIESD.) . 40xX3 o3 Mbg’:) y
480x270(1Mbps)/

480x270(0.5Mbps)
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Operation >Proxy Recording Mode

Operation >VF Setting

TOFVERZRELE T, Ea—J7AV5—BEEZRELE T
I5H RIEME NE IE[S RIEME NE
Frame Rate 23.98fps/25ps/29.97fps/50f  TOFVEER T4 —N v DT U—LL— b2 Peaking Frequency Normal/High Peaking Type®Ds&ENNormalDFE(C, E—
ps/59.94fps ENCIEIN F I EREZZE (Normal) (T DNh'E
Bit Rate 9Mbps/6Mbps/3Mbps/ JOFVER T —< v hOEY hU—hER (High) 9 &0\ 2EiRS & (CBK-VFO21EAH) .
TMbps/0.5Mbps NCESN Peaking Color B&W/Red/Yellow/Blue Peaking TypeDsREN ColorOHBEIC. E—F
Audio Channel CH1/CH2/CH3/CH4 JOFYF—H (R BT —TAFF v IR > DETERY S (CBK-VFOLFR).

WZEERS B

Operation >Assignable Switch

TUAFTTIVAA Y FICHREZEIDZHTET .
& BEDRDETICOVTHULIE [PUAFIIVAA v FICREEZEIDETD] (134X—) ZTEI RS,

B&W : BE
Red : 7R
Yellow : &
Blue : &

VF Detail Level

—99 ~+0~+99

ALD—F—RITHIFEE2—T 745D
T4 T—=ILLANIVZRET D (HDVF-20AEA
).

Operation >Marker

Ea1—J7 AV —BEERDN—A—RnZRELE I,

IE[S REEB S

<0> 134R—Y ASSIGN. 0R A v F(CHREZEID 1T B,
<1> 135R—Y ASSIGN. 121w F(CHREZEID 1T 3,

<2> 134R—Y ASSIGN. 221w F(CHREZEID 1T 2,
<3> 135R—Y ASSIGN. 3R v F(CHEREZEEID BT D,
<4> 135R—Y ASSIGNABLE 421w F[CHEEEZEID KT D,
<5> 135R— ASSIGNABLE 521w F[CHEEEZEIDH T D,
Lens RET 137 R—=2 U XDRETIRG » [CHEBEZEID BT D,
Online 135R—=Y ONLINERZ V [CHREZEID H TS,

Zoom Speed 0~20~99 ASSIGNABLE 4&felF5 24w F(TZoom =

DA TCTEHEDEFEREZRET Do

Operation >VF Setting
Ea—DJrAV5—BEEZRELRT.

158 RIEE NS

Setting On/Off IRNCDN—N—RET Y /T T B,
[CFE]
ASSIGN. 2[CMarkerZzgID HTTCWVBIHBE. CORE
[FERTT,

Color White/Yellow/Cyan/Green/ NY—H—DFRREZEFEIRYT Do

Magenta/Red/Blue

Center Marker 1/2/3/4/0ff TV —N—N—EERRT DHEFTDERE
ER. RRUEWVSEEFOZERT 5.

Safety Zone On/Off C—IF A —I-VORRELY /FTT B

Safety Area 80%/90%/92.5%/95% =07 4=V -V OHEEERT B,

Aspect Marker

Line/Mask/Off

T ARG N—H—7ZKRI dHald&RRAE

ZER., BFRUEVWEEFOMZERYT 5.

Line : BfRCTERRTI Do

Mask : ¥—H—8ENDETFES L)L
TFTERT B

=[] REBE NS

Color —99 ~+0~+99 Ea—T7A V5 —RGDBDESZHAET
Do

Color Mode Color/B&W Ea1—TJ7A4 25 —DFRRE—RZEIRTD
(CBK-VFO21s#EFEH%) o
Color : H5—
BRW : B&

Peaking Type Normal/Color E—F > J D= RINT © (CBK-VFO2{EA
H%)O

Normal : BEDOE—+>7
Color : AZ5—E—F2J

Aspect Select

15:9/14:9/13:9/4:3/1.66:1/
1.85:1/2.35:1/2.4:1

N——DT AN NMEZZERYT Do

Aspect Mask

0% ~ 12% ~ 15%

Aspect Markerf*MaskDIiF&EIC, ¥—H—
EADETAESUANIVICHT < —H—#0H
NDEFTFESUNIVERED Do
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Operation >Marker

Ea—D7 AV —BEDN—H—FRZRELF T,

Operation >Auto Iris

FT—hPAURZERELFT

IE[S REEB S 1B HEE NE

Aspect Safety Zone On/Off TPARG b =TT 44—V —=IUX—h—T=4~> Iris Override On/Off RO ZHAEEHFTCIEACEHCTHREZS
SFTT B, VST TITB

Aspect Safety Area  80%/90%/92.5%/95% TARG b =07 4—V—=UX—H—DKE Mode Backlight/Standard/ Z— b7 AU ZXDHEEHE— FZEIRT D
S (EEZ2EFCNT D) ZERT 2. Spotlight Backlight : )X\w IS4 hE—R (D EHDH

100% Marker On/Off 100%DE— 77 « ——X—H—DET%E SEDEHDEE, RADEENT ST~
RSt Erk S E) 4 BEE—R (F 7Y 3 VOUED

N N — N tandard : ZZ#EFE—R =V >

User Box . On/Off 71'?‘/77\7] \/)b@%ﬁm%\j/‘/j?f“%)o\ B EE R /)

User Box Width 40 ~ 500 ~ 999 /T\;‘J 77\:?: VILODIE (b S EAImE TD Spotlight : ZRw hSA FE— R (FFDEHED
ERt) T 2o WEHIC AR Y M54 MBIz o TG E

User Box Height 70 ~ 500 ~ 999 Ry IZAA—=VILDEE (bS5 ETHERT T BBNZERIDHIE—N)

DEERE) ZHET Do Level —99 ~£0 ~+99 IREELAILEREYS D (EDVAEVELH

User Box H Position  —479 ~ 0~ 479 MO 21—V )LDFDDKFAIBERET BDHICHED),

2o Speed —99 ~£0~+99 IR — R (REOZALICN T DRIGEE) %=

User Box V Position  —464 ~ 0 ~ 464 Ry I AAN—V )VDORDDEBABZHRE T RET D (BAREVEFERMIFELED) .

o Clip High light On/Off SEESOREERELT, BBEICHIBR

Operann >Ga|n SWltch m%ﬁq<éﬁé%ﬁg%jy/jjgéc

TAMEDYIDIRA FREZE LR T Detect Window 1/2/3/4/5/6/Var A—bTPAVRRED 1« RODBEZERT

| BEiE Pz 2o

- o B A - - Var . g%

Gain<L> —3dB/0dB/ GAINRA v FDIREDLDFZEDT A B7%%E -
3dB/6dB/9dB/12dB/18dB/ RT3, Detect Window On/Off F—bFPAVRRED 1« > OO =EY——
24dB/30dB/36dB/42dB Indication TR DWBEZ A " F T T %o

Gain<M> —3dB/0dB/ GAINZA v FDBREHMDIESD Y A E%E Iris APL Ratio —99 ~+0~+99 Auto IrisOModeh’Standard DF&EIC. F—
3dB/6dB/9dB/12dB/18dB/  SEIRT B PP AV ZREOE—D S FIEODRSLE
24dB/30dB/36dB/42dB BET Do

Gain<H> —3dB/0dB/ GAINZ A v FDBENHDIBEE DY A ViE%E Iris Var Width 40 ~ 500 ~ 999 Iris WindowhVarDB&(c, D« >~ RODiEZ
3dB/6dB/9dB/12dB/18dB/  EIRY %, BET 2.
24dB/30dB/36dB/42dB Iris Var Height 70 ~ 500 ~ 999 Iris WindowhWVarDiB&(C, D42 RoDEE

Gain <Turbo> —3dB/0dB/ Turbo Gain#gE &SI D ST 7 YA FIIVA ERET Do
3dB/6dB/9dB/12dB/18dB/ A wF=EFVICUTc&EEDT A MEZEIRT Iris Var H Position —479~0~479 Iris WindowhWardiZ&(C. D« > RO DKFE
24dB/30dB/36dB/42dB Bo FHRADABEZRET &0

Shockless Gain On/Off Y3y IVRTA Y (TA VHIDBRRABFICR Iris Var V Position —464 ~ 0 ~ 464 Iris WindowhWVarDB&(c, D+ > RODEE

L—XICEDIDBDDHEE) 24>/ FT9
50

AEDAIBZRTE S Do
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Operation >Zebra
Ea1—T7 AV F—I[CRRSNCVBIRICH UL CE T SRRZRE LR T
[TEE]

HLG Display AssistahRISRRENEE Avo

Operation >Display On/Off
E1—Tr7 AV —HHICKRI DIEEZRELF T,

155 REE NE

IEH ERIEE NS

Zebra Select 1/2/Both CISRTOBE(ETS1, €732, Ffeld
y5) ZERT Do

Zebral Level 0% ~ 70% ~ 107% TIS1ZRRITDUNIVERET Do

Zebral Aperture 1% ~ 10% ~ 20% TIS1OT7NN—F v —UNIVZRET Do

Level

Zebra2 Level 1% ~ 100% ~ 109% TII2ERRTDUNIVERET Do

Operation >Display On/Off
Ea—TrA V5 —BHEICKRI DEEZRELF I,

I5H REE S

Video Level Warning On/Off EDRD T EDHERICIFEITETDHEDE

ERNEAY /FTT B
Shutter Setting On/Off VP wEI—FE—REY Y I—AE— ROFRR
AV F T B
ND Filter Position On/Off NDT 4 LY —REDKRTZEA Y /4 TT o
Gain Setting On/Off TAVRERTNEL Y /T TT B
Rec /Play Status On/Off SCiR. BEREBORRZL Y /479D,
Color Temp. On/Off EBRERNEL Y /T TTD.

Frame Rate/Interval  On/Off YKRECIRE— RRNZEA >V / F T T D,

Battery Remain Auto/Voltage/Off Ny T8/ ANEBEERLZRET Do
Auto 1 /\y FU—FERIICIL UTEREZ R
Voltage : /\w T U—1ERIICEAD ST ANBE

[ElE N

Off i ‘A7

Timecode On/Off HALT—5 (FALD—R, I—F—Ew
Fab—YaV)RnELFY /FTIB,

Audio Level Meter  On/Off F—=FT AT UNIVA—=F—DRRZL /" F 7T
T Do

Media Status On/Off XT A TIREDRINEL > /F T T Do

SD Card(Utility) On/Off SDA— R (Utility) IREERIRZEZ > /A4 7T %,

Focus Position Meter/Feet/Off VY ADT#—HARIY 3 VERRT dHE
SHh ERREMZEIRYT D,

Iris Position On/Off L XDTPAIVRRI Y I VRNEA Y /Z T

ERSD

Zoom Position On/Off VY ADA—LRIVaVRNZEL Y/ FTT
%o

Extender On/Off VABROTIRT VI —DRNES YV /F
7T %

ALAC On/Off INEFIEDRRZA > /74 TT B,

AE Mode On/Off AEDE— REREDAELANLDEEBDRR
BAY /A TT B,

Focus Mode On/Off T4 —NAE—RRRZLY /A TI D,

White Balance On/Off ROA SM\SYRAE—REKRRELY /FTT

Mode %o

CC5600K On/Off CC5600KDFRRZEA Y /A TT %o

Rec Format On/Off BRI+ —NY hDRRELY /FTT B,

Gamma On/Off BIRETNTWVWDGammaDiEBDRR~ZA >/
4792,

Timecode Lock On/Off FALID—RDRRZEAY /A TT B,

Network Condition On/Off Ry NI —DEBEIREBORRZEA > /40T
%o

Proxy Status On/Off TOFVREOERRZET Y /FTF Do

NW Client Mode On/Off XY NI—=D0SAT7 Y hE—RKRRZESF Y/

Status F79 %,

Streaming Status On/Off ANV —ZVTREBORR=ZEL Y /F T T B,

GPS On/Off GPSZEREBDRNZA Y/ FTF B,

Video Signal Off/Waveform/Vector/ HAREESOREBRTOA Y F T, BKU

Monitor Histogram KNI DETHESDEEZERT S (19
R—),
[CFE]
RDBAFFRRSINEE Ao
AZa—®M0Operation >Input/Output >SDI Out]1
Select&SDI Out2 Selecth' s & BHOFfDE E,
AZa—M0Operation >Input/Output >Output
FormatMEREN720x480PF fzld 720x576PMD & T,

Clip Name On/Off U TEDRTEA Y /T T B,

Focus Assist On/Off T4 —NATFP VA NDRNEL Y /74 TF B,

Indicator

Focus Area Marker ~ On/Off TH—HATUTPN—H—DRR=EA >/ F T

ERCD
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Operation >Display On/Off

Ea—T7A2VY—EHEICKRS DIBEEZRELE I,

Operation >White Setting
ROA MU RARICEET DREZXLE T,

B8 REME ot BE REME Rz

Lens Info Meter/Feet/Off SREEEFRS DN ESNERREMERZIR AW Speed 1/2/3/4/5 ATW(BERERR DA NSV R)DBBEAE—
9% REEIRT 2 (1 BEREEL).

WRR RF Level On/Off TAVLUALY—I\—DZ{EREDRTES >/ ATW Mode Natural/Pure ATW (BERBER MR T A MSR) DEEZESR
SETT B FY %o

Clip Number On/Off 91w IERDRTELY /T T %o Natural : ~—>DBAHE(CIGUT, BRES

Operation >"I"LED

Ea—DJ7A25—D""RRZRELE T, (HDVF-20AERARCEMNERECTT )

EITIED LD ICATWZEENRET
2o
Pure | BHPHRFDBZEZETFIC. KDRE(C

158 RIEME W& EDFDRDICATWZEERET D.

Gain <!> On/Off T4V H0dBESAIERESN TLDIHEIC, | AWB Fixed Area On/Off BIEARESTAWB (F— bR DA KISV R)
SV TERASEDMEEES Y /HTF Do ZRITT Do

Shutter <!> On/Off SHUTTERR A v FHONICERESN TV DIHE Filter White Memory On/Off White BalancehiPresetR fa(FATWD EE(T,

(S | SVTZRANSEOREE=ZS > 4 T9
Do

White Preset <!> On/Off

WHITE BALAA v FHPRSTICERESNTLD
Falc. | SVTERASEDMEEZS > /7
PERE

ATW Run <!> On/Off

ATWHYERENTLDHEIC,
SEOHREZES Y T TT D,

| SV T%RA]

Extender <!> On/Off

TIGIWIORT VY —HEE. FlelFL VXD
TORTVI—PMERSINTVBEBEEIC. |5
VIERNIS B EL Y T T T B,

FILTERDFEHDRY Y 3 vESTEITRTA b

INSVADAEY —BEHZRES Do

® Assign/ia >/ (CElectrical CC Z&IDHTT
Wb EE(F, Electrical CCOA, B, C. DIC
TNEIMIDORT A bOAE —EE =
9D,

® Assignia >/ (CElectrical CC ZEIDHTT
WEWEEE, FILTERDFEHDRI Y 3 VE
STEITNTA S RDAEY — B %=
RET Do

Filter <I> On/Off

NDZ A LT =B LACRESNTVDHE
(S | SVTZERASEDDREZEST > Z D
ERSD

Operation >Offset White

ROA MGV Ty MEICET S5REZITLE T,

Iris Override <!> On/Off

F— P AURS—=)\—=Z4 PHMREBLSC
BESNTCWLBDHZEIC, | SV TERAISES
WeEZZ > /A TF B

I5H REE RS
Offset White<A> On/Off AEU—ADRDTA NS VRICHTEY ME

ZH0g S (On) BMIIILEWLD (OFf) Z52R
EECE

Operation >White Setting
ROA MNSVRFRICEIT BHREZLE T,

IEE RIEE NS
White Switch<B> Memory/ATW WHITE BALZ A v FDEREDBDZEDEIE
E—RERTET D,
Memory : Z— bIRDA bKSVRX
ATW : BERBERTA M VR
Shockless White Off/1/2/3 WHITE BALRA wFHIDBWZ BFDYIDED D

EREEZERT S (1RDREV).

Warm Cool <A> BZOEEEZRR Offset White<A>HOnDBE(IC. XEU—A
(#71600K ~ 3200K ~ DIRTA NS VRITAMT DS Ty bR
16000KIZE) BETHRETSD (A 7y hOBEENESNE

EREDKRE L ILDEHEBRDIM G ZE BIFN 55
),

Warm Cool —99 ~+0~+99 Warm Cool <A>DERE CHEDIEHE SN

Balance<A> HBholeBEIl. EHICHN <K BRERRET

éo

Offset White <B> On/Off OnlCgdECCTREUEA 7Y hDBF v

VRIVDIRDTA MNS VAR MEND.
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Operation >Offset White

MOA NSV RZ Ty MEICET D5REZTVE T,

P

Offset White<B>HOnMiFE(IC. XEU—A
DIRTA MG VRITHMT DA Ty bt
SBETRETD (F 7y hOEEENREVNE
EREDKE L IFDICHRBOMGZE RGO S

o

Operation >Clip

Uy TDRMPEERICRTOREZ LFR T,

[TxR]

Uy TRDEPNDXF%Z [ DESICULIENTLEEW, U w TRZORIIDIFD I ICIE>TWD I U v TE,
dVEa—9—tD7PTUT—23 VYT RO TP CHETEET A,

155 REE

PE

=[] REB

Warm Cool <B> HZOEREZRR
(#1600K ~ 3200K ~
16000K*2E)

Warm Cool —99 ~+(0~+99

Balance<B>

Warm Cool <B>MDERTE CHEDIIENFE SN
BHofegall. TSI < BRERRET
%)O

Operation >Shutter
Yy I —DEEE— FZERELFR T,

Clip Naming Title/Plan

Uy TRODBEREZERYT .

Title : Title Prefix CERICERET Do

Plan : 7S5V Z VI X9 7 =5 THRE LI
(LD (TS IAXIT—ITHREL
fe2IDIEWEEIE. Title Prefix CEREL
feRH#NCT D),

155 REE

P

Mode Speed/Angle

BTV vy I —DEEE— RZEERT D

Speed : ¥ ¥ vHF—RAE— R7ERE FPEAD)
TRET Do

Angle : ¥ vy 9 —2E— RZEBE (B81) T
HET Do

Title Prefix NEI V]

XFHNDANBEECTO U w TRADEY A LB
(4 ~ 46XFDHRYF) ZREIT D (101 X—
o

Operation >Slow Shutter
AO—Y vy y—7ZRELFRT,

Number Set
5 ([REWsR)

Clip NamingDERIC KD ZED

OV TRDESELDZRET Do

Clip NamingDsREN TitleD EE
0001 ~ 9999

Clip NamingDs&ENPlanTT SV ZV I XS
TR 00— RENTVBHEE !
00001 ~ 99999

158 REME NS
Setting On/Off AO—Y vy —tpee 4> /T3 B,

Number of Frames  2/3/4/5/6/7/8/16

A0—2 v v 5 —HKEEODZEE D L — LABZERE
EESN

Operation >Update Media
AT A PREBET 7 A )VZEF LRI

Operation >Time Zone

REZRELET,
I5H REE &
Time Zone UTC +14:00 ~ UTC UTC (FU Zw IR#EE) h S DEEZ 3008

Greenwich ~ UTC -12:00

(302841

I CERT D

[CFE]
T7 AWV AT LADFATICERESN TS EE. COBEEIFFERTEFEA.
IES BEME RS
Media(A) Execute/Cancel 20w FADSXSAXEYU—H— ROEEBEHR%Z
B9 D (Execute TEIT)
Media(B) Execute/Cancel 20w FBDOSXSAXEU—H— ROEEER%Z

FH 9D (Execute TEIT) o

Operation >GPS
RIRIERR (GPS) ZA4 > /AT ULERT .

158 RIEME NE
GPS On/Off GPSHRE=ZA > /4 T T 2o




15
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Operation >Planning Metadata
TSV IXIT—IDRIEICEHT HREZLF T,

I5H REE S

Operation >USB
SXSA— RRAOY MMTEASNICEIRA T « PAD I U w TZUSBAT « P ([COIE—T & EEDHRME
[CRIT 2R EZLF T,

Load Media(A) Execute/Cancel SIot(A)DSXSXEU—H—Rh TS0 F
A F—=5%0— KT D,
Execute’i®#IRd  ESIot(A)DSXSAEY —
H—RICRESNTVD TSV VIR T —
DT 7AIDH—ERREIND. T7AI7ZE
RIdE. FHHBEEAFRRIND,

[TFR]

T7AIYRT LDFATICERESNCLD EE. D
BRERRSNEE .

Load Media(B) Execute/Cancel SlotB)DSXSAEU—H— Ko TS
A F—5%0— KT D,

ExecuteZ@iRd 2 &SIot(B)DSXSXE —
N—RICRBFENTVWD TSV Z VI XY T—
FDT7A)IH—EBERREIND, T7AI7ZE

RI2E. FHBEDIRREND,.
[TER]

T7AIYRT LDFATICERESNCLD EE. D
HREERRSNEF B,

15H REME S

Format USB Execute/Cancel USBA T« 72431 T % (Execute THEIT) o

Copy to USB Media(A) to USB/ SXSH—RFXOv bROITRTDI Y v Te—
Media(B) to USB/ FIOE—92&E WROROY MMEEIRYT D,
Media(A)(B) to USB Media(A) to USB : O w RAICHERAETNTULY

BDEEAT A 7DINTDT 1w TZUSB
AF 4 PICOE—T D,

Media(B) to USB : XOw RBICHEA TN TL)
BDECFAT A P DITXTDI Y w T%ZUSB
AF 4 FICOE—T B,

Media(A)(B) to USB: ROw hA, BKRU RO
RBICEATNTWDERAT A 7DIN
TDOIZYUYITZUSBAT « PICOIE—T B,

Media Remain (ZE=ERE  BERT) USBAXT 4 PDEEREZRNT Do

AECO— RESNTWVWBD TSV IXITFT—
YDHRBZFRNI D (Execute TEIT) o

Properties Execute/Cancel

AECO—RSNTWVD TSV IAIFT—
S 5HET D (Execute TEIT) o

Clear Memory Execute/Cancel

Title1(ASCI/Title2(UTF-8) TSV IAXITF—=HTOU Y TREHRET

BDEEDRRENZEIRT B (64X—V),

Clip Name Disp

Operation >USB
SXSA—RRAOY MMTEASNIEEERA T « PAD T U w TZUSBAT « PI[COE—T & S EDHRIE
[CRT 28 EZLE T,

I5H REE RS

(UN—%FT)
Operation >Flash Band Reduce
Tovya)l RERERIELE I,
[TEE]
RIS LUSlow &QuickOnDEE, CHIRBIFER) (VL —FR) [CEDFT,
IE[S] REE PNES
Setting On/Off Flash Band&igitéeez=4> 479 %,

[TEE]

e Flash Band Reduce®# >/ # JHID#Z B3,
G PEEDERICE ED. —B/ A XHAD
FJ,

e Flash Band Reduce’ 7> CTH. v vF—XA v
FHF >V DBEIFEEELFEE Ao

o BRZEYDEFREFHERFFREICRDF T,

Select Folder USBXAT ¢« PRD T # )L —7%3E&IRT %o
USBXF ¢ PRICH LWI # )L —ZER T
2o

View Clip List USBXT ¢ PRDT )W T—E=ZFRRT Do
Rename Folder USBXT 4 PRD T # )L —R7ZRET Do
Error Check On/Off SXSAH—RAOY MTEASNICERERAT 4 7

RDT U wTZUSBAT A PANIE—TBHEE
[C. IS—F v IZTOIDNEDIHEERT D,
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78 AZa—FRREFHRE

Paint X _— 1 —

KEET Y54 U TERRINTVDHREEG. HERORETT . Paint SWhite
e BEEERELC. FETKRIA MSYIBEETVET,
SEMIRECTANMEE RS Y AT UET, 5E BRE(B NE
E= el Wz Color Temp <A> 1500K ~ 3200K ~ 50000K ~ XEU— AICRESNCRDA MGV ADE
Gamma on/oft NINRERS S /T T TDe Color Temp Bal 99 ~+0 ~+99 ?ifﬁz\iz;*m wOA MASY2DS
—_— e eaE N olor lemp balance  — ~TU~ — AlIR1FC CIN -
Black' Gamma On/Off 77|/773/Z&Emi&2‘//2‘7‘9”%>0 A> B RIA . BA VSR ERET B,
Matrix On/Off NhUIRBRES Y /A TG Do R Gain <A> 299 ~+0~+99 XEU— ACRES MR OA NSV ADR
Knee On/Off ——BeEA Y T T D, B A EERES D,
White Clip On/Off MOA NIV TiEEET > /A T3 Be B Gain <A> —99 ~+0~+99 AEU— AITRESNZRDA NSV ADB
[T53E] SANERBET Do
OfflCBELTH. BRERAEIIONCRDET. Color Temp <B> 1500K ~ 3200K ~ 50000K  XEU— BITRESNR DA NSV DS
Detalil On/Off T4 F— )RS A T T B, BEZERNT Do
Aperture On/Off FI—F v BB L+ T B, Color Temp Balance —99 ~+0~+99 XEU—=BICRTFENIZIRD A RISV RADY
Flare On/Off IUTRIEREEES Y 7 TT B, ;? 5 99 ~+0 ~+99 1;% (R;Tf;rfg: i;@? K‘E%%i?)%
— — N ain <p> - ~x0~ — BlICIRFS CTIN -
Test Saw On/Off TANESZA Y/ F 79 %o B A NERRES B
Paint >HDR Paint Setting B Gain <B> —99 ~+0~+99 XEU— BITRESNER DA NSV ADB
Shooting Modeh'HDRMD & & DHDRBEETNET S A NERBET Do
[TEE] Paint >Black
BUFEDHDR LICENSE (CBKZ-SLHL1) R ICDHRRINE T, TSw LN (DS TOEWLEZDIED LA #RELET,
EE LM Es TSwoIUNLERELT, 2EIHNED. BERDDEVSIRIEDHERETT,
HLG Look Natural/Live HDRE— RESDHLGREERRTET 5. I=[S] BEfE N
Natural : ITU-R BT.2100(HLG) [CHE#LL Tt Master Black —99 ~+0 ~+99 TRI—T 5w I UNIVERET Do
L|veH- Dlg%ibg 725 %C?ngﬁL;)%f% L. &0 R Black —99 ~+0~+99 RIS wILNILERED 2.
A < <
J— ,\_,i ,\_/+ = W /\“ gl’bl——! o
HDR Black Offset =95 ~+0~ +103 HDRE— RESDSDREE(Master Blackicigg o 0o P~E0~+9 BIZvo LI ERET S
DHHDRDBlackdDA Tty MEZERET Do Paint >Flare ) B
HDR Knee On/Off HDRE— RBSDHDRIESICH S %~ —HIE# JUT7REICAT OREZTNFT. \ _ )
I s U7 BELOBEZ VB DEEEZ|FTREDLAILLED ER>TUEL., BLEHHEES
HPEKT. LY AR TON ot .
HDR Knee Point —99 ~+0~ 499 HDR Kneeh*OndD & EICHDRES(ICHFD BT U/jf BCORDERA - DFE bfg
Z—IRA Y NERET B = RUE(E n&
HDRKnee Slope ~ —99 ~£0 ~ +99 HDR Kneeh'Ond & =(CHDRIESICHF 2 Setting On/Off JVTRIEREEES Y AT D,

——RO-TZHRET . Master Flare —99~+0~+99 NAYT—=TUFPRHELUNIVERTET .
R Flare —99~+0~+99 RTUVFZHIELNIVZRET o
G Flare —99 ~+0~+99 GIUTFZHIEELNIVZERET B
B Flare —99~4+0~+499 BOUZHIELNIVERET Do
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78 AZa—RREFHMERE

PaintX=a—

Paint >Gamma(HDR)

HDRDA YV VR EBEZERRLE I

Paint >Gamma
BURAEICATDEREZITVEI,
ADURBEICKD, BEOIY FSAMZHREELUT. MEDOHRZAETELEZ DI ENTEFT,

[CER]
FIFEDHDR LICENSE (CBKZ-SLHL1) EARFICDHRRINET o
IEH REE NS
Gamma Select HLG(Natural) HDRD AV Y EREME (RRDH+)
HLG(Live)

Paint >Gamma

HYRMIEICETDREZTVERT,

AVRBWECKID, BEEOIY hSRAMZRABLUC. BEDHRZRELEZ DI ENTEFT,
1BH RIEME NS
Setting On/Off HURTEIERREZA Y /T TT B,
Step Gamma 0.35~0.45~0.90 HUNRIEBZ0.05 AT W T THRET o
(00527 w7)
Master Gamma —99~+0~+99 NARAT—=HIRUNIZEHRET Do
R Gamma —99~+0~+99 RAVRUNIVZRET %o
G Gamma —99~+0~+99 GHYRUNIVZERET %o
B Gamma —99 ~+0~+99 BHYNUNIVZRET Do
Gamma Category ~ STD/HG/User HYXAT IV —ZRRT D,

STD : EFAIESHOBEDH YN H—T

HG : 74 ILATIRE UTe K DSBS R B EIR
(SR feHY<H—T

User : 2——h'CvpFileEditorTM V4.2 TE
BUfeHY~h—T

IE[S EE AR
Gamma Select Gamma CategoryDERICK HAUNHIEICERTEHYNT—TILZERT
bZD2 (REIRSER) %o

Gamma Categoryh'STDDHE
STD1 DVW : DVWALAOD—5—1E4
STD2 x4.5 1 X455 4>
STD3x3.5: X35514>
STD4 240M : SMPTE-240M#84
STD5 R709 : ITU-R709/8%
STD6 x5.0 1 X504~

Gamma Category*HGD5E
HG1 3250G36 : 325%DE T4 AF7Z100%DET A HAICERET D
HG2 4600G30 : 460%DE T4 A2 100%DET A HAICERET D
HG3 3259G40 : 325%DEFZ AN7Z109%DE T HHICERT D
HG4 4609G33 : 460%DE T A AS7Z 109%DE T Z HAICEHET

Gamma Categoryh'User®Diz&
User 1 : Userl [CERRESNIAVYYT—TIb
User 2 : User2[C&FENc A~ T—2)
User 3 : User3[CERFSNIcH <Y 77—
User 4 : User4(CBFESNIcH N T—TI
User 5 : UserS[CEFEINEAY~NT—)

Paint >Black Gamma
TSV IR URFIEICETDREZITVNET,
TSV IHIURBIEICKID. BEDRFZFEICEV (BBV) BoOBEHEPESVNBIRT D ED
TEFI,

2

IE[S] REE PNES
Setting On/Off TSVIRINEEREZST > /A TF Do

[TFE]
TSv oAV IEREZEERICT BIT(ESaturation
ModeZzLow KeylZERELTLEE L,

TS v I AURBEOEWEEZERT D,
Low :0~3.6%

LMid : 0~72%

HMid : 0~ 144 %

Range Low/L.Mid/H.Mid
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Paint >Black Gamma
oV I RYRBIEICEATHREETVET,
TV IRYRBIEICKLD., BIEDEFEFEISEV (BBL) BoDEAPESVLNBIRT &N
TEFT,

Paint >Detail(HD)/Detail(SD)
HDE— REFEEFSDE— RIEDT « T—)UiAZE(ICRE T D5 EZTLE T,
T+ TV, HEARDE®mBEDCT « T—IVESZMA Tzl Zz@A L. o U P IFBMRZ{ER
I DIECTCT,

IEH RIEME W& I5H RIEME &
Master Black —99 ~+0~+99 NAI—=TSvIAIRUNIVEZRET Do Setting On/Off T TV TS T T T Do

Gamma

Level —99 ~£0~+99 74 F—ULNIVERET B
Paint >Knee H/V Ratio —99 ~+0~+99 HF 4 F—ILLAILEVT « F—ILLARILD
——R®IEICET PREETVET. SYORERET B
——HLEld, HEH%UDEHZ)D%Bﬁ:?’i%ﬁﬁin‘fdﬁ@j%)ﬁ%{%@ﬁ/ﬁ‘i‘y7[/)“)0)J:EE[CIL\U"CE%EL;\ Crispening —99 ~+0 ~+99 SURT= IRV EBRET D,
- W 5 —_ \ == » —_ e ~ —_ |- =)
g, VAPSESLAVEI=TRA Y R, =—IcSORRORE  “ovelDepend _ On/Off UNILF A R RBRISEEE A~ /4 T B,
— — — : — Level Depend Level —99 ~£0 ~+99 LAJLT 4 Ry RUNLVEBRES Do
= BX.
- — = N Frequency —99~+0~+99 HF « T—ILESOHDERKZSRET D (B
— AN}
setting O0/Off__ 0 S ; N BAELTBIFET « F— V5B
Point 75% ~ 23% ~ 109% DCORBEDI IDES, =AY PERET  Tnee Aperture__ On/Off ——7)—F r—WEREET > 4795,
Slope 99 ~+0~+99 DEC%&%‘Q“D“Z‘?@&*\' 2 O—JrmEd Knee Aperture Level —99~£0~+99 =7 I=F v —UNIVERET Do
~zY gl . —— — i
2. Limit —99~£0~+99 B8, BETAEDT +T—ILUS v 5—%=R
Knee Saturation On/Off ——UFalL—Ya VRS Y T T B — /E_gkét’_\ — -
- White Limit —99~+0~+99 BAADT 4 T—ILU=Z w5 —ZERET D,
LR o Black Limit —99 ~+0 ~+99 RADT ATV v I—ERET B
Z—OFal—ya UHEBEERMICTDICIE — N — .
Saturation ModeZKneelZBZE LT LIRS, V Black Limit —99 ~+0~+99 %{EJJU)VT%T-JbU:‘y@-%EﬁE@'éo
Knee Saturation — 99 ~+(0 ~+99 —HF -3V NEDET S, V Detail Creation NAM/Y/G/G+R VT4 T—IVESZERM T DIcHDY —RES
Level ZERT o
: N NAM : RIESD SIESNVT 1 F—ILESE
Paint >White Clip - GIESH BIESNEVT « T—ILESEBIE
ROA o Uy TR DREETVET, ‘ SHSIESNIVT 1 F—ILESDS> 55
R4 hoUw T, EFFHAESORALANVICHRENTIBNETT, EFFHAESORA HURILOBES
B%Z [IRDA b Uy TNV EFUFT, Y:VYES
IEE REME NE G:GlES )
Setting On/Off ROA RO Uy TRERERS Y 4 TT B G+R: GIESCRESZ1 | 1TEMLITES
Level 90.0% ~ 109.0% ROA Uy TN EREST B, Cross Color —99~+0~+99 T4 T=ILOIZARAS—MEUNIVZERET
HEROREGY AT LR HREF. YT L5994, 29.97. suppress 2.
DRECKDEDD ([WNEIE 24, 23.98DEF(2108.0%. 50.25D& FlE (SDE—RE)

Z27) 105.0%

[CFRE]

T4 T —)VAEEEEOfDZE®. XZ1—0D
Operation >Format >Frequencyh'50 fcld 25D
B, COREFENTT,
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Paint >Aperture
T I\—F v —IEICEAT HREZTVE T,
PIN—=Fv—/@ElF. ETAESIC. BRRMOT )\ —F +v—E5ZNA CERBFEICK D%z
HEL. BREZSHHNETT,

IEH RIEME W&
Setting On/Off 7 IN—F v —IlIERRE A > F T Do

Paint >Matrix
N MU AMIEICET DREZTVED,
N MUOZAMIEICKD. BEDBL., BHPOPHTZREITDCENTEFT,
[TUEY bR MIJIRIEULTHOEN UDARSNIINSA—5—t v hpHENICEDY KU T
AZEIRCEF T, FEED TN A—FI—ZHFRICERELC AT NI IR ZERT D
EBTEXY, [P TT 4 INRMIIRIER NI T RADMEESZNIFT D8EEECT T,

188 RIEE NS

Level —99 ~+0 ~+99 T —F v—UNIVEBRED B
. - - Preset Select 1 SMPTE240M JUty MY MU T RZERY &,
Paint >Skin Detail ) o 2 :1TU-709 1 : SMPTE240M : SMPTE-240MAB24
AFYT A T —)VHIECHT SREZ(TNE T, ‘ o 3 : SMPTE Wide 2 1 ITU-709 : ITU-709484
AF VT 4 T—)VHEEF. APDIZENWVICEEDHEEDEN T HEDEDEFEZERATT 1 T— 4 NTSC 3 1 SMPTE Wide : SMPTE WIDEAE24
IWINVZZIERS B HIIETY, 5 EBU 40 NTSC @ NTSCAEY
B8 BEME ] 6 PAL 5: EBU : EBUAE
Setting On/Off 2FVT 4 T—)VBIEREEE S /7 7T B 6 PAL - PALAE=
Area Detection Execute/Cancel AF VT ATV HEDNRELDEBERET User Matrix On/Off A=Y=~ bUTABIEHEZT > /4 TT
DERPBEENERE NS (Execute THRIT) 2o
Area Indication On/Off 2F VT4 ToVBEDRRE BHEOTIIF  Level —99~£0~+99 RESBDBORS (Saturation) ZHEY 2.
[CEISHERTRT DR /4 T B, Phase —99 ~+0 ~+99 BigLBDE AL (Phase) ZRET .
Level —99 ~+0 ~+99 2F VT4 T—ILUNVERET Do User Matrix R-G ~ —99~£0~+99 R-GDI—H—< NI REEBICHET Do
Saturation —99 ~+0~+99 AFUT 4T —)VHIEDNR EFDEDEIFE User Matrix R-B —99 ~+0~+99 R-BOA—T—< MU IR ZARICERET Do
TFab—r32) @HET 2. User Matrix G-R  —99~£0~+99 G-RDI——T MU U REEBICRET 5o
Hue 0~ 359 AFYTA T VRIEDNR S BOEM User Matrix G-B  —99~£0~+99 G-BD1—U—% b AEEBICRET 2.
. (B2 ZHETS, . User Matrix BR =99 ~£0~+99 BROI—T—< SR EERICEET 5,
Width 0~40~90 AF 7 AT VREDHRCBOBOEMED oo Vatrix 86 —99 ~£0 ~+99 B-GDI—T—< M J A EERICHET 2.

HHZRET Do

Paint >Matrix

N hU O ZAIEICRET SR EZITVE T,
NhUIRFEICKD. BEDEK. BEPHSZREISENTEXT,

Paint >Multi Matrix
RIVFX MU O RFIEICRET DREZITVET,

RIVFY MU IFHIEF. 168DEM (Hue) Z2R-TEIFIE (Saturation) Z38EULF I,

[TUty hRY RS ELTHED UHRESN/(SA—5—ty O SBERICAST RS 58 BRE(E N&

AZRIRCEF T, FEBDTINIA—F—ZFRICERELC[I—TF—X NI IR ZEHT D Setting On/Off NIVFY MU O AGIEBEZA >/ F T D,

EBTEXT, [7ITT 4 INMIUIR]FY MU I ADMEERGZINGEIT HHEET T, Area Indication On/Off TILFT N RIEDOHS EHEDEDT YT
IHH REB S (LTSRS DEBEES Y FTT D,
Setting On/Off N hUORIERREZES Y 4TI B Color Detection Execute/Cancel NILFY MU ZBEDNREEDBERET
Adaptive Matrix ~ On/Off FETF4 IR NI AR REES Y /T TT SERHBENETENS (Execute THT).

Do Reset Execute/Cancel Z#hD[Hue] & [Saturation]Z 9 N CHIHAMEIC
Preset Matrix On/Off TUty N NUSRBEEEAY /T T B, 9% (Execute THAT).
Axis B/B+/MG—/MG/MG+/R/R+/ XILFX MU T ABEDNRETEDE (168

YL=/YYLH/G—/G/GH/CY/  E—R) ZERET Do

CY+/B—
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Paint >Multi Matrix
RIVFY MU O RHIEICETHREEITVNET,
NIVFY MU ZAFIEE. 16EDEE (Hue) ZZRTEIFIE (Saturation) ZEREULF T .

Paint >Saturation Mode
YFaL—Y 3 VEEICETHREEITVED,

155 REE NE

IEH RIEME &
Hue —99~+0~+99 NILFNY MU ABEDRREEDEDEE

(Ea—)Z16MTE— FCEICRET Do

Saturation Mode Knee/Low Key SFal—y 3L NILiiEWE TS
(Knee) TBINEDMMEVE D (Low Key) T
B EBDZERT B,

Saturation —99 ~+0~+99 TILFT MU I RBEDTR EISDEDEIHE
(UFal—r3V) Z168IE— RS EITHRE

ERN

Paint >V Modulation
VEYValL—y3arvyz—T« VIRIEICETSHREZTVED.
LY XETUXLDBEFRTCTRET HEBEAQDREDEEZHELF I,

Knee Saturation On/Off Z—YFal—vaveEEd Y FTIT D,
Black Gamma On/Off ToOVIORVREIERE=REA Y /T 7T D,
Low Key Saturation  On/Off O—F—YFalb—y3Vikeerd> /7779

Bo

158 REME NE
Setting On/Off VEYVaU—Y3vyz—F 4V TmIEwREZ

T2/ TS B

Paint >Noise Suppression
S ARYTUR (/A XEHE) #EEICEIT B8 EZITLE T,
WEEDHNEL Y YWD ZZRLDD. /A RS ZNRNICHF T D ENTEFRT,

I5H RIEE NS
Setting On/Off S ARG TUREEEZES > /AT Bo

Level Low/Mid/High /A XY TUADUNIZEEIRY %,

Master V —99 ~£0~+99 SRAY—NVEI 2=V 3V INIVEREYS Do
Modulation

RV Modulation —99~+0~+99 RESDVEY 1 L— 3V IUNIVZERTET Do
GV Modulation —99~+0~+99 GESDVEY 21— 3V INIVERET D,
BV Modulation —99~+0~+99 BESODVEY 1L —a v INIVERTET Do

Paint >Low Key Saturation
O—+—Fa2U—Y 3 VHEIEICETOREZITVFRT .
IREDBEVEBD DBODIRS IE[JZMIECEFR I,

158 REE NE

Setting On/Off O—F—YFal— 3 VRiEskierS > /7
AR
[CFE]

O—F—TFab— 3 VEREEZBRMCTBICE
Saturation ModeZzLow KeylCERELTLEE L,

Level —99~+0~+99 EEETY7DB0REE (UFalb—r3Y)
ZRTET Do
Range Low/L.Mid/H.Mid O—F—YFal—Yav@EEENCTDE

EBUNIVEERT %,
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MaintenanceX—1—

KFEF VI =S4 VTRRSNTVDREEIS. BEFORECTT,

Maintenance >White Shading

MIA by T—F ¢ VIHIEICET HREZTVE T,
MNIA Y T—=F 4 VIEU Y XDFEIC KD FEET DHDVEDDIEBELASPELAS T, LYXT

EITHRIEDMNETT,

Maintenance >Battery
Ny T U—[CRATHREZITVE I,

158 RIEE

PE

I5H RIEME NE
Near End:Info 5%/10%/15%..95%/100% JXw 7 U —)Cy IBP-FLX75/GL65A/GLI5AfE

Battery

FABS(C [Battery Near End] Z#&R"g 2 LEW
BZRET Do

Channel Select Red/Green/Blue

ROA MY T =T 1V IHEDORRZEIRY
Bo

End:Info Battery 0%/1%/2%/3%/4%/5%

IR T 1J—) 0y IBP-FLX75/GL65A/GLISAfE
FABSIC TBattery End] ZFKRd & LELVMEZER
T Do

White H Saw —99 ~+0~+99 KEBBEDSAWIRD A b T —F « VIHIEB
ZERTET Do

White H Para —99 ~+0~+99 KFERBDINTIRIMIA b T—F VI
EfEB7ZERET D,

White V Saw —99 ~+0~+99 FEEABDSAWRT A b T—F « VIRIEBE
EERTET Do

White V Para —99~+0~+99 FEEABD/INSMINITA b T —F 1 VI
EEZHRTET Do

White Saw/ Para On/Off MROA b T—F 1 VITDSAW ISR

IEtkpemA > " F T3 B

Maintenance >Black Shading

IJSvIYT—F 4« VIHEICEHT OREZTVE T,

Near End:Sony 11.5V ~ 17V JCw 1 —) 0y ZBP-L60S/L80SEEFERFIC
Battery (0. IVAFTw ) [Battery Near End] Z%FR 9 & UELMEZER
/’_‘Eg—éo
End:Sony Battery 11.0V~ 125V JXw U —) Uy I BP-L60S/L.80S{EFaRF(C
(0. IVAFTw ) [Battery End] Z&RR9 & LEWMEZRET do
Near End:Other 115V~ 11.8V~17.0V VRSO Ny T U —) I ERRIC
Battery 0IWVZTv) [Battery Near End] Z5&~d 2 LEWEZER
9D
End:Other Battery ~ 11.0V ~ 14.0V VRSO T U—)Cy T ERRFIC
0 IWRFTw) [Battery End] Z&Rmd & UELMEZRET Do

I6H RETE

&

Channel Select Red/Green/Blue

TSv IV T—7« VIHEDNRZERT
Bo

Detected Battery Sony Info Battery/
Sony Battery/Other Battery/

DCIN

Ny FU—D@EZ BB UfciERZRTR
éo

Maintenance >DC Voltage Alarm
HNBOCEREEICEAT D7 S—LZRELFR T,

IE[S| RIEE NS
DC Low Voltage1 11.5V~ 17V DC INlmFICHEBERZ#Z R L CWL IS
(0. IVAFTw ) [Battery Near End] Z%FR~d % LELMEZER
EI D
DC Low Voltage2 11.0V ~ 14.0V DC INimFICHEEBIR =R U CWLDIBAIC
0IWVRFTw ) [Battery End] Z&R"d & UELVBZRET

Zal

Maintenance >Audio
F—T 4 FICETDHREZTVE T,

188 RIEE

W&

Black H Saw —99 ~+(0~+99 KEBBDSAWI SISy 1—F 4 VTJHIERE
EERTT Do
Black H Para —99 ~+0~+99 KEBBDINSRTITSVIITI—FT 1V
FEZERET D,
Black V Saw —99 ~+0~+99 |EEHBDOSAW ISV IS 1 —F 4 VIEIEE
EERTET Do
Black V Para —99 ~+(0 ~+99 EEAOD/ISRT TS VIV I—FT 40
FEZRET Do
Black Saw/Para On/Off TS50y 1—F 4V IDSAW ISR
IEHgEE > T T9 Do
Master Black —99 ~+(0~+99 NRAT—DT v I UNVZRTET Do
Master Gain (TMP)  —3dB/0dB/3dB/6dB/9dB/ —BNICNY R =T AV DEZRTET Do
12dB/18dB/24dB/30dB/
36dB/42dB

Front MIC Select Mono/Stereo JOY hAo%7E./ S (Mono) ICTDhH\
AT U7 (Stereo) (CTDHERIRY 2.
Rear XLR Auto On/Off #EOAUDIO IN CH-1/CH-2imFICo —TILHd

BHRSNTVDNESHZEFNICHRHT D5
=T/ ZTF B
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Maintenance >Audio

T—T 1 A CEAITDREZETVERT,

Maintenance >Audio

=T 14 (CEITDREZTVET,

156 REE S 1B BEE NE
Front MIC CH1 Ref ~ —70dB/—60dB/—50dB/ 70V MRATDF v RIVTOEEASHUAN CH1 Wind Filter On/Off Fr ORIV OREER T« IEF—Z4> /7
—40dB/—30dB IWZEEIRT %, PEKH
Front MIC CH2 Ref ~ —70dB/—60dB/—50dB/ 70V bRATDF v R)L20OBEAD AN CH2 Wind Filter On/Off FRIV2OREBER T «IVF—ZA T
—40dB/—30dB W7ZERT D, PEKH
Rear MIC CH1 Ref —70dB/—60dB/—50dB/ AUDIO IN CH1 R w FDEEEHMICDIZED CH2 Wind Filter On/Off FvURIVIORERR T A IV —ZA> /T
—40dB/—30dB BEADUNIVZERT 5. DA
Rear MIC CH2 Ref ~ —70dB/—60dB/—50dB/  AUDIO IN CH2AA v FOBRENMICOEAD  CH4Wind Filter  On/Off F v Y RIVADRBER D « L —EFY /7
—40dB/—30dB BEADUANIVZERT . 73 %,
Line Input Ref +4dB/0dB/—3dB/EBUL AUDIO IN CH1/CH2 XA v FDERENLINED TkHz Tone on Color  On/Off/Auto NT—I\—F—RBCTkHzDT X MESZH
SEDEEANUNIVZEERT 5, Bars 77950 (On) HA LWL (Off) ZRRET 5.
Min Alarm Volume  Off/Set ALARMDEHER D & Sfc & EDEBEER Auto : AUDIO SELECT CH1 R A » FDRED!
55, AUTODIBEDH T 2 MESEHITT 2.
Off L IFIFE T A TFL) MIC CH1 Level Side1/Front/Front+Side 70V MRATDANER=ZET v R)V1ICE
Set : HBDEEFEZA D IRIBDBAIC. EDODFRHCTERE UL ZRBE
Speaker Attenuate  Off/3dB/6dB/9dB/12dB EZH-AE—H—HDEDEBERRT D (f IHNEERT Do
TR DEBICEEE L), Sidel : Y+ RJCRJLDLEVELDFEH (k)
Headphone Out Mono/Stereo AVIR>7ZE/S)U (Mono) ICF2h. AT Front. '7|:|y. ™ LOMICLEVEL=3ds
7 (Stereo) |29 BDEEIRG 5. Front+S|de1\ " LEVELDZ&E & (&) &MIC LEVEL
. — — DEHEEHED
Reference Level  —20dB/—18dB/~16d8/  BEANLALERETS, GOET. TkHz  “yicep ol Side/FronyFrontiSide2 IO FRA JOANEREF v 720K

—12dB/EBUL

TAMSEDENUNIVZERET o

Reference Qut

+4dB/0dB/—3dB/EBUL

BEANUANIVSH T DHAOUNIVZRET
éo

RIDHEIC. EDODIRHTERLUNIVZRE

THNEEIRT Do

Side2 : U RJXRJLDLEVELDER 3+ ()

Front : 70~ bJXRJLOMIC LEVELDFEH

Front+Side2 : LEVELD&Rd (F) &EMIC LEVEL
DFEHZEHSED

Rear1/WRR Level

Side1/Front/Front+SideT

DAYVUVANA U7 )RIJLOAUDIO IN

CH-limFICER U2 EODXRHF CTER

LNIVZZFRENT V7 EIRT Do

Sidel : ¥+ RJXRJLDLEVELDEH ()

Front : 70~ bJXRJLOMIC LEVELDFEH

Front+Sidel @ LEVELD& & (£) &EMIC LEVEL
DERHEEESED

CH1&2 AGC Mode  Mono/Stereo FroRIV. 2ICEHJTD/FOATA—T 14
EEDODANUNIVOEEREE. EF v =X)L
THIZULTITSD (Mono). AT UAE—RT
15 (Stereo) Z&EIRY Do

CH3&4 AGC Mode  Mono/Stereo Fy 2RIV 4ICEFRITD 7 FTOTA—T 1«74
BESDANDUNIVOBEREREZ. &F v=x)b
THIZUTITSD (Mono). AT UAE—RT
75D (Stereo) Z#EIRY Do

AGC Spec —6dB/—9dB/—12dB/ AGCORF4E (BEFILANIL) Z8IRT D,

—15dB/—17dB
Limiter Mode Off/—6dB/—9dB/—12dB/ =T A FAAUN)VDF B, KEFEA

—15dB/—17dB

NESICHIT DU v I @@L ANI) Z
BEIRT D, UIvy—ZERAULEVEEIFOff
ZEIRT Do

Output  Limiter

On/Off

FT—TAXENI=Z VI =AY/ FTT B
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Maintenance >Audio
F—T 4 FICEATBHEREZTVEI,

Maintenance >WRR Setting
DAY URAF 21— —ICBT OREZITVE T,

S| REE ANES 158 REE NES
Rear2/WRR Level Side2/Front/Front+Side2 DA VLVARYA D EUT)IRILDAUDIO IN TX Input Level -—-/Mic/Line WRR CH Select CEIRUfcF v+ VRILTRIEL

CH-2ImF (TR UTcas = EDDEHF CER

LNIVZRES D72 #EIRT 2.

Side2 : U+ RJXRILDLEVELDZF ()

Front : 70~ bJXRJLDOMICLEVELDE d#

Front+Side2 : LEVELD&d () &MIC LEVEL
DEHZEHTED

TVDEEHDATILANILHIN A T (Mic) &5
42 (Line) DEBSICRESNTLDHZER
™I Do

Audio CH3 Level Side3/Front/Front+Side3

F v RIVBICEFRSNDERLANILZEDD

FHCTHETT DNEERT Do

Side3 : ¥ FJXRJLDLEVELDEH

Front : 70~ bJXRJLDOMIC LEVELDEH

Front+Side3 : LEVELDEH#EMIC LEVELDZ
HEEENTE D

TXATT Level -

WRR CH Select T:ERUZF + 2 RILTRIEL
TWVDEEHDATTUNIVZRE T & (FREED
OZ#HHE . 2EUTCVDXERICE O TELE
DHBEDDD).

TXLCF Frequency — —

WRR CH Select CEIRUTcF v+ RILTREL
TV E#OO—AY N 1 LY —Bik#7=
BRET D GREBODAZEHHG. ZIELTWVD
RIERICK O TELDHEEDDD) .

Audio CH4 Level Side4/Front/Front+Side4

F v RIVAICEERSNDERLANILZEDD

FHCHETT DNEERT Do

Side4 : ¥ FJ{RJLDLEVELDEH

Front : 70~ bJXRJLDOMIC LEVELDEH

Front+Side4 : LEVELD&EdH+EMIC LEVELDE
HEEHEIED

Maintenance >WRR Setting
DAY URF 21— —I[CAT OREZITVE T,

TX System Delay Auto/0.0ms ~ 8.0ms

BEDEEEZHRTET Do

Auto : DA VL AL Y—/){\—h6xE5NTL
DEEDELEEN0ICED LD ICEENIC
EIESZHIET Do

0.0ms ~80ms : F—FT A A=FY—LEZN
UCTEHDITAVLUAV AT LAZFRLT
WBBHEIC., FRSNSDAVLURAYV AT
LODEEEZHRTEY o

I6H REE

&

WRR Valid CH Sel All/CH1

DAVUALY—I\—DF vV, 2&0F
MTTBN (AN Fr RV DHFZEERNCT
2 (CHY) ZERT Do

TX RF Power High (Powerf&) mW/Mid

(Powerf&) mW/Low (Power

WRR CH Select CEIRENF v RILTEBIE
U TV EERDRF Power Level Z88E I 2D

WRR CH Select TX1/TX2

WEZAZ1—[CRTI DRETF v/ RIVEE
T

X1 : Fv 2RIV DRBEZERRT Do

TX2 ! FvURIV2ORBZERTI Do

B) mW GREBOIZHHEIF. ZELTVDIEEKIC
SO CELFDHENHD),
TX Power Save Active/Sleep WRR CH Select CEIRENTe T v+ VRV TS

UCW R EHDN\D—t—JE— RZEHRET
o

Active | EXEHZEEE— NICT D,

Sleep : EEHRZE/NT—tE—TJE—RICT D,

WRR Delay Comp ~ On/Off

DA VU AN EEOELHEREEZERICT
21 (On) #EMICTDH (Off) Z:ERT S (On
EERT DTN CDE-EHNDEFDLHI8MS
EET D).

TX-Cam Power Sync  Off/On

EEDND——TREZAEDPOWERZ
A vFEABMUTYIDER DN E DD ZRET
éo

TX

WRR CH Select TERUTeF + RILTRIEL
TVDXEHDRIZERRT Do

TX Audio Peak ---/Peak

WRR CH Select TERUTeF + VRILTRIEL
TWBEEEDAFLANILAE—D 4 —)(—hH
EDDERTT Do
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Maintenance >Time Code
YA LO—RICEATIREZITVET,

Maintenance >Camera Config
ALAT—F—DEEEEICRAT OREZITVE T,

LS| EE NE 1B BEE NE
TC Out Auto/Generator YA LO— RHAZEEIRT D, HD SDI Remote I/F  Off/Characters/ AEEDSDI OUT 1/2ikF (HD SDIHA) (CHHG
Auto : EEERBFF S A LAO—RY T RU—5— Green Tally/Red Tally SN EBREER (O T S EC iRl E R e 7z (E
DEZHAL. BEKEYA LO—RU— BTN EDINRET 5. EHATDHES. HE8
F—DE=ZEIT S KD ECERINAE T DD T EDRIAEEERY
Generator : oy, BEREBHYAALO—F %o
VIRL—Y—DfEZLEFIT D Off : ECERBNMERIEMEAEZER LU,
DF/NDF DF/NDF ROw I IL—LE—R (OF) &g/ R Chara - E2—77 125 —BIE LORERR
Ov 7 7L—LE— R (NDF) Z&RY 5. DOABREHHR R CRRI Do
LTC UBIT Fix/Time TCOI—F—F v NIRRT 57— 5 ERE GTally-E2 =771 5 —HDTALLY (FU—

ERSH
Fix : A——HRE L T—5 28R T
Time | IREDKZZ5CERT D

VHU—) SYTTERY Do
RTally : £2—7 745 —ROREC (257 -
Ly REU—) S TTRIRE B

Counter Display Counter/Duration

Ea1—J7A4 V5 —ICRRSNDAHD V5T —E
DUty bOFEZERYT D,

Counter : RESETNS > Z T X TRREIN D,
Duration : EeifFtAC & ICU Y SN2,

Color Bars Select ARIB/100%/75%/SMPTE

HNS5—I\—DEREERT Do

User Menu Only On/Off

AXZa—ZRRUCETIC, UserXZa—FF
HERRITDD (On). A_a1—URNERRT
5h (Off) ZFEIRT %,

Maintenance >Essence Mark
Ty VAN—7ICETREZTVED,

158 REE ANES
Find Mode Clip/Rec Start NEXT/PREVIRS > 7280 U T & EDEMEZRE

RN

Rec Start : XFEFTDRIDL W I AT — K
N—7CH%ET D,

Clip i NEXTIRZ V=T & XD U TD

FEENEET D, PREVIRYVZHT &, IR

FEOOU Y TDFEICEETD (FU YT
(DFFECTPREVIRY V7249 & 1 DRID Y
U w JDFEREICEENT D).

User Menu with On/Off

Lock

AZa—FRICOvIZNFT. UserXZa—

RIFDORRICT DD EIHERIRY D,

On : ARDEFIIESZASIL. XZa1—FR
[COvIZRFD. (UserXZa—71EIFm
RRICEDET,)

Off : OnLfe&EEICANDLIHERDIEIIES =
ANUL. OV I ZRIRT D, (FRIRT D&
BEDOAZ1—UX MRRICTDEDHDF
9.)

[CEFR]

BEOAZ1—KRTRFECIEF. KRENTEA.
XZa—RREETAE 102R—VZCBLES
Lo

RM Common On/Off

Memory

UE—hIY ~O—-ILAZy MERIFEO—
IVRER CREZHE T DD (On) HELEWL
h (Off) Z&EIRT Do

RM Rec Start RM/Camera/PARA

UE—rIY bO—)LIZ Y MEREICEBS
DECERERIR,BIERY V ZBNCT DN ERTE
RN

RM : UE—hI> bO—LOZ Y b

Camera : ALO—5—

PARA : 5
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Maintenance >Camera Config
ALT—F—DEEEEICRET OREZITTLE T,

Maintenance >White Filter
T4V —(CBTDREZITLET .

BE BT WA EE TS =
SET Key on Pause/Play 1 DD LAZRA)7aEIR UTCIREETMENUDE ND FLT 3200K/4300K/5600K/6300K EBRMCCT 14 )LF—=NDT 1 )LF—(CEIDH
Thumbnail PR UTc & EDOEEZEIRT 20 CTemp<2-4> CRETDEREEZERTS (T4 I)LF—2~
ALAC Auto/Off ALAC (f5E@INAERIE) ZBEMICEITI BD 4.

EDNERET Do

Auto  ALACICHIG L TWS L XHED (7
51, ALACOERITE>TLa &, BE
BICALACZERITI B

Off 1 ETULIELY,

[CFR]

INFERIESL Y XICK o TlE. AIEEDAutolIER

ESNTVTHBRERABERICINEMIEREENEEL

BV (Ea—T 745 —BEELEICTALAC] ERRE

NEV) TEDHDET . CDRIBEERF. LUK

DA—=LVUYTETH—HAAU Y TN D fcAIRE T

FBHULT. Ea—T 75 —@ELIC[ALACI DX

T2 CEZHER LT SERALTIEE L,

¢ EBERBLYXIIDVTIE. VI—DY—&
ABHERCFEFRBAECBHLEDELEE

Electrical CC<A>

3200K/4300K/5600K/6300K

BRMICC T« ILI—DYID IR AR 7T A
FINAA v FICEDETDEEDERERE
R B,

Electrical CC<B>

3200K/4300K/5600K/6300K

BIHCCT 1 LY —DYIDIRZ a7z 7 A
FINWARAvFICEIDE TR EEDEREZE
RTD

Electrical CC<C>

3200K/4300K/5600K/6300K/

BIHCCT 1)L —DYIDIRZ Rz 7 A
FIWAAVFICEIDHTCDEEDBEETE
RIT B, CZEEDFEVNEEF-—ZEIRT Do

Electrical CC<D>

3200K/4300K/5600K/6300K/

BRWICCT 1 )L —DY)D IR HEREZ 77T A
FINWRA wFICEIDEHTH EEDEIREEE
I, DEFEDIFNEE(F-—T2ERT Do

Maintenance >DCC Adjust
DCC(HAFZv oY bSR MOV bO—I) [CETHREZETVE T

L IBE SREME RE
Maintenance >Preset White DCC Function DCC/Fix OUTPUT/DCCAR A1 wF7ZCAM. DCC : ONIC

MRIA NSV ADTU Y MEICB T HREZITLE T,

Select

UTeEEDZ—RA Y bOREEZFIRT

éo

DCC: Z—RA Y bR BHDEBECEDLET
EEEEE=E )

Fix : Z— A2 hMzEEBICT D

15H REE NS

Color Temp <P> 1500K ~ 3200K ~ 50000K  ROA bNSVRDTUY MEZERET Do
Color Temp —99~+0~499 Color Temp <P>THEDREHE SNED D
Balance<P> THBBIC. IHICHN <K BREZRTET .

R Gain <P> —99~+0~+99 RIAVDTUEY MEZESRET o

B Gain <P> —99~+0~+99 BIUADTUTY MEZERET Do

AWB Enable <P> On/Off WHITE BALAA v FHPRSTDEE. AWB (A —

bROA BINSUR) ZRTI deeEZ >/
F79%

Maintenance >White Filter
T4 )5 —(CEAT S HREZITVE T,

DCC D Range 400%/450%/500%/550%/ OUTPUT/DCCR- v F7Z2CAM. DCC : ONIC
600% UIc&EDIAFT IV IV VIZERET Do
DCC Point —99~£0~+99 DCCORN=—IRA Y hZERET Do
DCC Gain —99~£0~+99 DCCORBICH T U A VEZRET Do
DCC Delay Time —99~£0~+99 DCCORHAE—  (BIRDZEAEICH T DRIt
HE) ZRET Do
DCC Peak Filter —99~£0~+99 DCCOMBEDE—T ([T T DB RE =R

ERCD

158 REE ANES

ND Filter CTemp On/Off BIMNCCT A ILEF—ZND T 1 L5 —ICEIh
CRWREZA Y /T TS Do

ND FLT CTemp<1> 3200K/4300K/5600K/6300K BRHICCT 4 LY —ZENDT 4 LY —ICEIDH

THEEOEEEZFRI D (T (ILT—1H).
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Maintenance >Flicker Reduce
TUw A—IEREEICRT DR EZITVE T,

HAKTIEEEHRNICEENZ(L T DRAT CRERZIRT Ulc &, SR U—LAL— hEDBEFKT

FETDIU Y H—ZMECERT,

Maintenance >APR

BV /A XUF T 3 VHIEICET SREZITVE T,

158 EE NE

Mode Auto/On/Off TUy D—HIERBEDBEZRTE T Do
On : BICEMESE D,
Auto : TUwAH—ZBHT D EEET Do
Off - BIfESBEL

Frequency 60Hz/50Hz Uy H—DREREF > TWVDRADERRR

HIcEDED,

System FrequencyDsREN59.94. 29.97.
23.98DHZEDHEIREREIF60HZ

System FrequencyDERENS0, 25DHBEDH
B ERE (F 50Hz

Maintenance >Genlock
Jo0OvIICEATREZITVERT,

IBE SRTEE NS
Genlock On/Off SOy IOKEES Y /AT IT D,
Reference Internal/External(HD)/ KEDNMER U TV EEESOREEEZRNT

External(SD)/SDI IN/CA

Bo

Maintenance >Auto Shading

FT—hISVIII—FT 4 VIMEZERTLE I,

=S REME S

Reset Execute/Cancel APRBKRU TS w oINSV ADEEFAEDET
[CLDT. BMNEFRINcART—YZHRYT
% (Execute CTE179 %),

Maintenance >Basic Authentication

BasicEREEICRI T DR EZITVE T .

18H REE S

User Name RBEDI—T—RZZFR) FRODI—T—R7%ZHRET D (BasicERaA) .
HERF Fadmin(CERESNTLE T,

Password i BasicEReEICEAT ©/\AD— RERET D,

JNAT—RIEE. SXFULDEHFZZNZE
MIXFLUEERT 2,
AHUTIRD = REFFCRIRSNDON SHIFT
F—ZHUTCVDEFE, ANUIEXFEARRS
na.

[TEE]

FDT 7 — LD T 75 0FKEH 55,0082/ \—
VavPyIgRE. RD—RREFUEY b
FY. COBARIRT— REBRELTZEL,

I5H ERIEE

&

Maintenance >Network
Xy D —JEGICBIT OREERRZITVET,

Auto Black Shading  Execute/Cancel

F—bISVIII—FT AV IBEEETITD
(Execute TE1TT D),

Reset Black Shading Execute/Cancel

Jovoyv1—T4VIMEBZI U7 TD
(Execute TEITI D),

Master Gain (TMP)

36dB/42dB

—3dB/0dB/3dB/6dB/9dB/
12dB/18dB/24dB/30dB/

—FRNICNYRAY =54V DEZFRET B (GAIN
A v FOREEBERUIEICED),

Maintenance >APR

B )L/ A XUSF T 3 VHIEICET HREZITVE T,

I5H REE NS
APR Execute/Cancel BEIXMEHEE (BB o)L/ A XUSF 03

V) BEEERITU. SLSE— RIFORRZER
9D (Execute TEITI D)o

15H REE NS
Setting On/Off Xy ND—OWEEZES >/ H TS Do
Wi-Fi Mode Wi-Fi Access Point/ DAV LU ALANEGOEIEE— R ZRET D,
Wi-Fi Station/Off
NFC Execute/Cancel NFCIC Kk D8R ZRIA T © (Execute TR
79%),
WPS Execute/Cancel Wi-Fi Protected Setup (=WPS) ZBI89 %
(Execute TE1T9 %)
Channel Auto(5GHz)/Auto/CH1/CH2/ DA VL ALANDF v+ R)VERTET Do
CH3/CH4/CH5/CH6/CH7/ (o]
CH8/CHI/CHTO/CHTI Auto(5GHZz)I&. TERDTA VUALANEY 2—)b
[EKDOTF. BRSNBWVWEAENDDFT,
SSID & Password (SSIDFR) SSIDEJRRAT— RERRT Do
(Password==m)
SSID (SSIDZER) Wi-Fi Station Mode TD#E#EE 7 o EARA

PDSSIDZERTY Do
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Maintenance >Network
2w ND—UEFGICRETOREEERREITVET,

Maintenance >Network
Ry hD—JEGICET R EERRZITVED,

LS| EE NE =S HEE NES
Wi-Fi Station Detail ~ Scan Networks (Execute/ Bty M- BEMRLZRBT D Wi-Fi Station Detail ~ Primary DNS Server (DNS W= —DTSAU—DNSH—/\—ZAS]
Settings Cancel) (Execute TEITT B). Settings Auto/On @ BEIES DNS 9%, DNS AutoDOffD & E(CHRD,
SSID (P ZBRIKA > ~D Wi-Fi Station Mode CO##SET 7 B AR A > Auto/Off : 0.0.0.0)
SSID) bDSSIDZATIT %o Secondary DNS Server (DNS  JL—4—0DtH>4 1) — DNSH—/{\—%&AH]
ANITEDNFFUTDESD, Auto/On @ EE1EUS DNS T2

PILT 7Ry hRAXF  A~Z
PILT 7Ry M\XZF a~2z
HFE 0~9

505 L "HS%&H+ /<=>TNA I~

Auto/Off © 0.0.0.0)

DNS Autoh’Offd & E([CHM.

Device Name (Wi-Fi)

USBOA VLU RALANEY 2 —)LARKFICEERS
NCVdxRY FI—IHBEDRINERRT Do

Password (77 ZARA > ~
DINZAT—R)

Wi-Fi Station Mode TOD#E#5t 7 7 T AMRA >
rDIRRADT—RZEAST Do

AN U R D — RIFFCTRRENDD. SHIFT
F—ZHUTLDEIE. ASUEXEDTRRE
N,

AN TEDXZRFUTDEBD,

FILIT PRy hRANF  A~Z

FILT PRy M\XF ta~2z

HFE 0~9

05 L HS%R /5 <=> NN~

IP Address (Wi-Fi)

DA 7 L ALANE R DADIPT R RA7%ZR
ANCRSH

Subnet Mask (Wi-Fi)

DAV UALANEGRIROY TRy bR U 7%ZR
I Do

MAC Address (Wi-Fi)

A (CIBEEINTLIDUSB Wireless LAN
ModuleMACT R A%ZRRT Do

DHCP (On/Off)

Wi-Fi Station Mode TDDHCPZERTE T Do
OnlCgdE. BEMIICAREICIPY RUAZE|
DHETD, FETHEDIPY RUREANTD
B&lE. OfflCT 2.

Regenerate Execute/Cancel INAT— R 7ZBER T % (Execute THRITT

Password B)o

Modem On/Off 3G/AGET ALK DR Y MD—TUmOER
W ZERET Do

Wired LAN Enable/Disable EIRLANEBOBZH 2R TET Do

IP Address (DHCP/On :
HE)ESDHCP/Off :
192.168.1.50)

THEDIPY RURZATIT Do
DHCPHOffD EEICHM.

Wired LAN Remote

On/Off

LANT =D)L TRy ND—2#EHEUcEE(IT,
Wi-FiUE3J>. WebXZa—. [Content
Browser Mobilel 7 7U 4 —> 3 H 5 DR(E
EBMICLET,

Subnet Mask (DHCP/
On : EEHUSDHCP/Off :
255.255.255.0)

THEOY TRy BNRIZEANIIT B,
DHCPHOffDEEICHM.

Gateway (DHCP/On : EEjEY
1SDHCP/Off : 0.0.0.0)

PIORARA Y SDT— D TAZATIT Do
DHCPROffD & EICH M.

DNS Auto (On/Off)

DNSEEERSZRET D
OnlCgd & BEMICDONSY—/\—D7 KU
AZEUST Do
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Maintenance >Network Maintenance >Network Client Mode
2y RO —UEGICET ORELRRETVE T, XDCAM air®y Z—&% v RO —IRXRAT—¥ 3 VEEFH T DIeDDRY ND—0 IS5 A4 F >
BE sne e E—RICRETHREZITVE T,
Wired LAN Detail DHCP (On/Off) DHCPZERET 2. [TEE]
Settings OnlCeBE. BEMICAKICIPTY RLUZZE FRTOERICEPANTNENE, Ry ND—T 554 P NE— RERETCEE A
;g—c“i;%}%@wﬁ RLURZATT D5EE = =R e
< g e Setting On/Off RYNI—=OTSAT Y NE—REAY /FT
Officg %, 53
IP Address (DHCP/On : AHDIPT RUZAEATTT Be o
E81EY§ DHCP/Off : DHCPHYOffD & (S (2Rl
192.168.2.50) OnlCgde&. T7—LDT7ON—=I3 7 vIE
Subnet Mask (DHCP/ FEDT D%y NIAIEANT Be CEFth S
On : EEEYE DHCP/OFf : DHCPAOFDE EIZEH. Preset Select Preset 1/Preset 2/Preset3  Rw hND—0054 72 bE— ROBRREZ
255.255.255.0) DO UDHEELIETU LY RERE (Preset 1/
Gateway (DHCP/On © BHEL 72 EAMKA > RO — RO TAZAFT B, _ Preset 2/Preset 3) I SRS B
{8 DHCP/Off : 0.0.0.0) DHCPHIOFfD & 2 (T %D Preset 1 Uty hEORT) Uty hREATT S,
DNS Auto (On/Off) DNSHEIESEHRET . CCM Address B eCCMD Y RURAERET &
OnlcgdE. HEMICDNST—/\—0DF KL A RAFEEIPY FUA
AZHUSS B CCM Port (1 ~ 65535(8443)) #E#ECCMDIN— hESZREYS Do
Primary DNS Server (DNS W—5—DT5A<U—DNSH—/\—Z AN User Name BHSECCMORAIR1——RZH/RET D,
Auto/On - SIS DNS 92, ) L Password BESECCMMD) (R D — RERTET %o
Auto/Off 1 0.0.0.0) DNS Autoh'Offd & EICHER. AP LT ST — RIF*TERTENDD. SHIFT
Secondary DNS Server (DNS  JU—4—DtH>4J— DNSH—/{—%& A7 F—ZHUTVBEIF. ANDUEXEDRRS
Auto/On : EEEYS DNS ERSE N,
Auto/Off : 0.0.0.0) DNS Autoh*Offd £ & (CH3 NCM with Proxy (Enable/  Enable : CCMiEsBSD IO+ a2 E30IC
Disable) I
Disable : CCMEZzfBSD 7O+ seig =2 M
CESE
Camera Control (Enable/ CCMEBRIFDH A ST ~O—)UREDEFT
Disable) S REFRERTET Do
Camera Setting (Always/ CCMEEBFDALL T 7 A ) LIRIEDEF AL/ A5 E]
Onetime/Off) ZRTET Do

Always @ BICALLT 7 A JLDBRIEZFT A 3 &

Onetime : 1EIFEIFALLT 7 A )LODRIEZEFA]
ER)

Off 1 ALLT 7 A JLDREZEFAT L7gL)

Preset 2 Preset 1B U Preset 1EEU

Preset 3 Preset 1B U Preset 1EEU
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Maintenance >File Transfer
AHEEDSXSAEY —H— RDF—F DRy ND—Ink(CBT DR EETTVET .

Maintenance >Streaming
AMU—=VJ(CET REZITVET

=] REE NS IEH HREME PNES
File Transfer Execute/Cancel A E— RNBITT D (Execute CTHRITI D)o Preset Select Preset 1/Preset 2/Preset 3 A== J0TUty NEBZEIRT 5.
Remote File Transfer Enable/Disable FETRIRUICT U YT IV T 7 A )UEEEES, &5 BUEIAEd Preset 1/Preset 2/Preset 3 TH&
EE— RADBTERY RKI—IHh 5D F— TYI, ZEREEHICDVTIE. UTFESRBLT
MRIETHR T 5/ #0 UISWERTETS Do <fEEL
Enable : ®v hD—Ih 5D E— MEET, Size HD Auto/ A==V TROMGEDY A XZHRTES Do
ImEXE— MOBITZFI T D, 1280x720/ HD AutoZZEIR UTcIZE. SXSICEERENDED
Maintenance >File Transfer Cenix7= 31T 640x360/ I A—N v bDOREY. BEITDIUVT
TONEFHDFEA. 480x270/ DT A= v MMEDWNT, A XH1920X
Disable : ®xw hJ—UhH6DUE— MRIET. 320x180 1080Mm' 1280 X 720(CERETNZE T,
AT — PADBATZFFA LY, _ BitRate 9Mbps/ A N—ZVIROBEDE Y b — MERTE
Maintenance >File Transfer CEm& 25217 6Mbps/ T2,
TOMEDHOET. 3Mbps/ BIRTEBE W hU— NESizeDBEMBICKD
Auto Upload (Proxy) Off/On JOFVTFAIDBEEEEA Y /A TT 2Mbps/ BHEOFT,
%)o ] MbpS/ [C\zg]
Default Upload Sony C/NCMRX Server/  FUYF LI 7 AL PTOFY T 7 A L0 8-%?2{%“0 o . AUy MERTENE BT — S EEDEE
Server Server Settings1/Server T —I\—ZEIRT 2, : p EELET. ZOEHTF—IHEZ VT BIEEED
Settings2/Server Settings3  Server Settings1 ~ 3[C(&. WebXZ=21—® 0.3Mbps(Mono R)/ BOET, BEENRA NI —S VI TP BHET
[Upload Settings] MDisplay NamelZAAI L 0.2Mbps(Mono L)/ ETTVBTEERRLTIZEL,
e —N—2DRRINET. 2L [Em 0.2Mbps(Mono R) o 7 RUZDBEI AEEIC & D BE LEVEFIC
FEOU—I\—ZE{RITBICIF] (90R—) T—5EXELTCUXDABEMN DD ET,
ZECBLEEL, o Ry hI—UDKRICKD., IXTDITU—LZH
Clear Completed  Execute/Cancel EEE TEFDYITEIITUR D SIY ETTLENBEEDHOET.
Jobs 75D, o HITDHULWVWY—UTIF. BEHNEBLEDET,
— — o ARNU—SVIBEREETAZTINENE Y k—
Clear All Jobs Execute/Cancel \‘_})3 JURNIEBRUETNCDY 3 TZI M:Eﬁﬁbréi%ﬁ 5’/\‘(@7&—&3‘%;?675
UICE VEEHEOET. CORSEERIEBIICIE
View Job List XY 3T —BZRTI Do Size CRDINSWV A ZBZBATLIES W,
iEiniEnanee S ERming Type MPEG-2 TS/UDP/ 2 N —Z VI HOBREDOBEDERT Do

A==V T3 HREZITVE T,

MPEG-2 TS/RTP

158 EE NE
Setting On/Off ANI—ZVIGCREFY /FTT B
[CFE]

o CDFREIF. AEDERZANE Ulc&EICOSfIC
Uty hENZET,

e Onlcgd&. [Content Browser Mobilel 777U
T— 3V TDEZSYU VIREEFFEIFE A,

Destination Address X=%1/(0.0.0.0) A==V I F—=IDmEELT—/(—D7 R
LRAZEANT Do

Destination Port 1~ 65545(1234) X —I\—0D. ANI—=ZVTFEBITD
M—hESZANT D,

Audio Channel CH1/CH2/CH3/CH4 A MU—=vJHAICEE D Audio Channel %z

EIRT D,
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Maintenance >Clock Set

Maintenance >Option

MRSt ZRELE I o VI KD I P AT 3OS PREETVE T,
158 REE S 158 REE RS
Date Mode YYMMDD/MMDDYY/ FRHORTANZERT B, Type 1 (F TV 3vDETIVR) AVAB=ILENTWVWSIDEDA T 3V0

DDMMYY EFINEBDERREINET,

12H/24H 12H/24H RAIDERTENZEIRT D, Type 2 ATV 3avDETIVR) AVAR=ILENTWVS2DEDA T3 >dD
Date BASREEEZRTY . EFILBDERREINE T,
Time YR EEEEE T D, Type 3 (F7¥avoETIVE) AVAR=ILENTVS3IDEDF T3> D
Maintenance >Language ETVENERENE .

Xy DR =R EIR LT, Install Option Execute/Cancel ?Eizuie/t?)%?ﬁéél;:)bﬁﬁ%i%mié

15H REE NE
Select English/=r3 (i&)/ 8458/ Xy tE—IDRRSHBEEIRT Do
Espanol/Pycckuit

Maintenance >Version

TEDIN—T 3 VRRBFION=I 3V TPy TZRTLERT,

Maintenance >Hours Meter
TI5)UREEHCE Y DR EZTUVE T,

IE[S] REE PNES

Number AEDY T RO T T7 =TI 3 ERRTD (V.
XX) o

Version Up Execute/Cancel UTILITY SDA—RAOY hZERL. XDV

Thoz7PZEIN—I3 27 v TT5 (Execute

TRITIT D)o

BIFDSDA— RAYERTEFR T,

® SDHCAEU—7A— K (Speed Class - 4 &
JUHSIEMIG,B& 4 ~32GB)

[CEFE]

N—=Y 327y IT—=5DSDA— RHBEATN TV
FWVEE. FfeldMaintenance X Z 2 —®MNetwork
Client Mode >SettinghfOnD & EFBIRTEFE
Fuo

1BH REE NS
Hours (System) xxxxH BEFERFE (Vv bRA) ZRRT .
(xxxx | BSRS)
Hours (Reset) XxxxH BEFERFE (Uty bE) ZFRRd 5.
(xxxxI|FBSRE)
Reset Execute/Cancel Hours (Reset) &nz0ICUtY hED
(Execute TEITId),
Maintenance >Network Reset
X ND—UBEREZ THHEIREICRUE T,
=[] REE NS
Reset Execute/Cancel Ry hNI)—UBEOREZVIET D
(Execute TEIT98),
Maintenance >Fan Control
T 7 VDHEE— RZEFRELER T,
158 SREE NS
Setting Auto/Minimum/OffinRec 77 VO#IHE— FZEIRT .

Net-Func Version
Number

AHEDT AL ALANEHEED N\ —TI 3V %z
FKRIT D (Vxxx)o

[TFR]

Operation X Za—®MProxy Recording Mode

>SettingHtOff. HDOMaintenance X Za1—®D
Network >SettingD'Off D& E[FFRRESNE B Avo

Maintenance >VF Display Setting

E1—T7 AV —DFRICET HREZITVET,

I5H ERIEE N
Chara/Marker 5/4/3/2/1 Ea1—T7AVF—DRRICERT D+ VST

Brightness

F— PAAY, X—H—DRADSZRET 2.
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Maintenance >Version
KD/ —T a3 VRRBKO/N\ =T a7y ITZETLFET,

LS| EE NE
Net-Func Ver.Up Execute/Cancel PROXY SDA—RZOw hZEAL. &HEDD

A VLU ALANERHEREDY T hD T 7% )\—

37w T3 (Execute TERITT D)o

LIRDOSDA— BOMERTEEXR T,

® SDHCXEU—H— (Speed Class : 420t/
UHSIENIG BE 4 ~ 32 GB)

® SDXCXEU—H— K (Speed Class : 44t/
UHSIEX G BE : 64 ~ 256 GB)

[CFR]

Maintenance X Z a2 —®MNetwork Client Mode
>SettinghPOnD EE(FBIRTEFT B Ao
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FileX= 71—

KFEF VI =S4 VTRRSNTVDREEIS. BEFORECTT,

File >User File

IA—T—T7 A )LOREICEHT DREZTVE I,

File >All File
ALLTD 7 A )LODBRIEICEE T DR EZITLE T,

155 REE

PE

3Sec Clear Preset On/Off

MENU CANCEL/PRST/ESCAPER A v F 7%

= S & CANCEL/PRSTHIIC3FPERL EIFeFFICT
9 == R ~ o7\ Ik g ] (& [
L0ad 5D Card —;;gégg’;gﬁm“m R BEBACE [CREDREBE T ULy Mah
BIRIZ S ©e HUTENBREERAY /AT Do
Save SD Card 1—H— T 71 LDREESDH— RNRF T : :
PEEEERT B, File >Scene File ) ~
File ID 1—F— T 7 A ILOFile DERFEFEET SH Y=Y 77 OVORFICRISREZTNFT.
HZERNT Do IEH REE PR
Recall User Preset  Execute/Cancel UserX Za—(CERINTVD A1 —TEED Recall Internal REXEU—D5Y—Y T 7 LEFOHTE
fEE Tty MEICRY (Execute THIT). Memory HZXTI Do
Store User Preset  Execute/Cancel UserX Za—(CEREINTVD A Z21—TBED Store Internal RRXEV—[c2 =T 7 A ERF T SBE
BRI Uy MEE LTRIFET B (Execute T Memory ERTI D,
=17 Load SD Card SDA— KRB I—2T7A )L ZEROHITEE
Clear User Preset Execute/Cancel UserXZa—[CEJINTVBD X Z1—IBEHD ZRNI Do
REDRTED LT Y MEZTIBHAEE Save SD Card SDA—RICYV—2VT7A ) ZRES DEEZ
[CRY (Execute THIT), KNI Do
Load Customize On/Off [Load SD Card] MDEfTHFCUserX Z 1 —DH File ID V—2 T 74 )LDFile IDRREMREZTOEE
Data BHAIN A RERZEFHHADH E DD ZERTE 7RI Do
ERCE Scene White Data ~ On/Off Y=V TP A EFOCHTEEC, ¥—VT7
Load White Data On/Off [Load SD Card] MEITEFCRD A ISR AIVDIRTA NSV RATF—IZERMEIEDH
BRZEFHADODE DDVZERTET Do EDNZEHRTET Do
File >All File File >Reference File
ALLT 7 1 )LDBREICEE T DEREZETTVE T, UT7 U VRT7AIVDBRIEICET DREETVE T,
IHE REE NS I5H HEE S
Load SD Card All FileDEREZSDA— RSO H I EEZ Store Reference Execute/Cancel U7V AT7AIVDRRAZ 1—IEH
KNI Do DREDREB=Z T Y MEICHREFETD
Save SD Card All FileDBERSDH— RNEET 2EEER (Execute THAT).
IS Clear Reference Execute/Cancel U7 UVATF7AIDR[RAZ 1 —IEEDIR
File ID All File®File IDFRE fREE%E1T S BE RN T EOREBOLT TV Y MEZ TIBHFIEIC
Do R (Execute THEIT).
All Preset Execute/Cancel FRTOEEE Ut v MEICRET (Execute Load Reference(SD  Execute/Cancel SDA—bDSUT 7 UV AT 7 A IEREEE
TEFTB). Card) UL, TUty MEICERET D (Execute
Store All Preset Execute/Cancel IRTOEBICOVTREDRERZ 7V Y CTHEA)
MEE LTIREE 2 (Execute CETT3), Save Reference(SD  Execute/Cancel UI7UVAT7AIDORRAZ1—IBEDT
| W — KR C o
Clear All Preset Execute/Cancel All FileDFJRD A = 1 —TBEEDIREDRT Card) Uy MEZSDA— RILRF TS (BrecuteT

EBSRUTUY MEZTIBHEHBEICRE T
(Execute TRITI D),

ES TN
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File >Reference File

U7 UVRAT7 A )VDBRIEICET DREZITVE T,

File >Lens File
L ZX T 7 A )VDBRMEICEET DR EZTVE T,

BEE REE R BEE R E]

File ID UD7 YR I7A)UODFile DRREFESET  GFlare —99 ~+0 ~+99 LY ZT7AIICGT LT UNILVERET 2.
SEEZEXRRY &, B Flare —99 ~+0 ~+99 LY ZT7AIICBILT LANIVERET B

File >Lens File White Offset R —99 ~+0~+99 L ZXT7AICLUVXCRDIRDTA RIS

LY X7 A LDBEICE T REETVET. 2F Tty FORBIEEERED Do

BEE REE R White Offset B —99 ~+0~+99 LY Z T 7 ALY RICEBIRTA NS

Display Mode Model Name/Lens ID REFPIFUH UBSICEREIND U MRy & X AZ Ty hOBhRIEBZHREY S
([CRRIDIERZERT D, Shading Ch Select  Red/Green/Blue ROA S T—F o V IRIEDNRZREIRY

Recall Internal

WEAEU—D S UV XT7 A ZFUETE

Bo

Memory HZFRRI Do
Store Internal WEAEU—ICLUY XD 7 A )V RFS DEE
Memory ZERINT Do

Load SD Card

SDA—RP5LYX T 7 A VAU J BiE
EETY B

Shading H SAW —99~£0~+99 LY X T 7 A JUITKFEREDSAWRD A ~
VI—T 4 VIRHIEEZERET D,

Shading H PARA —99~£0~+99 L2 ZXT7 A SKFHBEDINSRI KT A b
VI—T 4 VIRBEBEERTET Do

Shading V SAW —99~£0~+99 LYXT 7 A VICEBEHREDSAWIRD A
VI—T 4 VIREBERET Do

Shading V PARA —99 ~+0~+99 L X077 AI)VICEEHRBD/ SRS RDIA b

VI—F 4 VIWIEEZRET Do

Save SD Card SDA—RICLVYXT 7 A I RET DEEZ
KNI Do

File ID L XT7A)LDFile IDRREFEZTTOEE
ZRNT Do

File Source FEIRULTCWD T 7 A ILDBESHRREND.

File >User Gamma
User GammalcB8 9 R EZ1TW\E T,

Clear Lens Offset Execute/Cancel

VX T7AI)7%o U733 (Execute THET
I5)

I5H RIEME

PE

Off/On(Lens Name)/
On(Serial Number)

Lens Auto Recall

VU T ILBEML Y XEERIC, ZHTHU
VXTI 7 AN ZEEENICHETEITHE DD ZE
Ed Do

Current Settings

I—Y—AURT7AIDREDHRE (T 7 A
LR) UX FEEZERRT ®o

Lens Serial Number

KESNEY U7 )LEBERINL Y AD U7 )b
FUIN=DRREND WIRL 2 XDdH) .

Load SD Card

User GammaDsREZSDA— R oMU T
BEZFRRT D

Lens Name

KESNIZY U7 LBENITL ~ ADEERD
RREND WIS~ XD o

Reset 1/2/3/4/5/All

BEEULY NIRRT —HUYT7AILE
BIRU. ExecuteTHEITT D,

AllZRIRT D EITRTOA—HF—HIYT7A
WUy b,

Lens Manufacturer

EESNCY UTILBENINL VY XDA—H—
BHERREND WLV ADH) .

MasterV —99 ~+(0~+99 U XTI 7A)ICEEABDSAWS T—F« >/

Modulation JRIEBZRTET Do

Lens Center H —40 ~+0~+40 VX T7AICE IR —H—DKFUE
ERTET Do

Lens CenterV —40~£0~+40 LXT7AIICEYI——h—DEEE
ZRTET Do

R Flare —99 ~+0~+99 VX T7AINCRT U7 UNIVERTETD Do
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PO AFTIVAA Y FICHBEZEID S TS

OperationX Za—MAssignable Switch €. ASSIGN.0 ~ 32X wF. ASSIGNABLE 4/5Z 1 v
FEONLINERZ Y UV XDRETIRY VICEBDKAREZEID {THIENTERT,
TIBHERFICIF. TNENTRICRIEEDEID L TENTVET,

ASSIGN. 2 XA w F(CEID =" C R ERTS % EE

[CFR]

ASSIGN. 22 A FICHREZEEID B TIcBR E5CHR T 4 —< v bOUIDIRZ BER(E. TORRDAA v FDRE EAED
RED—BUBWVNCEDHDRT . HAEDEID B THERICASSIGN. 2R A v FZYIDIRZ DH. BRZEZBRATDE—HL
ER

Assignable Switch® #eE

Eal—]

AAYTF/IRFT Y HRE Assignable Switch®ERE
ASSIGN. 0R A wF RERTE Off

ASSIGN. 1R wF RERTE Off

ASSIGN. 2R A wF RERTE Off

ASSIGN. 3R A wF RERTE Off

ASSIGNABLE 4 XA wF  KEBE Off

ASSIGNABLE 5RAwF KRBT Off

RETR% > LyolEa1— (BETREEES) Lens RET

ONLINERZ > ProxyZ U w J7ZBEE#mxd & Network Client Mode

ASSIGN. O XA w F(CE|D =" C RIS #ERE

X AE

Off RTE

Front Mic RTUANRA V%GR, AT U4/ /I END]RZ S

Marker IRCDN—N—KRRNEAY /FTTTD

Picture Cache Rec” EOFv—FvvyabwIE—RELY / FT93

Zebra CISKRRNELA Y /793

Clip Continuous Rec Uy TAVT A ZaFP AUV IE—RZEAY /FTFD

Rec Source SR T DIESZEHATEECIIHBAAICYIDIRZ B (FEoiRBEHICERE

gL, IR/ BEMET UTHSUIDMANRITIND)

Digital Extender X2 EEIEK Q) #eeZ24> /4733

Assignable Switch® fens B A RS DIREE Digital Extender X3 EEIEK GE) #2424 733

RE Digital Extender X4 EEILKR (45) #ee24 > /4733

Off RERTE - TX Power Save EERONT—t—TE—RE—RZYDIRZ D

Marker INCDN—A—FRZFY T3 REZRFT D 1) Picture Cache RecZEIDH T3 &, X =1 —MD0peration >Rec Function(d ) (4 L—Fx) [CHED. RETER
ATW Hold ATW (BEIBRRDA MISVR) [CLDRT  — <HEDFET,

A NNSVAREEZFRET D

Picture Cache Rec EOFv—FvvIalbwvwIT—RZEFV /7 BEZHFEFID

79%

Focus Magnifier KT+ —NAEEREZA >/ FTTB REZFRFLIEW

Zebra CISEREFY /F T REZRRE LIEW

Shot Mark1 T3y MN—U1Z8EA0 -

Shot Mark2 Y3y hY—U2ZETAD -

Clip Flag OK SERECIFBEFDT U TICHUTOKTS BEZRFTULIEWV
JIERE/RRT D

Clip Flag NG SERKTICFBERDI U v TICHUINGT S BEZRIFLEN
D7ERTE /WK T B

Clip Flag Keep SOERFRTCFBESRDI U w TS L TKP REZRFLIEW

(Keep) IS5 07ZR7E /RS B

Flash Band Reduce” Tovya\V NRRBIEBREES Y/ F 7928 REZFEFLEL

1) Flash Band Reduceh’7d > TH. ¥ v wdF—A v FHF VDBEIFHEEELFE A,
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TYAFTTIVAA Y FICHEEZEIDHTD

ASSIGN. 1/32A wF. ASSIGNABLE 4/52A wF & ASERESE L BEREAROR
» ~ ,|—r NV N AN BXAE
ONLINERS 2/ [CED 3 TR ge/S % EE Zoom Tele/Wide S U7 LEERHL > XA -
ASSIGNABLE 4(CZoom TeletkgeZ .
ASSIGNABLE 5(2Zoom WidetgEzZzZNnZn
Assignable Switchd> ~ #&E BRERABDREE 2|DYTS (<4>. <5>DREFBDHETI D)
BE —
p—— [CFE]
Off REE - TOF Y R B D M TR EEEE LT
Front Mic RTUANA V&R, ATUA (FY) /£ BEZRFID ata{ AR
/I (FT) ZD]RAS Zoom Wide/Tele U T VBENIRL > X BRI, -
Marker IRTCDON—H—FREL Y /T TS% REERETD ASSIGNABLE 4(ZZoom Widetge
Last Clip Delete BHIICEER LIy Uy TEYIRT 2 - ASSIGNABLE 5(=Zoom Teleifge 2N 2N
ATW ATW (BEEERARDA NSVR) E— RET  BEERBLEL DRCE (< <S> DREROIETIS)
Y/ FTEBR =34
ATW Hold ATWICEBRIA MNSYRABREBZRET  — JOFYERERPRIHID A TREERE LTS
? rzEb
Turbo Gain Operation >Gain Switch >Gain TurboM&E FREARRF UL Manual Focus Assist  X=a7I T4 —AAPVA MRS > /7 REERRFIS
[CRDVNTH—RS AV ERITITS J9%
Rec Review Ly oL 1—EETd3 — Focus Magnifier WRT4—NAREEZAT > /FTTD REERFEELEN
Rec spesmsL (S| ERITT B — Zebra CISRRZD Y/ H 793 BREZERFFLIEV
NFC NFCHEBEE =TT B _ Lens RET Uy—VETHESERRT D —
. e o= o T o AASTIORAT VY3 VA MefERLTW
Network Client Mode g:g) hNO=DOZAT Y NE=—REAY /AT REZRFEITS HOMBAR. Ly s a— (BATEEEEa)
Streaming ANV ERES Y/ TID BEERBLBL) Return Video oI TARRERT IS -
Auto Upload(Proxy)  JOFS 7 7 A LOEBEREDS >, 4 %% BEERET Return Video? VI IETAERERNT S -
=93 Return Video3 US—23ETHESZRTI D -
Picture Cache Rec COFv—FvuYaUvIE—REFY /F REERETD Return Video4 VY—VAETAESERTI S -
J9% Shot Mark V3w M= 1ZEETAD -
Spotlight F—hPAURE—REZRY hSA MCRE BEERIETS Shot Mark2 V3w hY—2EEEAD -
FREI D Clip Flag OK ERFERFBELFOIU Y TCHLTOKTS  REERFLEL
Backlight F—hPAURE—RENYISA MIRE, BEERETS DIRRE S RET B
RS S Clip Flag NG ERFIFBERDIU Y IITHLTNG TS  BEERF LN
VF Mode Ea—D7 A VS—BEEDHAR(4Y) /HS5— BEEFERTD DRRE S RET B
() Z)D]RA D Clip Flag Keep SERFIFEEFDY U w T LTKP REERE LT
Video Signal Monitor ~ ETAESEZI—XRTHAEZTIDIBR D REZRITIT D (Keep) 75 J7ZH_TE /IR T B
Lens Info WEFRERTDA J. XA—F—KRR. T14— REZRFTID ColorTemp SW 3200K  1RDA MGV R%Z3200KD T Uty METIR BEZEFREITD
NETREDIRZ B JA PSSV RFEETS
Color Temp SW4300K RO A NS A7%Z4300KDT Uy METIR BREZRRFFITD

DA MNS YV RREZETD
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Assignable Switch® HERE BRBEAROIRRE Assignable Switch® FRE ERBEARORRE
RE =E
ColorTemp SW 5600K DA MGV RZE5600KDTUEY METR BREZRRITD HLG Display Assist Ea1—T7A45—EDBMRICHLGDA VY  BEZRFELEN
DA MGV RARZETD H—DZMNFITERRT B
ColorTemp SW 6300K DA MNSVRZEE300KDTUEY METR BEERRI D (]
DA NSV ARRELTS SDRE— KBS, F/cl3EERIAERTEE DA
Electrical CC ROA NSV ZREEBEICH LT REZERFET D
BRWCCT 1 I)LY—=HID]AR 5
(3200K/4300K/5600K/6300K) #&aE
AAVF /R EBSTZUIC
3200K—4300K—5600K—6300KEH1D S
MenuzzE CZ5EnlRE (Electrical
CC<A><B><C><D>THE)
[CFE]
AZa—MMaintenance >White Filter >ND Filter
CTemph' OnDIZEFFRECERE Ao
WEEEZEID M Tzdp & TND Filter CTempZOng 2
ELFDPTAFTTIVAA Y FIIERELIFLSIED F T,
CC5600K RO A S\S Y AERBICH L T5600KDBER HEZFRFT
HCCT A4 ILF—ZEDTFD
Clip Continuous Rec JUwTAVT 4 ZaFPAVYIE—REFY BEZRFLIEWV
SATED
Slow & Quick Motion AO0—8IAYIE—23aVaEFY /FT79D H[REZFRFID
Slot Select 20w hAEBOMSICEERAT « PHEESN —
TWBDEE, FRTDEIMAT « P 2D B
Digital Extender X2 BEALK (1) HaEZF > 47793 REZRFELEN
Digital Extender X3 BEALK (31E) aEZZ > 7793 REZRFLEN
Digital Extender x4 BEALK (415) REZZ > /7793 FREZRFLEN
Digital Extender EEILAEEEDEBEZYIDITRZ 5 BEZRFELEL
X2X3X4 BEEX A v TF /R VEBS T2UICOf— 215
—3fFAE-OFfETIDID S
TX Power Save DA VU ZRERDN\NT——DJE—REYD BEEREFLEN
b )
Flash Band Reduce TJowya\Y RERFIEREES Y/ F 795 BEZFRIFLIEL
[TFE]
Flash Band Reduceh’z > TH., Y v wdF—XA v F
WF >V DBEFKELIR B A
Proxy Recording Mode JOF > F—558RMEEZ A /75 REZERFET D
Proxy Rec Start/Stop TJOF VRS (FLET D FREZRFF UIEN
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TYAFTTIVAA Y FICHEEZEIDHTD

L2 ZDRETS 2/ [CEID = CRIREIS A RE

Assignable Switch®Ds%  H&aE BEREIRARDIRRE

E

Off RERTE -

Lens RET US—VETHESZRRIT -
AARSTORTYavITw MEERLTWL
HOWBERE. LyolbEa— (BEARERES)

Return Video Uy —VETAESZERRI D -

Rec Review LwolE1—%ZFTITD -

Shot Mark Y3y MNN—J1Z8EA0 -

Shot Mark2 3y bN—02ZEEAD -

Clip Flag OK SOSRFCEFBEEFDI U Y IICHULTOKTS  BEZRFLEL
DZRE /R T B

Clip Flag NG EERECEFBEFDIU Y IICHUTINGTS  BEZRFLEWV
JEHRE /R T B

Clip Flag Keep ELERKRTC(FBERD T U w T(TH L TKP REZFRFTLEWN
(Keep) 75 V%E/E/ BRI D

Focus Magnifier BRI+ —NAEEZA > /A4 TITD REZRFUEL

Digital Extender X2 BEALK (21F) aEZF > 7793 FREZRFLEN

Digital Extender X3 BEALA (315) taEZEZ > 47793 FREZRFLEN

Digital Extender X4 BEHLK (415) tKaEZEZ > 7793 FREZERFTFLEN

Digital Extender EEILAEEEDEBEZYIDRZ S BREZRFELEL

X2X3X4 HREZ A W F /IR VBT e U(COff— 215
—3FAE-OFfETIDID S

Proxy Rec Start/Stop TJOF ViR FLET S FREZRFFUIEN

HLG Display Assist Ea1—TJ7 A —EOBMRICHIGDA VY  BEEFRIFLEV

H—TZNNITERRT D
[CE=]

SDRE— RE. FIcldBERIFERTEXREA.
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88 I1—Y—HRET—YDREFEEFUHL

11— —8ET

Ty hPYvIAZ 1 —DRERNEE. AEOA
BAEU—FESDAN—RICREFTDHIENT
TFXT, COT—FZEET EUEEY b7y
TREZT (EPLBRTCEFXT.
RET—Y7ZSDH—RICRETHEEF. 5
hUs. EERAHFREFSDA— K (38X—)
ZUTILITY SDA— RO MCEALTHER
ER

BI7AVICRESNDREEBICDOWNT

F. [A—Y—F—FIRESNBIEE]
(165X=) ZCBLZE L,

BET— 5 REASDA— ROEA

| 2qvFh—EET2.

) #EF—927%RSDA— REUTILITY SD
A—RZOw MIEAT B,

3 A YFHN—EEDB.

BT — 5 RAFFISDA— RO H
L

| 24vFn—=ET5.

) BET—5REASDAH— REEL
1EHR L TEDHT

[TER]

o SDA—RICP I ERARICHHEDERZY]) >fcDSDAH—
RethWesa., T MRIASNE A, H—RIC
ERSNICIRTCDT—IMMEND TR D DE T,
BRZYDED. N—RERLS EEE BFEATS
SDA— RDACCESSS 2 THVEKT LTS & & 7= HEsR
UTHhSBRIELTLZE L,

o HUANBICESDA— RORVHE UICTERLIES L,

= —

—5

FRATEDI—Y—T—FFRDESD T,

d1—5—T7A4)b

NAITAZXUteUserA Z a1 —DREEB &
BRET—YZREFELET. SDH— RIC64fEZFE
THREFEIDIENTEFI ., DI F7AIER
BEDAEU—[CFHRHAD T EICKD. USERX
Za—FHARINAXUIEREBICEY NPy T
TBHTENTEFT,

ALLT 7 AU

EAZ2—DRET—FZRELE T, SDH—
RICOHEE THRET D ENTEE T,
[TEE]

HEERDT —% (WECEICREDDELY T —FT 1
TRHEAUNIVEE) FREFESNE B A,

V—=2T7A)

By —VICEDEBTREULENRA Y MNEED

REMEZRFLUE T AEDOABAEY —IT5

B, SDAN—RICOAHBEFETHRETDIENTE

ESER

RDT == T 7A)VICRFCEET,

e PaintX= 21— =R U CERELE

o BEE— RBKIUECSE—RTODY vy H—
AE—ROERE

o IRIA MNSVRADT—H

RESNDT—IBIUOHFOEENDT—

HlE. XZa1—®DFile >Scene File >Scene
White DataDEREIC KD TEHEDF T,

V=T 7 AVISAEBOAEA T —&KTlESD
H—RICRETDENTEFT,
FIREFELEY—V D7 A EHUHT CED
TEEY,

U7 U RAT7A)

=277 A )VDOEEERTE (File IDHYStandard)
DEREBEERELET . AMEOHNBEA T —&
SDA—RICTHETOREFEITDCENTEFT,

LU XT7A)b

LY XEBORMZEMIET DU TDT—57%ZR
EU. LYXT7A)EVTRIFLRT, At
DHBEXEVU—IZ32{E. SDH— RIC64EET

RFEITHCENTEFT,

BRET—H e
VEYVal—y3arvyz— MV Modulation
T4 VIRIEE

T~ —H—DE LensCenterH

Lens CenterV

U7X R Flare
G Flare
B Flare

MDA MNSVRFWIEE  White Offset R
White Offset B

RET—H e

MIOA ~h>x—F %  Shading Ch Select

fHIEME Shading H SAW
Shading H PARA
Shading V SAW
Shading V PARA

HIRT7A)

aA—Y—PERLicH Y ~T—JILTF—%
(User Gamma Data File) ZZA#DAEL X T
U—[C5EERCTHREFEIDCENTEFT,
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dA—5—T7A1)b

A— =T 7 A )LEFREFET 1—Y5—"T7A4)LZFUOH

Z) El
| %x=a2—File > User File >Save SDCard | *=a—File >User File >Load SD Card
FRRT D, FRIRT B,
1—T— T 7 A LDEFEEEHE TSN 1= T 7 A —EEENERENET,
=7,
2 MENUDEFHEBLTIRUT I 7 A L%
7 MENUDEHEE U THREEEERL. D BIRL. DEHEET,
EHEET, REANRRINET.

File IDHINo FileDITICT 7 A L& RET D
ZEDTEFT, File IDICFile IDDECHE 3 MENUDZEHEE L TExecute BER L.

NCWVBITZERTDE. TDT7AIVIC EN Y %I

tEEENFT, —

File DEBEMICHITONTINN BET gz ormomss. AgERNCEEDENST,
BTEBHTEET,

3 MENUDZ#%E L TREEEFEDExecute
EERL. DEHEET,

File DZZ$9 %

| =2 —File >User File >File ID%E&IRT
50
File DOREEANERENET,

) =3 RUTRle DEANT 3.
3 MENUDEF#%EE L TDone &R L. OF

HEHT
File IDOZEASET LE T,
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ALLD 7 1)U

RET —FALLT 7 AU
EUCTREFETD

| =2 —File >All File >Save SD Card%
BIRT B,
ALLT 7 A LD EEEENE RS NE T,

7 MENUDEH%EE L TRFEEERL. D
EHEET,
File IDBNo FileDATIC T 7 A I ZRFET D
CEDTEFXT, File IDICFile IDDECE T
NTVBITERRTDE. ZDT7AIIC
FEFINFT,
File IDIFEBIMICHIFSNETH, ZET
BTEHTEET,

3 MENUDE#%E L THRREEDEecute
EBIRL. DEHEET,
[TEE]

ALLD 7 A VICIFREDREEE TV Y MEDRESN
EEE

7 AIVDREDFERTINENEE
(&

BIEPFRIFRIORDIS— X v E—I N
KRSNCEEF TP AIRESNE A,

ITo5—Xv KR PO

-y

File Access  ECERAJBEIL A SCERATREIR X
NG FATDEAS T PEEAT

UCTLEL %)

File DZZFE 9 8

| =2 —File >All File >File IDERRT
%)o
File IDDREBAENERENET

) xsmERUTHle DEANT 5.
3 MENUDE#%E L TDone Z&IRL. OF

HEHRT
File DOZEATE T LE T,

EF— S EFOLT

| =2 —File >All File >Load SD Card%
BIRT B,
ALLT 7 A ) —EBBEEHETENED .

7 MENUDZEH%E L TIEUHT T 7 A L%
BIRU. DEHEET,
BEREEHERENET .

3 MENUDZ#%E L TExecute &R L.
SFEHEET,

[TEE]

o SDA—RDST7AILZEFUHT & AERERICRTE
SNTVDIREDREEE T U Y MEF EEESN
EER

o OB CTREFELLT 7 MIVEFURTHBE, 77 A
W ERFEUIBEE T 7 AL ZFOHIHE T T 7 —
LOTT7N=Y3VHELEDE. FUR USRI
INUTUVVRUVVEBED R EEIFIFUH L TE R B Ao

o RET—YEIFUHT & AKIFEEMICHEZHN
ER

77 A )OFUE UHASRITENEL
EE

BIFRE I [FRIERICRDT S —X v E—I Nt
KRSNBARE. 771 )LOFUH UIFTH
nEth,

IS5—Xv KR PO
-y
File Access FiHHUTIRERE T 7 A ILZREF
NG AT ATHIENY UTeXT 14 7%
XTF47ICEE BATD
DT 7 A )UHE
(A
IREDREEZINT T
ttwy MBICRT

AETIH. I—T-HRAIREREFLC
Ty by IXZ1—DREANSZ [ TULEY
ME] EXREELE T,

T7 AN EZFOHEUCHAEZEEY h7 Y TU.,
EOICREREZATOTRETTD T 7 A )72
IEERELEHETH. JUty MEZERE
TEBDILEICKD. TF7AILOABTZ Y ~
THTENTEFRT,

| X=2—File >All File >All Preset &R
a—%)o
FEEHEREINET,

7 MENUDEH7%E L TExecute Z&R .
DFEHEHT,

REDREEZINCTY
Yy MECUTHREI D

| =2 —File >All File >Store All Preset
TRING B
FEANERINET,

2 MENUDZFEH#7%Z B U TExecuteZ &R L.
DEHZEHT,

[TEE]

KT, FEIEBHCHEH NI T,

REDINCOREEE T
Uty MEZ TiHHaE(C
R9

1 XZa—MFile >All File >Clear All Preset
ZEIRT D,
EREENRREINE T,

7 MENUDZ#7%E L TExecute &R L.
DEHEHT,

[CER]

RITR. AIEBMCHEEINT T,
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—=2T7A4)

=27 A)V7ENEXE
U—[CRFT D

| x=2—File >Scene File >Store
Internal MemoryZEiRT 5.
V=T 7 A I —EBBEEFRRENETT,
File IDA'StandardDRTFSEIC(EHD SH U
BEREPMRESNCVE T,

7 MENUDEH%E L TRIFEARRL. D
EHEET,
IR UTARIZEIC Y — Y D7 AU L=
REENET,

3 MENUDZ#%E L TREEEFEDExecute
EERL. DEHEET,

V=T 7A)ESDA—
NCRIFI D

| =2 —File >Scene File >Save SD
CardZ=EIRI D,
Y=V TP AR EEEENETENET .

7 MENUDZFH%EE L THRFEEERL. D
EHEET,
File IDBNo FileDITIC T 7 A I ZREFET D
CENTEFT, File IDICFile IDDECEIS
NCWVWBITZEIRTDE. TDT7A)UIC
FEFINFT,
File IDIFEEIMICHIFSNETH, BET
BTEHTEET,

3

MENUDZEH7ZE U CHESSEEDEXecute
BERL. DEHZEHT,

S~ D7 A )LESDA—
RO BIFOH T

File DZZEJ %

X Za1—MDFile >Scene File >File ID%Z &R
a_%)o
File IDOfREBENDFRRSNE T,

NZFEZEIRUTFile IDZAST %,
MENUDZEHMHZEILTDoneZEIR L. DF

BT,
File DOZEAT T LE T,

=207 A)V7NEX T
U—DBHFUOHT

1

2

XZ a1—MDFile >Scene File >Recall
Internal MemoryZ#iRd %.
=27 A ) —EEEIRRINET T,

MENUDZEHZE L CIFUHT T 71 )L7%Z
BIRU. DEHZEHT,
REENSRRENE T,

MENUDZEH7%ZE U CTExecute 2R L.
DFRHZHT,

| =2 —File >Scene File >Load SD
CardZ=EIRT %,
Y=V T A —EEEDNERENET .

MENUDZEH7ZEI L CIFOHT T 71 )L%Z
BIRLU., DFEH7ZHT,
SEEDFRRENE T,

3 MENUDZFH#7%Z B U TExecuteZ &R L.

DFERHZHT,
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D7 U2 AT

BEDREEZ TUtY
EECUTREFID

1 X Z a—MDFile >Reference File >Store
ReferenceZ#&iR9 %,
EREE N RRINET,

2 MENUDZEH%ZE U TExecuteZ &R L.
DEHEZEHT,

71)b

3 MENUDE#%E L TDone Z&IRL. OF
BT,
File DDZEEHNT LET,

U7 A T7A )%
SDA—RHOBUHET

REDEEEZTULY N
BE LCSDA— RICRTE
ERR

1 X Za1—MDFile >Reference File >Save
Reference(SD Card)Z#EiRd %,
SREENRRSNET,

7 MENUDE#7%E L TExecute Z&IR L.
DFEHEHT,

1 A Za—®DFile >Reference File >Load
Reference(SD Card)Z#EiRd %,
EREEONERRINET,

7 MENUDZ#%E L TExecute &R L.
SEHEET,

REDINCOREEE T
Utzw ME%Z TiHaEE(C
RY

File DZZE 9 %

1 X Z a—MDFile >Reference File >File ID%
BRI D,
File IDDfREBENAFTRINE T,

) x=m@RUTRle DEANT 3.

1 X Za—MDFile >Reference File >Clear
ReferenceZ#&iRT 5.
EREENRRINET,

7 MENUDEH%E L TExecute Z&IR L.
DFEHEHT,
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LA T7

U AT 74 )L7RNE X E
U—[CRFT D

1 XZ a1—MDFile >Lens File >Store Internal
I\/\emory%ﬁﬁ@“éo
VY ZXT7 A ) —EBEEPFRRINE T,

7 MENUDEHZE L CTREEERIRL. D
FHEHT,

File IDHNo offsetDITICT 7 A JLZRFT
DT EDTEFET, File IDICFile IDAYECE,
ENTWVBITEEIRTSE. TDT7AIb
[CEEBEEINFT.
File IDIZBEEINICTFHNETHL
HTEBHTEFRT,

EEY

3 MENUDEFH%E L CRRE
EBIRL. DEHEET,

HEDExecute

L X7 7A)7Z2SDAH—
NCREFET D

1 X Za—MFile >Lens File >Save SD Card
ZTERT D,
VXD 7 A )VREFELREERNRRINET,

7 MENUDZH%EE L TRIFEERERL. D
EHEET,
File IDB*No FiledfF(C 7 7 A L EARES B
TENTEET, File IDICFile IDHVECHE
NTVBITERRTDE. 20T 7 AIUIC
rEEENFT.

1)L

File IDIZBEEIMIICRHTSNFIHL
BDIEDHTEET,

EEY

3 MENUDEH%E L CRREEDEecute
ERIRL. DEHEET,

File IDZZE 3 %

| x=2—File sLens File >File IDERIRT
%)o
File IDDIREERANERENE T,

) x=m@RUTRle DEANT 3.

3 MENUDE#%E L TDone Z&IRL. OF
BT,
File DDZEEHSET LET,

L2 X T 7 A )V 7Z2REX T
U—D'BIFOH T

1 X Za—MFile >Lens File >Recall Internal
MemoryZEiRT 5.
Lo X T 74 )—8BEEIFRRINET .

7 MENUDEH%ERE L TRUOHT I 7 (L%
BERL. DEHEET,
FEANERINET,

3 MENUDEH%E L TExecute Z&IR .
DFEHEHT,

U Z T 7 A )WESDH—
R SIFUH Y

| %x=2—File >Lens File >Load SD Card
ERRT B
LY XTI 7 A N —BEEHRRENET.

7 MENUDZEHER U TIFUHYE 77 1 L%
EIRL. DEHEET,
PEEHETENET.

3 MENUDZFH#7%Z B U TExecuteZ &R L.
DEHEHT,

L XD 7 A )L7Z2BEE) CH
O)us}

VUTILBEMNL Y X7 ERLTVD EE(L,

LY ZADFREICHIGT DL X T 7 A )L EE)

HICHFUHULT, AZzTY b Py T E

HTEFT (Lens Auto Recall#EE) .

Lens Auto Recall#gEZ AT & & E(E, File

AZa—®D >Lens File >Lens Auto RecallZZl4

TOWFNHICHRELET,

Off . #peZERA LIEWL
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On(Serial Number) : U X#fE2 &> U770
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(U7 IESOBENTREEL V XDi5

&)
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88 I1—Y—HRET—YDREFEEFUHL
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HIR T 7 A IVDREDE
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2

CvpkFile EditorTM V4.3°C
ER LI 1—F—HU~
74 )7 ERT 5

X Za—MFile >User Gamma >Current
SettingsZEIRT D& RARESNTWVNSI—
P—HX T 7 A —EEEHRRINET,

SDA—RKRh1—tH—4H
IR IT7A )OS

| %x=2—File >User Gamma >Load SD
CardZERT 5,
1P —HIXT7AI—EBEEHRRS
nEd,

7 MENUSE#ER L THUOHT I 7 ALk
BIRL. DEHERET,
FEANERENET,

3 MENUDEH%E L TExecute Z&IR L.
DEHEHT,

ER Lic 21— —HY T 7 A)ILIFSDA— R
D [PRIVATE/SONY/PRO/CAMERA/HD_CAM]
T4 MU—ICREFLC. HUH UREZITD
TLIEEL,

RESNCT 7 A ILOAE
ZHHRIRREICU Y b D
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R 5.
Uty hg2HIT7AILOESEEH
FKRINFT,

J MENUDEHZERBLTUtY hEBHYT
TP AIDES (1 ~ 5) BRIRNT 2.
IRTCOAVNIT 7A=Y NI D
ARAIERRUET .
BREENRRENES .

3 MENUDEH%E L TExecute Z&R L.
DEHEHT,
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THEDHTEFTT,

JE—HrI bO—)LD
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BHE. UE— IV bO—ILE— RDERRENF T,
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FHEED AL w FRIFEHICTTEDE T,

o GAINAA wF
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e SHUTTERRA w5

e OUTPUT/DCCRA wF

o Turbo GainEzlFATWHSRENYEID 24T
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ASSIGNABLE 4/5 XA wFB KU ONLINEMR
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UEt— bt rO—)LE—
NEHERT S

AEDOSERZYIO, I ~O—)V1Zw hEE
DHUET,
KEEDAA v FEOERENEBMICEDERT,

RM-B170ICEZSY —= 3%
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RM-B170MDMONITOR®HF (BNCEY) h 5.
VIDEO OUTimFHh5DHEAE B UESHHAS
nFEd,

RM-B170MDMONITORIGF & EZ 5 — A&
I25BHaIF. AHEDVIDEO OUTIHFDREZE
CompositefFICLT. RM-B170(CIEBDE
Wr—JIZERLTLEEW

RM B 70}§%JLH%@
ZIEH(ICDWT

'EIIIII

NASOEERFEIEF (R4 hTF—5) (2D
Tl&E. BIEIRM-B170Z#ZEFRLUIEEE(CERELRE
IO A—=F—HBRINET,

RM-B170%zic B DECERF
in MEIERSY  DREREICD
LT

A Za—MMaintenance >Camera Config
>RM Rec Start CBIRCEXR 7,

RM Rec StartDEREEICH T MY >/ DHEEE
&, LUITFDOESDTTY,
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FHEDREC iz B B
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LYZXDOVIRR 3 a3 B
5

SCERFAMR 12 i) axp a3
LERREDYEID

HToNT

L1DASSIGN.

1324 YT,

ASSIGNABLE

4/5AAVF. B

KUONLINERS

”
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%

AATEHERFRT —5D
T 9*% (CDWT

TEDFRFOAATHEBRET—F (XA hT—
&) DTF—FHEEICIE. KEDKLSIC. UE—
O hO—)LAZw bEEREUEVEECE
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#E S TUE— DY bO—)UAT— 5538
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DEBEEDREEN—H UL TWVDRENDDAA VT

X Za—MMaintenance >Camera Config
>RM Common MemoryZOn(CEEET D &
UE—HrI> ~O—-)LIZw bEEFELTHBIY
T—-hrIbO—-)LAZY MRT—YHEE] =
EMCUEX RBAT —FHEE ZFES &
W CEFRI, COFE. UE—H~IY O
d=v MMETERAT—FRE] DT —5ZF5H
THIEILED, HUTesEBUE—MIOV b
O—)LI= v bCTHREUCTFTOBEEHL MRS
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EREDERLED EE(F. FEDRA v FHMES
ENEI,

Fle. U=V bO-)LIZ Y bZERL
feEEIC, ERRIEHENTEENEL ULENSK
JICTBDIENTEFT, CDHFAEIE. UE—
hI> hO—LAZw bORY 2 —L%FTT
HEHMER Y 2 —AICRELTEKBENS DR
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& FU<F. FUE—HFIYRO—LAZY MMIRHED
ARU—Y 3R AT ETELIEEL,
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BIFI S

| RM-B170DCHARACTERIK S >4 LT
JEETh S, MENUKRS V&Y,
RM-B170DMONITORSFICE#E LIc E=
& —BEICA = 1—HEREINET .

) BEOFHECANCEL/ENTERRS > 7% {8
UT AT 21— 38R - BET Do

3 BENMERD-S. MENURS Y EOFFIC
LTA= 21—k 3.

€ RM-B170D#BMEIC DV TEE UL IEZRM-B170D 4
RU—y 3R aFP ) ETEL RS0,
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OF SEBEEOER - UE— I bO—)LIZ Y hEER TS

RCP-1001/1501. RM-B170CEBIECE DTSR

KROEh
BIERRODESDEKIFRDESDTT,
O BFCED
— L BRECELTW
1BE HHE ERA e RCP-1001 RCP-1501 RM-B170
Panel Active Panel Active On/Off IRRIVBRIEDBWZL > /A4 TT D O O O
Bars Bars On/Off NE—IN—WEhEA>Y /" FTFD O O O
Call Call On/Off RCP/RMDS5AALT—FEI—ILTD O O ov
Standard Standard On/Off EBEE—RICTD O O oV
ND Filter ND Filter 1/2/3/4 BRENTWVBND T 4 LY —ZERRT D O O O
CC Filter CC Filter A/B/C/D BRENTWVWBCCT A I—ZRTRT D — — —
Gain Step Gain —6/—3/0/3/6/9/12/18/ NAY =T AV DHRE O O O
24/30/36/42dB
White Balance AWB Start/Stop F—hRDA SNSVRZRTITD O O O
FTHIIT BB A MY TTD
White Memory A/B/PRESET ROA MGV ADAEY—ZYDEZ D O O O
ATW On/Off ATWZZ>Y /A TF D oV O o’
5600K On/Off BREBEERESY /FTTID O O o"
Black ABB Start/Stop TSV INSUABERABEZRTID O O O
FTHRIATOHZERIRA Y TTD
Knee Point 75% ~ 90% ~ 109% ——RAY NEERET D — O oV
Detail Level —99 ~+0~+99 HDT « T—)LLNILERRETS 2 O O O
Shutter Shutter Setting On/Off VI —EF Y A TITD — O O
Shutter Speed — VI —REZRET D — O O
ECS Setting On/Off ECSE—RZEFY /FT79% — O O
ECS Frequency — ECS E— FORKREZRET ® — O O
SLS Setting On/Off SLISE—RZA>Y /A TF2 — O O
SLS Speed — SLS E— RDRAE— R (T —LE) ZHRET D — O O
Iris Iris Mode Auto/Manual PAURE—RZRET D O O O
Iris Level —99 ~+0~+99 F—bFPAUROERMEL NIV ZRHET D O O O
Close On/Off TAVR@HOO—RZEA Y/ FTTD O O —
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CUE—bIOV MOV Z Y bEERRT D

1BH S| ERA e RCP-1001 RCP-1501 RM-B170
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Matrix On/Off NhUORERE A /F TS D — O 0?2
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Detail On/Off T4 TV RS Y S FTTB — O O
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Test Saw On/Off TRANESZEAY /A TIBD — O oV
White R Gain —99 ~+0~+99 MROA NS VRADRY A MEZRTED D O O O
B Gain —99~+0~+99 MOA NS VRADBY A MEZRTED D O O O
Black Master Black —99 ~+0~+99 NRY—=T5v I UNVZERET D O O O
R Black —99~+0~+99 RF v URILT S IUNIVERES O O O
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Select/Set Select(Up/Down)/Set — — O
Media Rec Start/Stop SCiRZRR ELETD — — O
Play Play/Pause BEZRRT D — — O
FREV — WEREET D — — O
FFWD — SIREET D — — O
STOP — BYEZEIETD — — O
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PREV — REQIYU Y ITDEEICI > TITD — — O
NEXT — RDTVJw TOFEFRICT v TTD — — O
Shot Mark Shot Mark1 — Y3y MN—J1%Z8ETD — — O
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Z0O0M — — A—LBE WL > X) — — ov
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THEEOEHESZEERL. BRI DEZI—ICRUIcERT —JILZEFRL TS0,

o8 £ &

—_

—

VIDEO IN

SDI OUT
112 ?
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4

VIDEO OUT
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BNCT—2)L (RlI7E)

HDES ./ SDESZEDH T, ABE=5—IC
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AFROAZ I - EZRRIED I ENTE
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[T33E)

SDIESDOSF Y IVI\— MG, *Z1—D

Operation >Input/Output >Output FormatDEEH
720x486i 720x576iDEEICITTDCENTEFRT,

SDI OUTim+ (BNCEY)

SDI OUTimFICIE. SDIRIRDEZY—. XA v
F v —PVIRFEDEFREBZER T o &h
TEFXT,

KiFFHODOHNESIFE. A Z21—D
Operation >Input/Output >SDI Out1
Output/SDI Out2 Output (108R—2)) TH
VA TTHENTEXT,

ElClE. RBIFEDOBNCT —JIL7ZERLE T,

VIDEO OUTim—F

VIDEO OUTi®mFICIE. 77FOJaVRI w i
IRDEZS—OVIREEDELIRRE 7R T ©
CENTEFT,

HAESEF. XAZa2—MD0peration >Input/
Output >Output FormatDiREIZEE) U TE
bbxEd,

7FOJIAVRY v bIESRICIESZ AT
BICIF. BECIHU T, VIDEO OUTIHFN S
OFFOJ VIR v MESDREICEGHET.
7FOJIVRY w bMIESRRID A IIES R
EZEEBLFRT,

T —PVIRFEDEREECEFZAST
5155(1E. AUDIO OUTImFh o DEEHDE
EZY—PVIRBIDOA —F « A AN ZERUE
CB

ElClE. BIFEDMBNCT —JILZERLE T,

HDMI OUTiw=F (Type A
RO 5—)

KiFFHODHAESIE, AZ21—D
Operation >Input/Output >HDMI Output®
T/ ATTHENTEFT,
HIESDT 4+ —< v b, XZa2—0
Operation >Input/Output >Output Format
THRELFET,

Em(C(F. MmEROHDMIE R — J)LZER L
FIo
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TR TSSAEY—H—PNICEERLIEIU YT
Z, AvE2—9—LtTEBUED. FIFED./
VUZTREY T N TRETHIENTEFY,
T B R EIR T ICOR—5 TV A ML=
/ USBX T o 772k I NUE SXSAEY—H—

FRDOU Y TEiR—5TIVA L—2 7 USB
XTFAPICAE—THIENTEFT,

a1 —5—&EUSBE
ERR

AHEZRFEOUSBT — DIV ZE>TCIVEa—
Y—[CEmRIDE. ROy MMIEESNIEAE
U—A— ROV 21— —DiR NS AT &
U CERSNEd,

THEDEBE. 2MOXEU—N—RHEATN
TWdEERF. OVE2—5—TIF2DD RS
ATEUTEHEINE T,

¢

USB—2)L
(Bl7E)

[TER]
o FEDERZAICUT. EHICBEPERDRTS
NTHS. FEICUSBTr—DILZEERL T EEL,

e JVEa—¥F—[CERIDEEF USBORTISI—D
FeamEICERULTLES L,

o AEIFIVE21—F—NSDNR/I\T—TIEFEELE
Bh

USBE it zfRia g & (C(&

PCERIRT & I E 1 —5—ZRIFEDUSBT —
JIVEE->TEE LIS, USBERZED
(LT DN, EMCT DN 7ZHERT S [Connect
USB Now?] DXy Z—IHRREINF T,
[Cancell Z@RU=D. MENU CANCEL/
PRST/ESCAPER A v F7ZZESCAPERICHR L T
B a. FFUSBT—JILZEIRWEEEIF.
[Connect USB Now?| DX wtz—IhYNEA .
TTOEEICEDFT,
[Execute] ZEIRL. MENUDEHZIRYT &,
USBEFIABRICHED., AElF IV E1—5—
DR RTA TELTERREINE T,
soir/ BEMERICUSBESZEFA UTCIBEA(E.
BfEZE1E L TUSB Connecting (USBE#EH)
ZE1—T 7P A VY —BEHEICKRRULET,
ZDEFE, VIDEO OUTiwF. SDIOUT 1/2i#F
PHEDOHEAESFRBELEDET,
[CFE]
o USBIEHFRIE, ATRER BEKEDREITES
Bho
o JVEA—9—HOKEDELRAT 1 7ICT7 IR G
HEE) LTV B EERFUTORIEZTOIENTLEE
L
- AEOBRE (EBRODA > /74 7. E— RYIDBRIEE)

- PORARDERAT « PZREEL
- USBHET —JILDIREEL

USBEifcDERRR

USBERODEERRIF., IE21—5—DF /AR
WONUFIBICHRE D TRIELE T,

JEA—4—TCoOVUvT%ZEE - fREIT D

USBZEB#EHRIDETFE. —BUSBT—TIL
ZIRWeH EICBERERLTLIESW. BU
[Connect USB Now?] DX wtz—IHFRE
nxEd,

SXSAEU—=N—RZRDOAT (X

WindowsDi5&E

| avea—v—oyzsn—cRENT
W3 [/\— R T POED S LT 3ED H
Ul PA OV EIU Y55 %,

) EERENEAZ2—H'5 XS Memory
Card = RS54 T (X) ZZ2(ICMDAHUF
I1EFEIRT Do

3 RRCEDAT T ENTEDT ERASE
BAYE—IBERENES. A— RER
<0

MacintoshDiB&

TRAI Sy TCHBDSXSAES—H—RD7 A
dvz[d=5/El (I o743 V)ICRDY
JUET,

TP AV — EITSXSAEU—H— RDFP A T
VBB DBEEIE. MODAI T I NIAAVED
Uw I ULTLIEEW,

PIUT— 3V I NIDTI P EE

SIClE

AV a2—5—00—hIbT« RIICoUv T
ZEAE—9 358 1REF . ERO7 JUs— 3
VIO I TPESDIO—-RKRU, A VA M—
JWUTERULET, VI DT 705D >0O—

RICDWTIE, VI hDT7DForO0—RIC
DWW (183R—=) ZTELIEEW,

soix Ufcsmid, IBRDERDO T 7). 185
DI AT —CKIcH > TENMNMTVETHY
SER7JUS—3 VI RIIT P TIRE. N
SOERPT « LT MU—#EEZE, 1—T—H
BHTDHIEHL BRICRADLDIEOT
W&ERT,

[TEE]

Explorer (WindowsERig) ¥Finder (MaciRig) ZERA L
T SSSAEU—H—FROIU Y TJOOE—IREZITD
& Uy THRDBREZRF CEBLEDIEDHBOFH
ER

SV ZTVREY AT L7ZEEDICE

SV ZTREYV AT LI, AR TR U
TF—x v MR UTEREY 7 ho 77 (5l
78) MAE T

MBROER7Z U -3V I DI %
FoC. HHHMLHOVE 21— —DHDDICHR
EUEWIU v TZREFELTCHEET,
ERTDREY 7 MK TFIELLBELIE
WBENSDDET, CHEMICKEDRIC. BTE
BCERBRUIC T A=Yy MMCHINT D EZT
fEsR <2 Lo

R—5T)VANU—2
USBX T « 77zt I &

FEDOHNEB R tim F (CR—5 TIVA ML —
IPUSBAT ¢ PEEHR L TS EEF. SXS
A—RROY MMTEASNTVDEEAT ¢
FDIUw T R—=F T)VA S L—IPUSBX
T4 TICIE—TBDIENTEET,
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O SEMEERODER . OV 1—9—ToUvTZEE - REITD

1 XZa—MO0peration >USB>Select
FoldercZUwJOOE—%T # )L —%
EET D,

EEONewZEIRL T, 31ILWLWI #)LF—
EERICERT A EEBHTEFXT,

[T

TAII—ZREELEVESE, JE—9350Uv T
DRIV TOREARZ T 4 )VF—2ETB T 7

VI —DBENICERSN. Uy TIEFZEDT )b
H—COAE—NFT,

2 AZa—MD0Operation >USB >Copy to
USBZ&EIRT 2.

3 EEHSIE—NRDEIEAT 1 PHHEA

INTWLBH ROV hEEIRY Do

Media(A) to USB : X0Ow MAICHEATNT
WBEERAT 4 POIRTDI v T7%
USBXF 4 PICOE—9 D,

Media(B) to USB : XOw RBICHEASINT
WBEERAT 4 POIRTDT )y T
USBXF 4 PICOE—T D,

Media(A)(B) to USB : ROw ~A. BKU
A0 MBICHATNTWVWDEERAT «
FDIRTDI Y w TZUSBXT 1 7 (C
:Ito_a_%)o

[TER]

FB| T —5% T #ILY—EIEE LT, Media(A)(B)

to USBEBIRLIciga. 20w hADZ Uy JIS, 18

EEDT#)IAF—COAE—NFT, RO ~BDY

Uwld, U IDNESU Y JOREERE D +

W —2&E UCEEMICER SN D4 )5 —(C3

E—anxd.

4 MENUDZ#7%E L TExecute &R L.
DEHERT,

HWRDECERA T « 7DT U w THgNT
USBAT « ZICOE—ENET,

[T3ER)
IE=920UvITERALT7AIADTY Y THT
E—%7 5 LI—ICBEDBE. ZDIU Y JE3
E—aNFEEA.

M—5TIVAML—Y / USBXT «
PARDIYw TD—EFRTR

X Za—@0peration >USB >View Clip List
TIR—=F TIWA KL=/ USBXT « PTHRDY
Uy JEe—8BRRIOIENTEFT,

M= TIVASL—Y / USBXT «
PRDT )T —BDEE

XZa—®M0Operation >USB >Rename Folder
TIAINI—RZEEEFTDHENTEFRT,

| A Za1—@0peration >USB >Rename
Folderz#EiR3 5.

) EEITBI4II—EBRL. SETRY V%
Y,
T 7 A I BDANBEADERENET

3 TALI—2EAAL. BEDDoNeEER
a_%)o
T S — BB EEENET .

JE—DU—RFITvIIo—

X Za—@0peration >USB >Error Check’z
Onlcgd&. JUyTDEESAHE, U—F
FIyvIIS—Z{TDOIENTEFT,

M= TIVAML—Y / USBXT «
77 DAL

AZa2—M@O0peration >USB >Format USBC
M= TIVASU—T/ USBAT « 7 ZHHAL
(exFATC I #—X v ) T ENTEFT,

| AZa—DO0peration >USB >Format USB
ZERT D,

7 MENUDEH7%E L TExecute &R L.
DEHEHT,
ML (T4 —< v N) DEIIASNET,

3 PEHERTOA v E—IBERE NS,
BEEDOKEEING %o

M—5T)VAML—Y / USBXT «

7V DEETHER

MR—=F WAL=/ USBAT 4 PDEER
213, AZa—00peration >USBZZER U1z
EEICRRSNHEEDMedia Remaind1TIC
GBEUI CTHRRINF T,

M= TIVASL—Y / USBXT «
PANDERFHEICDOWNT

NS HIR TN S R—F TIVA RL—
USBAT 4 PADERMHEE. AZa2—D
Operation >USBDX = 1 —RE%Z1TD &~ BE)
HICREIATNE T,

fef2Ue LTFORICRIRETEXZ2—D
Operation >USBD X Z 1 —#{E%Z1T>TH.
EBREREFMEATNE B A. BREHGZRIAT
BIClF. RICRITREFRZITO TS,

NS IR

Uy TP, BER. AxBREERTY
YLRAIERR. TOF Do

VE#EH, ANU—Z2T

. TOFVERER. AR

X E— Reh

Network Client Modeh? Network Client

On ModeZOfflC g
Do

NAST I TH—EHiTH IASTEITH—
DEFZERT Do

[CFE]

o IR=FTIVASU—IPUSBAT 4 FDTUw TZSXS
H— ROy MMIHmASNTVSEEXT « 77(C3
E—93TLFTEEEA

o SRR IR FANOERMGHE. Uy TR
TEFBA, Uy TRRZInT 258(F. X 21—
MDOperation >USBDX Z 2 —#BEZH&LT LTLET
W
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98 SEBHEEDE

wse, WY AT L7Z 8T 2

AHEICHDAX S 7 H T5— CA-FB70/TX70%~ D> b LTCCU (Camera Control Unit) &#E#R 9
BDTENTEFY,

CNCRD, BROALT—F—PAXSIIRTYavyd1zy b UE—rI OV Y
bEIRE,PERYV AT LZER T D ENTEFRT,

@ CA-FB70BKUCATX70ICDVTEELLIF. ZNZNOEERSBAEE CBLRE0,

[CFE]

o AEZETDIYRTLATHEDIBA. AEICETF T4 hEEFELEVTLIIZEL,

e XAVC. MPEG HDEEERICDHMITLTWNE T,
o JOFIEER. TA 7L ALANERHBEICIFHIN U TLEREA.

Y —&D—)VDRR

VAT LEBRUCEEDY U —PI—)ILRRZERULE T,

VAT LD SDRET—Y HDVFDLEDZER VFEERAF v+ 575 —(CLDK
zN
Tally Green CADCall CALSAD REC/ GREEN @ ([ J CALL
Tally Call TALLY TALLY
LED LED
OFF OFF OFF OFF JEXKT JEXKT IR JERR IFRR
OFF OFF OFF ON =XT JEXT o IR CALL
OFF OFF ON OFF JEKT JEXKT IR IR CALL
OFF OFF ON ON =L JEXKT o eSO CALL
OFF ON OFF OFF JEXT =y Bl ® IR
OFF ON OFF ON =K =K { o CALL
OFF ON ON OFF BT =y El= N o CALL
OFF ON ON ON =vd] =ve] o ® CALL
ON OFF OFF OFF =vd] JHXT o eSS e =N
ON OFF OFF ON =14l JHXT RN KRR CALL
ON OFF ON OFF =vd] JEXKT ® eSS CALL
ON OFF ON ON B JHXKT RN RN CALL
ON ON OFF OFF =ve] =yl ® ® KRR
ON ON OFF ON JBXT =X E= N o CALL
ON ON ON OFF =ve] =ve] (] o CALL
ON ON ON ON KT =vel El=aN ® CALL
[CER]

ARXSTETE— CA-FB70/TX70%Z#ih(F. BEERRICEHLTVBEYU—FV T CKD 7 ST—LRRIFTVEE A,
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9 SEBHEEDER | BRIV AT LZEWY D

e Wi AT LB OX IR T 4 —< v S EEERIFR =2~ @0peration LTI e
Format Input/Output ~ L=¥ PDZAT L Uy—
TEENASTITY— AXTIY MO—-IVAZ Y bEERUTRE, RV AT LZERT D Frequency Rec Format Output Format JF—NXvb EF4D
BADMIN T 4 —< v b BRUBIEHRE FRICRUET . DI 28
AZa—®D0Operation NASTITI—/ HLAT—5— 23.98 XAVC- 1920X 1080P 1920X%1080i 1920X 1080 59.94i X
AXS ~O—)U DENEFIBR XAVC-L 50 1920 1080P (2-3PD)
Format Input/Output 1= MOYATL y— XAVC-L 35 1080P
Frequency Rec Format Output Format FE=T Ei'j@ HD422 50 1080P
SO = HQ 1920 1080P
59.94 XAVC-1 1920X 1080P 1920 1080i 19201080 59.94i X HD422 50 720P 1280 720P 1280X 720 59.94P %
XAVC-L 50 1920 1080P (2-3PD)
XAVC-L 35 1080P 50 XAVC-1 1920 X 1080P 1920% 1080i 1920 1080 50i X
XAVC-1 1920X 1080i 1920 1080i 1920X 1080 59.94i O XAVC-L 50 1920X 1080P
XAVC-L 50 1920 % 1080i XAVC-L 35 1080P
XAVC-L 35 1080i XAVC-1 1920X 1080i 1920% 1080i 1920 1080 50i O
XAVC-L 25 1080i XAVC-L 50 1920X 1080i
HD422 50 1080i XAVC-L 35 1080i
HQ 1920 1080i XAVC-L 25 1080i
HQ 1440X 1080i HD422 50 1080i
SP 1440 1080i HQ 1920X 1080i
XAVC- 1280 720P 1280X720P 1280X 720 59.94P O HQ 1440X% 1080i
XAVC-L 50 1280 720P SP 1440% 1080i
HD422 50 720P XAVC-1 1280X 720P 1280X720P 1280%720 50P O
HQ 1280X 720P XAVC-L 50 1280 %X 720P
29.97 XAVC-l 1920X 1080P 1920 X 1080PsF 1920%X 1080 29.97PsF? O HD422 50 720P
XAVC-L 50 1920 1080P 1920x1080 59.94i HQ 1280 720P
XAVC-L 35 1080P 25 XAVC-l 1920X 1080P 1920 1080PsF 1920% 1080 25PsF? O
HD422 50 1080P XAVC-L 50 1920 1080P 1920x1080 50i
HQ 1920 1080P XAVC-L 35 1080P
HD422 50 720P 1280X720P 1280X 720 59.94P X HD422 50 1080P
HQ 1920X 1080P
HD422 50 720P 1280%X720P 1280720 50P X

a) AASFPHTH— CATX70ERGEFPsFEREZHRELE T,

[CFR]

&R AT MBREIE TOFVEER. U1 7 U ALANERGTHEEE.

FEAEZRRICERT DL TER A

BRUORO—&TA v IE—T 3 VIEEDEFRE
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98 SEBHEEDE

NEBATIES DECER

AHEDSDI INlfFICEH UTeEs D S DSDIES 250k T 2 N CEFR T,

AASEDRDDICASESZEHSFEFT DICF. XZ1—D0peration >Input/Output
>Source SelectZzExternallCEREULER T,

[TEE]

o NWANESZ., AO—&IAVIE—YI3VE—RCRERI DI LFTEF R, AO—&TAVvIE—T 37DV
FTNHODEHFE— FZEBRLTVD EEIC, AZa—D0peration >Input/Output >Source SelectZzExternal([Z5%
ETIDE, LEDERE— NEEREINE T,

o F—hISVINSURIEEDEEEEEEEDORTHY, B /Ly I lE1— YARAIKRRPICAZ2—D
Operation >Input/Output >Source SelectZExternal [CERET D&, FRATPDRBEDS KURIELHET L. AED R
LIERREICIE D TH S AX SEZENBASICTIDIRZI F T,

o ABANDEFHRICADESHEANCEEICE, BFAMFLTDHEENDDET. AHESHEREICRD L. RIFH
ECTHERLET.

o JOFVEER. DA VLU RALANBEGEECEFMIMULTWVEEA.

NEATIEREIRES T 7 — N v b ERKEDEIFR T+ — N v
DB

HD/SD

X Z3—00peration
>Format >Rec Format®

==

X B

X Za—M0peration
>Format >Frequency®

Ean—}

X e

SAEATIDETRETS
EST5—<v b

HD/SD XZa—®MOperation XZa1—M0Operation SEBASIDVAIBETER
>Format >Rec Format® >Format >Frequency® {ES574—<w b
RE =E
HD XAVC-1 1920X 1080i 59.94 HD 1920X 1080 29.97PsF/59.94i

HD 1280720 59.94P

50 HD 19201080 25PsF/50i
HD 1280720 50P

XAVC- 1280%720P 59.94 HD 19201080 29.97PsF/59.94i

HD 1280% 720 59.94P

50 HD 19201080 25PsF/50i
HD 1280720 50P

HD XAVC-L 50 1920X 10801  59.94 HD 1920% 1080 29.97PsF/59.94i
HD 1280720 59.94P
50 HD 19201080 25PsF/50i
HD 1280x720 50P
XAVC-L 50 1280X720P  59.94 HD 1920% 1080 29.97PsF/59.94i
HD 1280Xx720 59.94P
50 HD 19201080 25PsF/50i
HD 1280%720 50P
HD422 50 1080i 59.94 HD 19201080 29.97PsF/59.94i
HD 1280720 59.94P
50 HD 19201080 25PsF/50i
HD 1280720 50P
HD422 50 720P 59.94 HD 1920X 1080 29.97PsF/59.94i
HD 1280%720 59.94P
50 HD 19201080 25PsF/50i
HD 1280x720 50P
HQ 1920% 1080i 59.94 HD 1920% 1080 29.97PsF/59.94i
HD 1280720 59.94P
50 HD 19201080 25PsF/50i
HD 1280720 50P
HQ 1440 1080i 59.94 HD 1920% 1080 29.97PsF/59.94i
HD 1280%720 59.94P
50 HD 19201080 25PsF/50i
HD 1280x720 50P
SP 1440 1080i 59.94 HD 1920X 1080 29.97PsF/59.94i
HD 1280720 59.94P
50 HD 19201080 25PsF/50i
HD 1280%720 50P
HQ 1280 % 720P 59.94 HD 1920% 1080 29.97PsF/59.94i
HD 1280X720 59.94P
50 HD 19201080 25PsF/50i
HD 1280720 50P
SD MPEG IMX 50 59.94 SD 486 59.94i
50 SD 576 50i
DVCAM 59.94 SD 486 59.94i
50 SD 576 50i
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108 RST - A&

R<T

Ea—"T7rA5 %0
J——>279%

Ny FU—HFICHT BT

}E /%\

N DR

EBRDCRTRAI U =P S5 —0XKEDSIF
IOZEBRETBICF. TOF—ZHENLIES
LYo
LyXETOFIbTANI—DoU—=20T
([ClF. AROL VX OU—F—ZHBEVKIES
LYo

[CER]

VTR EDBRIE—HEDIEN T ZE W,

#elcEHEsN L/ \y T U—imF Ny T
U=y IPACT FTEH—EDERERD) [FH
FmCdo
REPERICKI O THRFHER LD, HD D
2. HBBAVRIOEN TDFERZLEICK D
TREDNBRUEDT DL, KMEICERHMtE
SNIELEDET,

REBR R ZER LTV EHIT. EFR
RZERET D EZBBNLET . RRRICDE
FUCF VDY —ERBAEFCFESE
BEECTHHRLSIES L,

AERICHRERETAOU F O ABBDEESN
TWERT, Ea—T 745 —EHIC BackUp
Battery End” OFRRDH T SBMDTIRAINE
TIDT. VI—OU—2BHE, FFE
FEBUE(CTHERLZE,
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50—/ EZEEF5I AT

FETEFES. IR BFERSDPDERIINRZ. Ea—T7 A VI —BEEHDOX v E—IKR. SRSV TDRE. BRUESECHASTLET,
EEBOBEIFALARMDEIH CHETEE I ALARMDEHZR/NCTDE. EEBIFECALLLEDET,

To—Fmn

RORDOPERTDECESIE. AEEEEZEILEUERT,

Io5—Xyvt—3 ZEE5s WARNINGS > T ~#U—/RECSVT EBEREX R

E+I>5—3—R bE=b =1 — [=ped=p AEEDEFEDOREEN DD ET,

BRZYID. ERUTVIHEPLT —TJIVE. X7 P ICEBNEVNER LTS,
(POWERR A v F7ZOFFICU THERDMINEVEEGIF. /Ny TU—)Cy IRTFACERZNA L TLIES )
BESBRZANTCHIS NI 050, YV I—DY—ERIBHEEICTEEZE0,

EEEw

ROKXDFERTDHEIEEIE. Ay B—IHEo THERLTLEE L,

EEXyE—Y 55 WARNINGZ> T #U—/RECSVT RREREXER

AT A PHRENDTHNTT wita=) =y} U SXSAEU—H— ROEENIELIEDTVET,

Media Near Full BUORBR(CIBUTLIZE L,

AT 4 TPHRENDDOFIEA S =val EIEFU SXSAEU—H—ROEENFEVH. iz, IE— JU v TREIFTEEE A

Media Full L TLIEE L,

Ny TFU—KENDTHNTT K= SRR U Iy TU—=)Cy IDERENMELIEOTVET,

Battery Near End BURRICHEBLTZEL,
(BEa—T7A405—BEDO/N\vFU—KRROEBLET.)

Ny FU—KENSDFEA  ERE =AT SR U Iy FU—)Cy IhEFELER U,

Battery End SCIRIFTEER B A

DCINICERZDIFSH, LoTcAitFedIEL. Ny T U=y IZFTELTIEE0,
(Ea—T7A4VF—BED/I\YT U—KRRDRKLET )

EEREICHDOFLL k=1 U U REBRED LR UE Ul

Temperature High WolcABRZYID, BENTHDETERZHRIELTIZEL,
BREENMETLTLET k=1 U =y DC INEEMESZEDTWVET (&R,

Voltage Low HHeERZRESS L TIEE L,

BRBEDNTNELTVET i =KT EIREUH DCINEBEMET EET (BRBE2).

Insufficient Voltage SCERE CEF B Ao

fhDBRICERLUEL TZEL,
(Ea—T7A4VF—BED/I\YT U—KRRDRKLET )




157 108 RS R I5— EEVAT L

EEXyE—Y £255 WARNINGZ T #U—/RECSVT RRENER

Iy THA ERTY SEE =] =AT IR, SXSAEU—N—RICEFTED T U THOLRISGELE Ulc. CNUERERPOE—FTEFBAZIRL T ZETW
Clips Full

BT ) v TEoER iEoni=1 =y RO SOOI Uy TDERZETE T I DE. ST U w THOERICGELFR T,

Last Clip Recording FUWSKSXEU—A— RZCARLIEEL

Iy T ERELTY iEsni=1 =y RO SXSAEU—H— RICEFTEDEDDI U v THHMELE>TVET,

Clips Near Full BUORR(HRLTLEEW

Media(Proxy)i%27% LU $EE =1 =AU PR, JOF Y F—5EFASDA— ROBREL KW, TOFIF R ETEE A LT EEW
Media(Proxy) Full

ProxyZ U w 8D LRRTY SEE=1 =K SR JO+Y 7 —HYEEASDA— NCERRTCED IV v THO LRIGELFT Ufce TN ERRIETER B THRLTL
Clips(Proxy) Full aray

Media(Proxy)i&EHFhH iii=1 =y RO JOF VT —FRASDA— ROEREN ML L TVET,

Media(Proxy) Near Full BUgCzLTLEEW

Proxys#f&o U w Ja2exeh b= =y RO ERPOTOFY T—YDEBZET I IdE, EERAIBEET Uy THD LRIGELE T,

Last Clip(Proxy) Rec FLWLWIOFIF—FEFASDH— RECHEL T,

ProxyZ U w 78 EBRIE < iEni=1 =y FUR JOF VT —FERASDA— RICERTEDED DI U THHD L2 TVET, BURRICTTHRL T ZEW
Clips(Proxy) Near Full

Media(A)BED B EETA  BHE =v4] IR, BRSSO ERIERE R FARS

Media(A)" Full

Media(A)" 7 U v T# IR SEE =] =AT PR, BRSO iR REEFARS

Media(A)" Clips Full

Media(A)E8HOTHTT Wik =y RO EliSEwe eIz

Media(A)" Near Full

Media(A)" S#&Clipscizh b= b RO [EIRFECER e RS

Media(A)" Last Clip Rec

1) X0 RBICANcA— RDIBE(E(B)
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108 RT - = IS5—/EEYAT A

AR - SRR

BEPREBD(CROKIDIEEE - BEERERMRND CEAHDET ., COBEFRKRICHEDT

LU TLIEE L,

RTAR [RA EXER

AFAPAICIS—HRELELZ. XEU—HA— RO SDFHEULICIS—HREELRRD. B
BEZEIELR U LZERFITSNEEA.

Media(A)" Error BBECIRETDB/AICIF. IE—FERMBHEELT, XEU—
Playback Halted H—RZETHUTLIEE L,

ESANANEE

[RAE IR

CON\y T U—(FERATEX A

|UTLEEW
Battery Error
Please Change Battery

Ny T U=\ TICEBDRESNE Ul
EBFENNy T U=y TICHRUTLLIES Y,

XF 4 PAICIS—HFRELE LR
Media(A)" Error

XEU—N—RICEBEE LS. R TEETEA.
SEEICTREDHZEICIE. XEU—N—RZEHU T EE0,

Ny oF7y TEMEEDSDFEA

LT FEEW
Backup Battery End
Please Change

Ny OFy TEBDEKEDRNELTNET,
Ny Ty TEMESIRL T EEW,

BRI AT 4 7HEASINE L
XF 4P A FFEETETEA
Different Media is Inserted
Cannot Use Media(A)"

EHDEEDH— R EASNE Uz, BDSEALIH—
RZERICEAUA— REBUBEEDH— RICBUTL
YA

XF 4 P (A FERTEELA
L TLIEEW

Unknown Media(A)"”

Please Change

« N=FT=I3VPISNTVBDAXEY—H—RP, KT
WADO U THEBR CEEBREINcXEU—H—RhE
ATNF U

o T7AIYAT LD FATOEE(CSXSH— RZEHBALFL
fco

o 7AWV AT LhexFATERZ(FUDFD EE(CSDHC —
RZEEALE U

AETIHERATEFEADT. TRLTL SO,

ATFATFIS—DRELFE LR
AF 4 P (A IFHEEDNETT
Media Error

Media(A)" Needs to be Restored

AEU—H—RICEBDPREEL. BEDNUNELIREICHEDF
LTz,

AEU—H—RFZE—ERVTHhSBEALT. 1—rDEE
T2 C<LfEE L,

AFATPIS—DREELE U
XF 4 P (AL TEFTBA
Media Error

Cannot Record to Media(A)"

XEU—N—PHELT. RN TEFLEDH U

BEEFTREETCIDT, JE—ZWMDFEELT, HTULXAEY—

H—RICHT D EZHBHLET,

XF4 TP IT—DFEELFLEE
XF 4 P (A FERTEZBA
Media Error

Cannot Use Media(A)"

XEU—N—FHEL CEREBED TERLED T LI

T CTFRAFEADT, fDOHN— RITSHRLTLES L,

AF 4 PN FERTEF LA
T7AIY AT LAREEDET
Cannot Use Media(A)"
Unsupported File System

T7AINYRT LDEEDH— REIEE T+ —~X v bEnT
WEWH— RBMEASNE LT,
FHECTIFERTEFTBADT, BECEFETT+—Y Y
PUTLEE,

1) A0 RBICANZI— RDBE(E(B)
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NE Iz

BIEFICRTREINDA A v E—Y

REV AA VT, DEHFEZEREUCEEICRTSINDX Yy BE—I EZDREZLUTITRUE T,

[CFRE]

o BIEEHERRD—HUCEEICRRSNDA Y E—IREDZEZH LU TVE T,
o AZ2—TREMBERTETEVIRE (JL—7 D MARE) TRIFET O EEICKRRENBD X v E—IJRBEH L TLF A,

B{F

AXyt—v

Xy E—IDEK FHEER

RECRYVZERUIcEE

Media not exist

SXSA— ROy MMIETAT « PHHEAS N CVEVHERNTERL),

Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

TJOFF—FEHE— REONICEESNTVSH. TOFVEFASDA— FEASNTLIRW e 7O+ T —
T HEER CEF L

Media(Proxy)
Cannot Record
Media(Proxy) Error

TOFVEFRASDN— FOXT 4 PEBICKDETAHND TERVcH TOFI T —I DR TEEL,

Media(Proxy)
Cannot Record
Media(Proxy): Write Protected

TJOFVERASDA— ROEEAHRLEDcH TOF 2 F—F HECiR CEIFL .

Media(Proxy)
Cannot Record
NG: Preparing

JO#F 27— YR OO 7RO TOF Y F—I DR CEEL,

Proxy Rec Start/StopZzgIlD BT re 77U

Media(Proxy)

TJOFVERASDA— FAMEA SN TULIEW e TOF T —IDEER TEF L,

TIVAA v FERBIELIEEE Cannot Record
No Media in Slot(Proxy)
Media(Proxy) TOF+VEEASDA— ROAT 4 PEBICKDEETAHFND TELVcH TOF T —F DR TETEL,
Cannot Record
Media(Proxy) Error
Media(Proxy) JOF+VEEASDA— FOESAHFRLEDIH TOF Y T—I DI C T,
Cannot Record
Media(Proxy): Write Protected
Media(Proxy) JOF Y F—Y RO T TRIDCSH TOF T T —I DRI CERL,
Cannot Record
NG: Preparing
PREVIRZ VZfLfc & T First Clip Top! BARBMBENTEI Uy TDEET U—AICHDHRITTELL,
FREVRZ V=L EE First Clip Top! BERIBAIENEES U Y TDFEET U — AICHBDIcHEITTER.
PREV+F REVIRZ >V ZH UTc & & First Clip Top! BERIBAIBNEES U Y TDFEET U—AICHBDIcHEITTERL,
PLAYRS V&R Ufc & & Last Clip End! BERBUBNIREI U Y TORIE T U—LICHDHRITTELL,
NEXTRE V7 Lfc&E Last Clip End! BERIBAUBNIREI U Y TORE T U—AICHBDIcHEITTERL,
FFWDRE Y ZUTcEE Last Clip End! BERBUBENRIEI U Y TORIE T U—ALICHBDIHRITTELL,

NEXT+F FWDINY 7= Ufc & &

Last Clip End!

BERBUBNRET ) v TORK T U—LICHDICHRT TEFL,
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NE (08 BERICRRINS X vE—Y

BRIE Ayt— Xy —IDRk/ REER
AF 4 P20V MIDBRIRELEE Cannot Switch Slots BAEROcHRAOY hZYIDEZ TERL,
EERAT 4 PEIRVEE Media removed SR A T 4 P DA EEEET (ACCESS T TrkIH) [C AT o« P HRD N,
GAINZAA wFZYIDBEZ LT Gain: xxdB TAVDERENEE(ICHE DI,
(TxxJ (&, &4 1E)
DCCRA wFZEBRIELTCEE DCC:On DCCAONITHE DT,

DCC.Off

DCCHOffICiE o1z,

Fixed By Hyper Gamma'!

Gamma Categoryh' HGEF fzldUserlCERESNTWLIDTcsHDCCZONICTERLY,

ROA NSV ARA wFERIELEEE

White: Preset xxxxK
(Txxxx] (FEEEME)

RO A NSV A D PresetDEICEE N/,

White: A xxxxK
(Txxxx] (FEEEE)

ROA MG VABAXEY —DIEICEE SN/,

White: B xxxxK
(Txxxx] (FEREE)

ROA SIS VADBAEY—DEICEEENT,

White: ATW xxxxK
(Txxxx] I EEEME)

ROA NSV RAE—RPATWICEE SN,

SHUTTERR A wF =D BR e &E

Shutter: 1/xxxx
(TxxxxJ [F2 v 5 —18)

Uy —RAE— RHED oz (%, Speed®— RERERD,

Shutter: xxx
(TxxxxJ (3> v w5 —18)

Yy v I—AE— R Z DO (B2, Angle®— FERERD).

ECS: xxxxHz T vI—AE—RhED >z (ECSE— R,
(Txxxx ] (FEIRED
AZa—DFHEELIEE ECS: xxxxHz T vI—AE—RHhZED >z (ECSE—RE),

(Txxxx ] (FEIRED

Iris Override: +x.xx
(Txxxx] (FEfE)

TPAURF—=I\—=54 REDED DI,

FT—hISVIRA v TFERIELICEE

Color Bars No—I\—ESZHILTVDIcHERITTERL,
Cannot Proceed

Test Saw TAMEBZEIUTVDIZHEITTELL,
Cannot Proceed

Not Available ECERAPDICHRITTELEL,

Recording

Not Available BAERDICHRITTEEL,

Playing back

Not Available Y LRAIVRRPDICHERITTEIR L,

Displaying Thumbnails
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NE (08 BERICRRINS X vE—Y

BRIE Ayt— Xy —IDRk/ REER
F—bROA MRAvFEBRIELUEE Color Bars No—I\—ESZHILUTVDEHERITTERL,
Cannot Proceed
Not Available BARDIEHRITTELL,
Playing back
Not Available B LARAIVRRPDIEHETTERL,

Displaying Thumbnails

White Balance Preset

ROA NSV XD PresetlBEIE CHBDTEHFRITTEFL .

ATW Hold#geZ&Ib X Tl 7Y A4+ JJILA ATW Hold ATWODHold#gEDBMICIE DT,
AVFERELICCE ATW Hold Off ATWODHoldBEEEDRER 15 D 120
Clip Continuous RecZz&IDZH Tz 7 Cannot Proceed SCERFRDICHRITTEE L
TIVAA v FZBELICEE Recording

Cannot Proceed

ARXSTETEH— CA-FB70/TX70 ECCUNERIS N TV B EHRT TEF L,

Picture Cache RecZEIDH TP U A7
JWAA W FZEELUES

Cannot Proceed
Recording

SCERADICHIRITTETIRL

Cannot Proceed

ROV TNDDEEC & DETFTERL,
. FE

. YLZA)LERTH

o ARXTFEITE— CA-FB70/TX70EECCUREREINTLD

StreamingZEID BT 7Y AT TILAA v
FEBRIELICEE

Cannot Proceed
Network Client Mode Setting is "On"

Ry NI=005A4 72 bE— DB THDICHRITTEL L,

Cannot Proceed
Network Function is Disabled

v bD—UEERENOf CHDIcHRITTEF,

Cannot Proceed
Network Client Mode Setting is "On"
Network Function is Disabled

XY RI=005A4F2 bE—REONEESNTVDH, %Y hI—IFKEF CTHDICHIRITTELEL,

Cannot Start Streaming
Streaming Disabled Temporarily

BIFDOWITND DRHICKDERITTERL,

- JOFVTF—5BLEH

« ECER 4N MEREN1920X 1080DEE(IT1280X 7200 U w T B4H
« BB 7 —Nw hEREN1280X 720D EE(C1920X 10807 U w T =B

Cannot Start Streaming
Please stop Recording or Playback

DAV AKBEREEPICEER - BE (TARAIIERTRZSD) ZRIBUICIcOFRITTEFL,
iR - BE (WARAIKRTZSD) ZFIETDERITCTED.
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NE (08 BERICRRINS X vE—Y

B{E

AXyt—Y

Xy E—IDEK FHEER

Ry ND—=0 0547 hE— REMIIC
StreamingZEID B TP YA FTIVAA v

FEBRELIeEE

Cannot Proceed
Streaming Setting is "On"

A MU= THRDIcHRETEE L,

Cannot Connect to CCM
Network Function is Disabled

v hI—TKE ChdlcsHConnection Control ManagerlCHE#T CEEL.

Cannot Record Proxy

X~ a—MMaintenance >Network Client Mode >Preset 1. Preset 2. F/fcl&Preset 3OONCM with Proxyht
DisablelCRESN TS e, TOFV T —FEiBiadBREZ U THRINTEHL,

Proxy Recoding will be Stopped

X~ a—MMaintenance >Network Client Mode >Preset 1. Preset 2. &7fcldPreset 3OONCM with ProxyHt
DisablelCERESN TS e, TOFVTF—FEHEMELT Do

Cannot Connect to CCM
Cannot Record Proxy

. Ry MI=TKRER ChdTcshConnection Control ManagerTHEHE CTEEL,
- XZa—MMaintenance >Network Client Mode >Preset 1. Preset 2. F/cl&Preset 3NCM with Proxyht
DisablelCRESNTWVD e, TOF VT —FERBIADERIEZ U THERIMCTTEL,

Cannot Connect to CCM
Proxy Recoding will be Stopped

- Ry NI—=IKER CHdTzshConnection Control Manager|CEFT CTELEL,
« XZa—@Maintenance >Network Client Mode >Preset 1. Preset 2. FfcldPreset 3NCM with Proxyht
DisablelCBREINTWVDIed. TOFVTF—YERDMEIET D,

Cannot Connect to CCM
Invalid User Name or Password

Connection Control Manager®sRsEM T 5 —I[C/E DT,

Cannot Connect to CCM
Invalid Address or Port Number

Connection Control Manager®7”” KL R, KIzldm— I /\—DFREBELDH. Connection Control
ManagerlZ##t CEIFLY,

Auto Upload(Proxy)Z&IDH Tl 7 A4+

WAAyFRBIELIEEE

Cannot Proceed
Network Function is Disabled

JOF T —FEiREE. BROTA VU AKREREOEEST TRIDICHEITTEF.

ONLINERY VZRIB URIELTe & E

Cannot Proceed

DAV AKEEREOEENEBR . FCFBEBRIIERRDICHEITTELEL.

ZebraZB|D MU TP AFTIVAA v F%&  Zebra:On TIIH0OnlliEofe,
BIELCEE, FEdE2—T7A4V5—D  z0pra: Off B ISHOfICE ST,
ZEBRAZRA wFZYIDBER fcEE

Ea1—TJ7 A5 —DZEBRARA v FZIRIE  Zebra:On TISHOnICHE o1
Lic&&E Zebra: Off BISHOfICE Tz,
MakerZZIDETle 7 YA FTILAAwvF%Z Marker: On JY—H—H0OnllEofe,
BfELICEE Marker: Off Y —"—HOfCHE S Tz,

Video Signal Monitorz&lb Z Tl 7 Y4

TIVAA v FERIEUTCEE

Cannot Proceed

LIFOWFNDDRAICKDEITTERL,
« AZa—®MO0peration >Input/OutputdSDI Out1 Select&SDI Out2 Selecthlizg & BOFFICEETE
« XZa—@O0peration >Input/Output®Output Formatht. 720x480P&Tcld. 720x576PICERE

OUTPUTRA v F7%ZBARSE (H5—/\—%F

TONRIELfCEE

Not Available
S&Q Motion: On

SERQE—Y 3 VERE— FOERRDCHRRTELEL,

FIFIWIORTVI—=ZEIDHETIe7T+  Cannot Proceed

FIOWRA v FERELIcEE

UTFDOWTNHODRHEICRIDFITTELE L,
- BEF

« ULRA)ERTRH

- SBEBASIIRRE

« AS—IN\—PTFTRAMESZLIH
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NE (08 BERICRRINS X vE—Y

B{E

AXyt—Y

Xy E—IDEK FHEER

NDZT 4 LT —ZIDBR LT

2: 1/4ND xxxxK
(2: 1/4NDJ IENDFESE. Txxxx] (FEEEE)

NDZT 4 )LF—DWIb&E b o1z,

ND:3 CC: x xxxxK
(IND:3JIFEIFNTWAND T « )L5 —FEfE.

[CCx xxxxK/ [FRBENTVWDCCT A ILT—&

B ESREEIRE(T o R DEREE)

ND Filter CTemphOffC. WIFNHDF A FTILRAA v F(CElectrical CCZEID ZHTITRRETND T « LY —H4])

bEDOTC,

Color Temp SW 3200KZEID HTle 7T A
FIIWAA v FERELICEE

Color Temp SW 3200K

Color Temp SW 3200KDEMICIE DTz,

Cannot Proceed
ND Filter CTemp:On

ND Filter CTemph'OnDfcbZEE TEIEL),

Color Temp SW 4300KZ&ID 1Tl 77U A
FIIWAA wFZRIELICEE

Color Temp SW 4300K

Color Temp SW 4300KHhERHICIE DTz,

Cannot Proceed
ND Filter CTemp:On

ND Filter CTemphiOnDicshZEE TELEL.

Color Temp SW 5600KZ&ID H Tl 77U A
FIOWRA v FERIEUTCEE

Color Temp SW 5600K

Color Temp SW 5600KBMEZIICTE DT,

Cannot Proceed
ND Filter CTemp:On

ND Filter CTemph\OnDcshZEE TEMEL,

Color Temp SW 6300KZEID H Tl 7oA
FIIWAA v FEBEELUICEE

Color Temp SW 6300K

Color Temp SW 6300Kh"BRICIE D feo

Cannot Proceed
ND Filter CTemp:On

ND Filter CTemph'OnDfcHZEE TEIEL,

Electrical CCZEIDHTe7 YA+ TILA
A VFEBIELICEE

ND:3 CC: x xxxxK

(IND:3JIFEIRSNTWLBND T « )L —FEFE.
[CCx xxxxK] [FBIRETNTVDCCT A ILT—

CEBIBRERRZT O CROEEREE)

Electrical CCT v JLZ—DWID&D o1,

Cannot Proceed

ND Filter CTemphOnDIcshZEE TEMEL,

CC5600KZEIDHTIe 7 YA T TIVAA v F
ERIELICEE

CC 5600K

5600KICERES NIz,

Cannot Proceed

BIROWFNDDREICRIDRITTEF
« ND Filter CTempHiOn

« WIFNHDF7TAFTIVAA v F(CElectrical CCEEID HTTHBD N

Electrical CCIC5600KZE D HTTULEL,

Shot Mark1ZBID B TIe P YA FTIVAA v
FEBRIELICEE

Shot Mark1
(Planning Metadata@RARsE. FESFI)

Y3y =710 MmE NI

Cannot Record Essence Mark
Reached Essence Mark Limit

Ty VAN =8O LRITEL TV EOAITTERL,

Cannot Proceed

LIFUJL\_Q“HD‘(Dx{ﬁFI«.d: DAINTEE,

Uy THERENTNDAT 4 PICEESAHELEREDERTE

- E9Fv—FvvTalwvI#EENON

« A=)y TECiEH

« AFATHESAHFELITHEOTWVD

« WRT U W THSDA— RICEHFESINTLD

TAHTEF
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NE (08 BERICRRINS X vE—Y

B{E

AXyt—Y

Xy E—IDEK FHEER

Shot Mark2ZEID X Tle 7 U A+ TIVAA v
FEBRELUCETE

Shot Mark2
(Planning Metadata#@fBs(F. EEXF5)

Y3y bY—202bME NI,

Cannot Record Essence Mark
Reached Essence Mark Limit

Ty RVAR—IHDLRIGELTVDIZHRITTEL L,

Cannot Proceed

UTROWTNHODRHEICRID MM TEE L,

« DU YTBRHBRENTVDAT « P ICETRAHRIEEEDERTEEAH TEEL
s E9Fv—FvyvTal v IHEENON

. AVF=)NLL Y JECERH

« XTATHEERHRLECIEDOTND

« WRIU Y ITHSDA— RICEETRSN TS

Clip Flag OKZBID H Tz 7 YA FTIVR
AVFERELICEE

OK Clip Flag

oUw T TSI (OKY—2) BMImE e,

Delete Clip Flag

Uy T TS50 (OKNY—2) BHBRENTC(AA v F2ERURIELICEE),

Cannot Proceed

UTFDOWTNHDRHEICRIDFRITTELEN
o AT THETAHFRLICEOTND
« WRIU v ITHSDA— RITERFESNTLD

Clip Flag NGEEID 4TIz 7B+ F )L R
AU FRBEUEE

NG Clip Flag

oUw T TSI (NGIY—2) bMtnEnsc,

Delete Clip Flag

oUwTTS5T (INGY—2) BHIBRE N (RA v TF2ERUBRELIZEE),

Cannot Proceed

PUFOWTNHADRHICKDRITTELREN
¢ AT THETIAHRILEICEOTVD
« WRIU Y ITHSDA— RICERTRSN TS

Clip Flag KeepZ&I0 4TIz 7 YA F TIL R
Ay FERMELIEE

KEEP Clip Flag

oUw T TS50 (KEEPY—2) DS Nsc,

Delete Clip Flag

Uy T TS0 (KEEPN—2) BBIBRS NI (RA v F 2B UBRIELIE &),

Cannot Proceed

UFDOWTNHDRHEICRIDFRITTELEN
o AT THETAHRILEICEOTVD
« WRIYU v ITHSDA— RITERFESNTLD

Flash Band ReduceZEID E Tl /A7
JWAA W FERELEES

Flash Band Reduce: On

Flash Band Reduceh*Onlc#E o1z,

Flash Band Reduce: Off

Flash Band Reduceh*OfflCix o7z,

SLOT SELECTIRY VZBRIELTC & E

Switched Slot

BRI DEIEAT « PO ED O,

2O—&TA W IE—Y 3 VISR UKL
SCER T 4 —~w RERTET. Slow & Quick
MotionZZIbH e P U A FJILiks %=
BELUREE

Cannot Proceed
S&Q Unsupported Rec Format

Slow & Quick MotionZH R U TWEWT # —~ v hDfcHHRITTEEL,
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IR E
n — —
d1—Y —>7—FI[RZREFEENDIE
KNG 158 e REFTEI7AI
O REFTD Scene Reference Lens
O*  fRf7 9 % (Clear All PresetldF®544) Input/Output  Output Format X X X

X RELEL
—  REFEULEWV (—REHEXZ1—)
Default : U 7 UV AT 7 A )VICIFREFESNIEWVWIEBR T D, XZa1—DFile >Reference#3={T

Source Select

SDI Out1 Output

SDI Out2 Output

All

O
O X X X
O X X X
O X X X
TEHEAZ2—DYIHIEE LTIV Y REICHREFSINE T, HDMI Output O X X X
— SDI'Out2/HDMI Super O X X X
US@I’)(—:L Video Out Super O X X X
Down Converter O X X X
I8H s RIFEIT7 A Wide ID O X X X
All Scene Reference Lens Wide Mode(Ext.) O X X X
Edit User Menu  — O X X X Super Impose  Super(VF Display) @) X X X
Super(Menu) O X X X
Super(Marker) O X X X
Operationx:l_ LCD LCD Color O X X X
LCD Marker&Zebra O X X X
Rec Function Slow & Quick Motion O X X X
1HH e RFFXIT7AI Frame Rate 0O x % x
All Scene Reference Lens Clip Continuous Rec 0O % % x
Format Frequency o x X x Picture Cache Rec O X X X
File System o x X X Cache Rec Time O X X X
Rec Format O X X x Interval Rec X X X X
Aspect Ratio (SD) O X X X Number of Frames O X X X
Audio Length (IMX) O X X X Interval Time O % % X
Base Setting Shooting Mode O X X X Pre-Lighting O % % %
HDR Setting HD Rec/Out - - - - Simul Rec 0 % X X
Color Space - - - — Proxy Setting O* X X X
Format Media  Media(A) - - - - Recording Size O* % % ™
Media(B) — - ~ _ Mode Frame Rate - - - -
SD Card(Utility) - - - - Bit Rate _ _ _ _

(

SD Card(Proxy) - - - -

Audio Channel

O*

X

X

X
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User Box H Position

User Box V Position

Timecode

Audio Level Meter

Media Status

I8H fHE REERI7AI I8H e REFET 7 A

All Scene Reference Lens All Scene Reference Lens

Assignable <0> O X X X Gain Switch Gain<L> O X X X

Switch <> @) X X X Gain<M> O X X X

<2> O X X X Gain<H> O X X X

<3> O X X X Gain <Turbo> O X X X

<4> O X X X Shockless Gain O X X X

<5> O X X X Auto Iris Iris Override O X X X

Lens RET O X X X Mode O X X X

Online O X X X Level O X X X

Zoom Speed O X X X Speed O X X X

VF Setting Color O X X X Clip High light O X X X

Color Mode O X X X Detect Window O X X X

Peaking Type O X X X Detect Window Indication X X X X

Peaking Frequency O X X X Iris APL Ratio O X X X

Peaking Color O X X X Iris Var Width O X X X

VF Detail Level O X X X Iris Var Height O X X X

Marker Setting O X X X Iris Var H Position O X X X

Color O X X X Iris Var V Position O X X X

Center Marker O X X X Zebra Zebra Select O X X X

Safety Zone ©) X X X Zebral Level O X X X

Safety Area ©) X X X Zebral Aperture Level O X X X

Aspect Marker O X X X Zebra2 Level O X X X

Aspect Select O X X X Display On/Off  Video Level Warning O X X X

Aspect Mask O X X X Shutter Setting O X X X

Aspect Safety Zone O X X X ND Filter Position O X X X

Aspect Safety Area O X X X Gain Setting O X X X

100% Marker O X X X Rec/Play Status O X X X

User Box O X X X Color Temp. O X X X

User Box Width O X X X Frame Rate/Interval O X X X

User Box Height O X X X Battery Remain O X X X

@) X X X O X X X

@) X X X O X X X

O X X X

O X X X

SD Card(Utility)
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1HE HHE RIFFEIT7 A 18H HHE REEIT7AI
All Scene Reference Lens All Scene Reference Lens

Display On/Off  Focus Position O X X X White Setting ~ White Switch <B> O X X X
Iris Position O X X X Shockless White O X X X
Zoom Position O X X X ATW Speed O X X X
Extender O X X X ATW Mode O X X X
ALAC O X X X AWB Fixed Area O X X X
AE Mode O X X X Filter White Memory O X X X
Focus Mode O X X X Offset White Offset White <A> O X X X
White Balance Mode O X X X Warm Cool <A> O X X X
CC5600K O X X X Warm Cool Balance<A> O X X X
Rec Format O X X X Offset White <B> O X X X
Gamma O X X X Warm Cool <B> O X X X
Timecode Lock O X X X Warm Cool Balance<B> O X X X
Network Condition O X X X Shutter Mode O O X X
Proxy Status O X X X Slow Shutter Setting O O X X
NW Client Mode Status O X X X Number of Frames O O X X
Streaming Status O X X X Time Zone Time Zone O X X X
GPS O X X X Clip Clip Naming O X X X
Video Signal Monitor O X X X Title Prefix O X X X
Clip Name O X X X Number Set X X X X
Focus Assist Indicator O X X X Update Media  Media(A) - - - -

Focus Area Marker O X X X Media(B) - - -
Lens Info O X X X GPS GPS O X X X
WRR RF Level O X X X Planning Load Media(A) - - - -
Clip Number @) X X X Metadata Load Media(B) - - - -
"I"LED Gain <!> O X X X Properties - - - -
Shutter <!> O X X X Clear Memory - - - -
White Preset <I> O X X X Clip Name Disp O X X X
ATW Run <!> O X X X USB Select Folder - - - -
Extender <!> O X X X View Clip List - - - -
Filter <I> O X X X Rename Folder - - - -
Iris Override <!> O X X X Error Check O X X X
Format USB - - - -
Copy to USB - - - -

Media Remain
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15H e REFEFXI7AI 158 e REEIT7AI
All Scene Reference Lens All Scene Reference Lens
Flash Band Setting X X X X Flare Setting O O Default X
Reduce Master Flare O O O X
R Flare O O O X
G Flare O O O X
Pa|nt><:1_ B Flare O O O X
Gamma(HDR)  Gamma Select X X X X
= = ==y Gamma Setting O O Default X
- " Step Gamma O O O X
All Scene Reference Lens Master Gamma o o o X
Switch Status ~ Gamma O O Default X R Gamma o o O X
Black Gamma O O O X G Gamma o o O <
Matrix O O O X B Gamma O O O »
Knee © © © x Gamma Category O O O X
\/\/hit-e Clip X & X x Gamma Select O O ) x
Detall © © Default x Black Gamma  Setting O O O X
Aperture O O Default X Range o o o X
Flare O © Default x Master Black Gamma O O O X
DR Pa Lel_s(; IS_avvk 8 g é i Knee Setting O O O x
SGUWS " HDR Bole?ck Offset O O O X oint = = = .
Slope O O O X
HDR Knee © © © x Knee Saturation O O O X
HDR Knee Point © © © X Knee Saturation Level O O O X
HDR Knee Slope © © © X White Clip Setting X O X X
White Color Temp <A> O O O X Level o o O »
Color Temp Balance <A> O O O X
R Gain <A> O O O X
B Gain <A> O O O X
Color Temp <B> O O O X
Color Temp Balance <B> O O O X
R Gain <B> O O O X
B Gain <B> O O O X
Black Master Black O O O X
R Black O O O X
B Black O O O X
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1HE HHE RIFFEIT7 A 158 e REEIT7AI
All Scene Reference Lens All Scene Reference Lens
Detail(HD) Setting O O Default X Skin Detail Setting O O O X
Level O O O X Area Detection - - - -
H/V Ratio O O O X Area Indication X X X X
Crispening O O O X Level O O O X
Level Depend O O O X Saturation O O O X
Level Depend Level O O O X Hue O O O X
Frequency O O O X Width O O O X
Knee Aperture O O O X Matrix Setting O O O X
Knee Aperture Level O O O X Adaptive Matrix O O O X
Limit O O O X Preset Matrix O O O X
White Limit O O O X Preset Select O O O X
Black Limit O O O X User Matrix O O O X
V Black Limit O O O X Level O O O X
V Detail Creation O O O X Phase O O O X
Detail (SD) Setting O O Default X User Matrix R-G O O O X
Level O O O X User Matrix R-B O O O X
H/V Ratio O O O X User Matrix G-R O O O X
Crispening O O O X User Matrix G-B O O O X
Level Depend O O O X User Matrix B-R O O O X
Level Depend Level O O O X User Matrix B-G O O O X
Frequency O O O X Multi Matrix Setting O O O X
Knee Aperture O O O X Area Indication X X X X
Knee Aperture Level O O O X Color Detection - - - -
Limit O O O X Reset - - - -
White Limit O O O X Axis X X X X
Black Limit O O O X Hue O O O X
V Black Limit O O O X Saturation O O O X
V Detail Creation O O O X V Modulation  Setting O X Default X
Cross Color Suppress O O O X Master V Modulation O O Default X
Aperture Setting O O Default X RV Modulation O O Default X
Level O O O X GV Modulation O O Default X
BV Modulation O O Default X
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158 e REFRT7A) 158 e REFET 7 A
All Scene Reference Lens All Scene Reference Lens
Low Key Setting O O O X Copy Clip Select Clip - - - -
Saturation Level @) O @) X All Clips - - - -
Range O O O X Delete Clip Select Clip - - - -
Saturation Saturation Mode O @) O X All Clips - - - -
Mode Knee Saturation O @) @) X Transfer Clip Select Clip - - - -
Black Gamma @) @) O X All Clips - - - -
Low Key Saturation O O O X Transfer Select Clip - - - -
Noise Setting @) @) O X Clip(Proxy) All Clips - - - -
suppression  |evel O O O X Filter Clips OK - - - -
NG - - - -
KEEP - - - -
ThumbnailX =2 — . MNome - ~ } -
Customize View Thumbnail Caption O O X X
128 e RERXI7AI
All Scene Reference Lens . —
ST - - - — Maintenance X1 —
Properties
S_et Index - - - - - JI=[=] e REFLT7AIU
Picture ' _ Al Scene  Reference Lens
yliwe%\/mbnall Eslisence MarkThumbnaH : : : : White Shading ~ Channel Select O X Default X
p Thumbnail White H Saw X X X X
Set Shot Mark  Add Shot Mark - - - - White H Para < x < %
Delete Shot Mark1 - - - - White V Saw « % X X
Add Shot Mark2 - - - - White V Para « % X X
Delete Shot Mark2 - - - - White Saw/Para O X Default X
SetClipFlag ~ Add OK ~ _ _ - Black Shading ~ Channel Select O X Default X
Add NG - - ~ _ Black H Saw X X X X
Add KEEP - — ~ — Black H Para X X X X
Delete C!ip Flag - - - - Black V Saw « % % X
E(ﬁ;k/Unlock Select Cl|p : : : : BlackV Para % % X X
Lock All Clips Black Saw/Para O X Default X
Unlock All Clips ~ - - — Master Black O O O X

Master Gain (TMP)
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CH4 Wind Filter

1kHz Tone on Color Bars

MIC CH1 Level

I8H fHE REERI7AI I8H e REFET 7 A
All Scene Reference Lens All Scene Reference Lens
Battery Near End:Info Battery O X X X Audio Rear1/WRR Level O X X X
End:Info Battery O X X X Rear2/WRR Level O X X X
Near End:Sony Battery O X X X Audio CH3 Level O X X X
End:Sony Battery O X X X Audio CH4 Level O X X X
Near End:Other Battery O X X X WRR Setting WRR Valid CH Sel O X X X
End:Other Battery O X X X WRR CH Select X X X X
Detected Battery - - - - WRR Delay Comp O X X X
DC Voltage DC Low Voltage1 O X X X TX - - - -
Alarm DC Low Voltage2 O X X X TX Audio Peak - - — -
Audio Front MIC Select O X X X TX Input Level — — — -
Rear XLR Auto O X X X TX ATT Level - - - -
Front MIC CH1 Ref O X X X TX LCF Frequency - - - -
Front MIC CH2 Ref O X X X TX System Delay O X X X
Rear MIC CH1 Ref O X X X TX RF Power - - - -
Rear MIC CH2 Ref O X X X TX Power Save - - - -
Line Input Ref O X X X TX-Cam Power Sync O X X X
Min Alarm Volume O X X X Timecode TC Out O X X X
Speaker Attenuate O X X X DF/NDF O X X X
Headphone Out O X X X LTC UBIT O X X X
Reference Level O X X X Counter Display O X X X
Reference Out O X X X Essence Mark  Find Mode O X X X
CH1&2 AGC Mode O X X X Camera Config  HD SDI Remote I/F O X X X
CH38&4 AGC Mode O X X X Color Bars Select O X X X
AGC Spec O X X X User Menu Only O X X X
Limiter Mode O X X X User Menu with Lock X X X X
Output Limiter O X X X RM Common Memory O X X X
CH1 Wind Filter O X X X RM Rec Start O X X X
CH2 Wind Filter O X X X SET Key on Thumbnail O X X X
CH3 Wind Filter O X X X ALAC O X X X
O X X X
O X X X
O X X X
O X X X

MIC CH2 Level
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15H e REFEFXI7AI 158 e REEIT7AI
All Scene Reference Lens All Scene Reference Lens
Preset White Color Temp <P> O X X X Network Setting o* X X X
CTemp BAL <P> O X X X Wi-Fi Mode o* X X X
R Gain <P> O X X X NFC - - - -
B Gain <P> O X X X WPS - - - -
AWB Enable <P> X X X X Channel o* X X X
White Filter ND Filter CTemp O X X X SSID & Password - - - -
ND FLT CTemp<1> O X X X SSID - - - -
ND FLT CTemp<2-4> O X X X Wi-Fi Scan - - - -
Flectrical CC<A> O X X X Station  Networks
Electrical CC<B> O x X x ?;tt?!gs 5SID X X X X
Electrical CC<C> O X X X Password X X X X
Electrical CC<D> O X X X DHCP o* X X X
DCC Adjust DCC Function Select O X X X IP Address o* X X X
DCC D Range O X X X Subnet Mask o X X X
DCC Point O X X X Gateway o* X X X
DCC Gain O X X X DNS Auto o* X X X
DCC Delay Time O X X X Primary DNS o* X X X
DCC Peak Filter O x X x server
Flicker Reduce  Mode O X X X Secondary o* x x %
DNS Server
Frequency © x x X Device Name (Wi-Fi) - - - -
Genlock Genlock O X X X IP Address (Wi-Fi) — — — —
, Reference - - . - Subnet Mask (Wi-Fi) - - - -
Auto Shading  Auto Black Shading - - - - MAC Address (Wi-Fi) — — — —
Reset Black Shading - - - -
- Regenerate Password - - - -
Master Gain (TMP) - - - - Modem O > X X
APR APR — — — — Wired LAN O* X X X
Reset Wired LAN Remote Oo* X X X
Basic User Name X X X X
Authentication  password x x X x
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I8H fHE REERI7AI 158 e REEIT7AI
All Scene Reference Lens All Scene Reference Lens
Network Wired DHCP o* X X X Streaming Setting X X X X
LAN IP Address o* X X X Preset Select o* X X X
SDeetttairlwlgs Subnet Mask o* X X X Presetl  Size o* X X X
Gateway o* X X X Bit Rate o* X X X
DNS Auto o* X X X Type o* X X X
Primary DNS o* X X X Destination o* X X X
Server Address
Secondary DNS o X X X Destination o X X X
Server Port
Network Client  Setting o* X X X Preset2 Preset 1&EBEU
Mode Preset Select o* X X X Preset3 Preset 1B U
Preset 1 Display Name o* X X X Audio Channel o* X X X
CCM Address o* X X X Clock Set Date Mode O X X X
CCM Port Oo* X X X 12H/24H O X X X
User Name X X X X Date — — — _
Password X X X X Time - — _ _
NCM with Proxy o* X X X Language Select O X X X
Camera Control o* X X X Hours Meter Hours (System) - - - -
Camera Setting X X X X Hours (Reset) - - - -
Preset 2 Preset 1£EU Reset - - - -
Preset 3 Preset 1£EU Network Reset  Reset - - - -
File Transfer File Transfer - - - - Fan Control Setting O X X X
Remote File Transfer o* X X X VF Display Chara/Marker Brightness O X X X
Auto Upload (Proxy) o* X X X Setting
Default Upload Server o* X X X Option Type 1 - - - -
Clear Completed Jobs - - - - Type 2 - - - -
Clear All Jobs - - - - Type 3 - - - -
View Job List - - - - Install Option - - - -
Version Number - - - -
Version Up - - - -

Net-Func Version Number

Net-Func Ver.Up
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FileXZ=1—

I5H

e

REFLRT7AI

Scene

Reference

Lens

IEH

e

REERIT7 A

All

Scene

Reference

Lens

User File

Load SD Card

Save SD Card

File ID

Recall User Preset

Store User Preset

Clear User Preset

Load Customize Data

Load White Data

All File

Load SD Card

Save SD Card

File ID

All Preset

Store All Preset

Clear All Preset

3Sec Clear Preset

Scene File

Recall Internal Memory

Store Internal Memory

Load SD Card

Lens File

File ID

X

X

O

File Source

Clear Lens Offset

Lens Auto Recall

X

X

X

Lens Serial Number

Lens Name

Lens Manufacturer

Master V Modulation

Lens Center H

Lens CenterV

R Flare

G Flare

B Flare

White Offset R

White Offset B

Shading Ch Select

Shading H SAW

Shading H PARA

Shading V SAW

Shading V PARA

XIX|IX|[X[O|X|X|X|x|x|x|x]|x

XX XXX X|X]|X|X]|X|X]|X]|X

XIX|IX|IX|IX|IX|IX|IX|IX|IX|IX|IX]|X

O|O|O]O|x|O|O]O|0|0|0|0|0

Save SD Card

File ID

Scene White Data

User Gamma

Current Settings

Load SD Card

Reset

Reference File

Store Reference

Clear Reference

Load Reference(SD Card)

Save Reference(SD Card)

File ID

Lens File

Display Mode

Recall Internal Memory

Store Internal Memory

Load SD Card

Save SD Card
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74— v MRS SRS

wHER
\ _— EOF v— e 20—& S0y
AR B fryya T bqvy  avFezarz Zo2h
Lwo E—vav Lwo -

HD XAVC-I HD exFAT O O O O O O
XAVC-L422 HD 50 O O @) O O O
XAVC-L422 HD 35 O O (@) O O O
XAVC-L422 HD 25 O O (@) - O O
MPEG HD422 exFAT OOOOOO 77777777777777

UoF O O O O o) —

MPEG HD420 HQ exFAT @) O 7777777777777777777777777777 - - - O 77777777777777
w o o - S S —
w0 O — —~ - —

MPEG HD420 SP @) O - - - -

SD MPEG IMX 50 exFAT @) O 7777777777777777777777777777 - - - -

wr o o) - ~ - -

DVCAM exFAT c - - - - -

wr o - - - - -

1) WEUTWDET A X, TU—AlL—b. BRUKEESFMRIE [IBARE] (G7X—) ZCBELIEEL,
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FI9Fv—FvwvialbwvIT—RETE

AZa—®D0Operation >Format Cache Rec Time
Frequency Rec Format 0—2sec 2—4sec 4—6 sec 6—8sec 8—10sec 10—12sec 12—14sec 13—15sec
59.94 XAVC-1 1920 1080P O O - - - - - -
50 XAVC-1 1920 1080 O O O O - - - -
XAVC-1 1280 720P O O O O - - - -
XAVC-L 50/35/25 O O O O O O O O
MPEG HD422 O O O O O O O O
MPEG HD420 HQ/SP O O O O O O O O
MPEG IMX50 O O O O O O O O
DVCAM - - - - - - - -
29.97 XAVC- 1920 1080P O O O O - - - -
25 XAVC-L 50/35 O O O O O O O O
23.98 MPEG HD422 O O O O O O O O
MPEG HD420 HQ O O O O O O O O
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BUO., ERDNEFIFDIEDHODRIDT,
EhIFVTLZEW

— BEREUEEER
VDU —ERBHE, FlFEFBHEC
CHEMCIEEW

Bk ER (ST DIF7R0)

FTERNBERZZO) FHMAZERLTVST
. R=ZAAX=H— KBESERAEIZENY v
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EHEBREFEZEREOIAES TERT & RE
FZSIERIUIED. M. BFRFEICEE”
5X5CENBDFET,
AEDEL CTlE, EHFBRSLEDOBRIITED
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CMOSA A=I Y4 FEDIRSR

IREEEICHD TEDRKIFE. CMOSA X—Y
Y —HEDERERT. METIEHDFEA.

=)
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ESNTVETD, FEIREEDFEICKD,

FNICEE LICMNEERDFEET 2HBEDD
ODET. INFRERTOREICERT DD
THETIEH DI A

e, UFDHE. BRARAPILIEDET,
o SRDIRIRTHEATOLEE

o YR A V(R ZELTIcEE

o AO—Y v vH—E—bFDEE

EB. TSV INSVAOEFREBZTOIL
[CRD. HEEEDBE. BROPUEIT DL
WHDET,

TORLOTH
OV, RECEREIDE, TTETP
55DFNRABTIENDDET,

JUwhHa—
WHKT. T RUDLKT., KEBOFEDREE(C
FORATTIRFE T HE. BEDEERE LD,
BHAZEUIED. BREMNANDKLDIICEZSDC
ENRHDOERT,

AT
W 4RRRAR!

ARERRR =

CDRIFEEF. TU v H—HIE#REZAUtO
[CuTLrEn (126R—Y),

‘BE LW I LU—LL— M BRERHISE
WiEaERF. Uy h—mEENMESWLTE TV Y
N—ERR(CHETERVEANDDEIT, T
DEEIF. BF vy y—Z#FRLTIEEN,
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BREFFCMOSAA=I VT — ) ODRBEES
EHRIHLETIEDHEEICKD . REFMICELD
Tl&. BEZT P IEYDREEDD LD
NCRADIENBOET,

JZvya)\UR
TovakP. TP KRBT DHBEERE
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o bFET,

TovYa)\V RBREUCTU—LZEZTY
UwZE ER7JUS—y3avvyJbhoT7
EEALUTCHIET D ENTEFT,
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LTWB &, BE|RAT 4 PHRDT 7 A VDM
L (TZTAVT—232) LT, BEHRIEL

L&k - REFECEFLBZE DHEDDDFET. &
DEOIFBEIF. Uy TNy TPy T

Eofcdpd. AZa—MOperation >Format
Media (108 X—2)) TE|EXT 4 7D T # —

N b (#IERE) 21T o TLEE L.

TF2IUTAICREATHTER

o BIEATOMBTEF 1 U T A JWHEETOIK
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GPS (Global Positioning System) &id. KE

DEfBETMEGEZMNAB L. Ik EDEC
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BEE(CDNT

o GPSEONICUIcBERICEETDE. BEIULK
Do IBAICHAT, AfIE TORBH R
BBTEDBDFT,

o GPSHIEEKICL D=

AH(E. 3ELLEDGPSEHED SDBERES
£33 BBNICREEAGLET.
GPSHEBMAKICKDEEF. HI0mBETTY
h. BIAIY B EIDBIEIC L > TIFE STk
EHREFREUDTEDBDET, TDKD
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HEEDTEDBDET., . GPSEHE(F
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BENEBEINDCEDGDET,
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NE Iz

AN R

—fi%

g8 #13.6 kg (FED )

WATE (BB mm. BREESE T, AMEDH) ¥
0|
EONE (2
i — I o

1) PESEEETT,

BREE DC12VIT1V~170V)
HEB K22 W (RMEDIr. XAVCEERE.
LCOEZY—=4T8)
#24W(Ea—DT 7125 — CBK-
VF02. NZa7)LLVX X470
5. XAVCERERES. LCDEZ=Y—
FRATES)

[CER]

o HEEBENNS0WEDREVWETH 54 MEER LIEN
TLIEELY,

o NNy U—EAE. FilisEzsa U CERT 585
(& BEhIRESEOBEEBIDEF 40 WLRICED £ 5
[CLTLIEEL,

o AC-DNTOfERE. El#aziE L TRAT 5a(3.
BB DHEEERHDEETD 50 WHAICHED K S(CU
Tl EEL,

o AC-DN2BfEMAE. EilfzzsE U CTRERAT 55
B EEDHEBEEHDEETD85 WEAICED K SICU
[ G/ AN

o DCOUTImFICIFTHEBRN 1.8 AT O ZER U
TLIEELY,

BEEE 0T~40T

RERE —-20C~+60T
T7AIVY AT I

exFAT. UDF. FAT
R RS

#917053 (BP-FLX75fEF3F)
SR I4—N v b (ETH)
XAVC Intra

XAVC-IE— I CBG. &A223 Mbps.

MPEG-4 AVC/H.264
XAVC Long
XAVC-L 50— K 1 VBR. &K
50 Mbps. MPEG-4 AVC/H.264
XAVC-L 35— K 1 VBR. &K
35 Mbps. MPEG-4 AVC/H.264
XAVC-L 25F— K 1 VBR. &K
25 Mbps. MPEG-4 AVC/H.264
MPEG-2 Long GOP
MPEG HD422E— + : CBR.
50 Mbps. MPEG-2 422P@HL
MPEG HD420 HQE— K : VBR.
B®A35 Mbps. MPEG-2 MP@HL
MPEG HD420 SPE— I : CBR.
25 Mbps. MPEG-2 MP@H-14
MPEG IMX
CBR. 50 Mbps
DVCAM
CBR. 25 Mbps
Proxy
AVC/H.264 Main Profile 4:2:0 Long
GOP
1280%720/9 Mbps. 6 Mbps
640X 360/3 Mbps.
480x%270/1 Mbps. 500 Kbps (VBR)
REBIA—NY T —=FT17)
XAVC Intra
LPCM 24w b, 48 kHz, 4F v =%
b
XAVC Long
LPCM 24w b, 48 kHz, 4F v =%
b

MPEG-2 Long GOP
MPEG HD422E— K 1 LPCM 24E v
b 48kHz. 4F v
MPEG HD420 HQE— K : LPCM
6w b, 48 kHz, 4F v =)L
MPEG IMX
LPCM 16/24Ew b, 48 kHz, 4F v
=
DVCAM
LPCM 16w b 48 kHz, 4F v /%
v
Proxy
AAC-LC. 128 Kbps. 2F+ =L
SCER - BAERR
XAVC Intra
XAVC-IE—R
#5793 © SBP-120F/SBP-128E(EFAlS
XAVC Long
XAVC-L50E—R
#2309 © SBP-120F/SBP-128E/
SBS-128G1CIEARS
XAVC-L35E—R
#3159 © SBP-120F/SBP-128E/
SBS-128G1CIEFARS
XAVC-L 25F—hK
#4209 © SBP-120F/SBP-128E/
SBS-128G1CIEFARS
MPEG-2 Long GOP
MPEG HD422E— K
#2209 © SBP-120F/SBP-128E/
SBS-128G1CIEFARS
MPEG HD420 HOE— K
#3309 : SBP-120F/SBP-128E/
SBS-128G1CIEARS
MPEG IMX
#2159 © SBP-120F/SBP-128E/
SBS-128G1CIEARS
DVCAM
#4059 © SBP-120F/SBP-128E/
SBS-128G1CIEARS

[CER]

iR - BAERRBIE. 17Uy TEUTERERLIEEED
BODTT, sCiRI DT Uy THICK O TIIEHDIFE KD
BLIEBBENHDET,

s L—LL—b
XAVC Intra
XAVC-IE— R
1920X1080/59.94P. 50P. 59.94i.
50i. 29.97P. 23.98P. 25P
1280%720/59.94P, 50P
XAVC Long
XAVC-L 50FE—R
1920X1080/59.94P. 50P. 59.94i.
50i. 29.97P. 23.98P. 25P
1280%720/59.94P, 50P
XAVC-L 35FE—R
1920X1080/59.94P. 50P. 59.94i.
50i. 29.97P. 23.98P. 25P
XAVC-L 25F—R
1920%1080/59.94i. 50i
MPEG-2 Long GOP
MPEG HD422E— R
1920X1080/59.94i. 50i. 29.97P.
23.98P. 25P
1280%720/59.94P, 50P. 29.97P.
23.98P. 25P
MPEG HD420 HQE— R
1920X1080/59.94i. 50i. 29.97P.
23.98P. 25P
1440X1080/59.94i. 50i
1280%720/59.94P, 50P
MPEG HD420 SPE—R
1440X1080/59.94i. 50i
MPEG IMX
720X 486/59.94i
720X 576/50i
DVCAM
720X480/59.94i
720X 576/50i
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Proxy
A#R1920X 108085 : 29.97P, 25P.
23.98P
AH#R1280X 72085 1 59.94P, 50P.
29.97P. 25P. 23.98P

AE7JE0

ATJ
GENLOCKIN :

BNCEL. 1.0Vp-p. 75 Q. RFE
TCIN : BNCEL, 05V~ 18Vp-p. 10kQ
AUDIO IN CH1/CH2 :

XLREL, 3>, M

LINE / AES/EBU / MIC / MIC+48V]

DIRZ TIRE

LINE : +4. 0. —3dBu

AES/EBU : AES3#E#L

MIC : =70 dBu ~—30dBu

MICIN : XLRE, 5~ M. —70dBu~
—30dBu
WRR : D-sub 15~
7+ 0O2JCHT : —40 dBu
T JUCH1/CH2 © —40 dBFS
SDIIN :  SMPTE ST292-1/2595R4&%EH0L
FT—T 4 F4F v
Hi77
VIDEO OUT :
BNCEL., SD7+OJVRIw b~/
HD-Y8ID 1A
SDIOUT 1/2 :

BNCE, 0.8Vp-p. RF#H (3G
HD/1.5G HD/SD¥Ihi#23)

SMPTE ST424/425 Level-A/B.
ST292-1/2593R K54

F—F A4 FAF v R

AUDIO OUT :
XLREY, 5E>/. (Y. +4/0/— 3dBu ()
TCOUT: BNCEL, 1.0Vp-p. 50 Q
FARPHONE (RFUA ==Y p v o) :
—11 dBu (B#ELAJLHA, EZo—
RUa—LBA. 16 QETRHH)

HDMI:  TypeA. 19~
Z D
DCIN:  XLRZ, 4E>. O, DC1MV~17V

DCOUT : #BM4EY, DCT1TV~17V. BRE
HEEIR1.8 A

LENS:  12EY. LYZ~DEB#E (DC
1MV ~17V. BAEHEETRIO0A)
REMOTE : 8
LGHT: 2FY
USB: 4BV (AZA ) X2, 4EY BHA )
VF A6 (CBK-VFO2R). :FE20E
> (HDVFYU—Z )
2 NI—JiFF
RJ45%Y. 100BASE-TX (IEEE 802.3u).
10BASE-T (IEEE 802.3)
IXSH

®&FRTF 2/38. “Exmor’ Full HD CMOSA X—
Jtod—
1920 (H) X 1080 (V)

A RGB 3t A=

KR FlATUXLAR
NDZ 4 LT —
1: U7
2 1/4ND
3:1/16ND
4:1/64ND
RE F12( A7 LREKE#E: 59.941) (Typical)

(2000 Ix. 2&12£89.9%. 3200K)

RIEREHERE
0013 Ix(F14, +42dB. 16 7L—LA
i)
62 dB (Noise Suppression On)
(Typical)
KIFEFREE 1000TVAR
2N 3+1% (XZa—0Blackz [£0] (C5%
ELlcEE)
Ty I—AE—R
59.94i/P. 50i/P : 1/60 ~ 1/2000%
29.97P 1 1/40 ~ 1/2000%
25P 1 1/33 ~ 1/2000%
23.94P : 1/32 ~ 1/2000%
AO—Yvwvy—
2~8.
FAF=wobvy
600%
—135dB

BRIRS/N

167L—LA

A=Z7

A —T « 7 8B

YUV IR
48 kHz
SFRE
16/24Ew ~
Ny R)b—LA
20 dB (TiZHErls) (200 180 16,
12dB). EBUL
B R 1%
20 Hz ~ 20 kHz (£ 3 dBLIR)
FAF=wobvy
90 dB (Typical)
OFHE  0.08%UT (AFILNIL—40 dBUls)
ANEAE—H—
E/3)b. B3 300 mW

ZRIINED

LCDEZ=5—
BEY A X
8.8 cm (3.58Y)
T ARG K
16:9
[EE 2
960 (H) X540 (V)

XT 4 T8

SxSH—RZXOv ~
FEAKR © Express Card34
A0Ow b2
i F : PCMCIA Express CardZE#il
EFAHL— I 1 50 MbpsIU E
Ft UL — 1 50 MbpsII_E
SDA—RZOw b
ProxyF X 1. UtiltyA X1

L2 &R (PXW-X400KCIC
NE)

LYARD ~
VI=2/3AVFRNTRY b DTV~
SR 82 mm~ 164 mm
Z—1I F&f
A=At 2065
BRAORL
1:19
&b B&) FEaID I aTEe
F19~F168KXUC(yO—X)
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& 5% 0 FIFLTER

T+ — A EH
B&)/ FEY)D R AIaE
e
900 mm ~oo (¥ Z0O0FF)
10 mm ~oo (¥ ZOO0ON. [LAH)

Tq)LF—=
M82 mm. EwF0.75 mm
~oad ON/OFFHEJgE

L > XEB (PXW-X400KFI(C
1)

DA T N
V=234 VFRNFRY bYD K
FERERE 8 mm ~ 128 mm
(35 mmig& : 31.5 mm ~

503 mm)
X—LA BB FEWID IR AJEE
A—Lt 1615
RAORL
1:19
&b BE)/ FEt)D X olaE
F1.9 ~F16B&LUC(/O—X)
PERVIVS il
BE)/ FEt)D X olaE
EalEE
800 mm ~oe (¥~ O0FF)
50 mm ~oo (X Z0O0N. L)
732 mm ~o° (Y2 0O0N. Bi=i)
TAI)LT—&
M82 mm. EwF0.75mm
X0 ON/OFFaIgE

NI

2 a)LF—X)L k(1)

J—)URYa—+v ()

VAR hrvwv T

USBD AL ALANEY 2—)U (IFU-WLM3)
RETTvT()

H—R)

CERICIEBREIIC (1)

ERERBEE (CD-ROM) (1)

L X (PXW-X400KCICfHE) (1)
F—bTF—HAL X (PXW-X400KFIZHE)
M

TSIy IRBRF v— (1)

AT UAR AT (PXW-X400KC/PXW-X400KF(IZf
B (1)

Ea—77 A 25— (PXW-X400KC/PXW-X400KF
IS (1)

AT UARATBHRER T 1U—2 (PXW-X400KC/
PXW-X400KFIZE) (1)

BhEfkas

7w IIOU—RIATEVR
CBKZ-SLHL1 (HDR LICENSE)

BIREE

ACT I TH5—
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END USER LICENSE
AGREEMENT

IMPORTANT:

BEFORE USING THE SOFTWARE CONTAINED IN THE
CAMCORDER, PLEASE READ THIS END USER LICENSE
AGREEMENT ( "EULA™) CAREFULLY. BY USING THE
SOFTWARE YOU ARE ACCEPTING THE TERMS OF THIS
EULA. IF YOU DO NOT ACCEPT THE TERMS OF THIS
EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and
Sony Corporation ( “SONY” ). This EULA governs
your rights and obligations regarding the software
of SONY and/or its third party licensors (including
SONY' s affiliates) and their respective affiliates
(collectively, the “THIRD-PARTY SUPPLIERS)
contained in the camcorder, together with any
updates/ upgrades provided by SONY, any printed,
on-line or other electronic documentation for such
software, and any data files created by operation of
such software (collectively, the “SOFTWARE").

Notwithstanding the foregoing, any software in
the SOFTWARE having a separate end user license
agreement (including, but not limited to, GNU
General Public license and Lesser/Library General
Public License) shall be covered by such applicable
separate end user license agreement in lieu of the
terms of this EULA to the extent required by such
separate end user license agreement ( "EXCLUDED
SOFTWARE").

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The SOFTWARE
is protected by copyright and other intellectual
property laws and international treaties.

COPYRIGHT

All right and title in and to the SOFTWARE (including,
but not limited to, any images, photographs,
animation, video, audio, music, text and “applets”

incorporated into the SOFTWARE) is owned by SONY
or one or more of the THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE

SONY grants you a limited license to use the
SOFTWARE solely in connection with the camcorder
and only for your individual use. SONY and the
THIRD-PARTY SUPPLIERS expressly reserve all rights,
title and interest (including, but not limited to, all
intellectual property rights) in and to the SOFTWARE
that this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS

You may not copy, publish, adapt, redistribute,
attempt to derive source code, modify, reverse
engineer, decompile, or disassemble any of the
SOFTWARE, whether in whole or in part, or create
any derivative works from or of the SOFTWARE unless
such derivative works are intentionally facilitated

by the SOFTWARE. You may not modify or tamper
with any digital rights management functionality of
the SOFTWARE. You may not bypass, modify, defeat
or circumvent any of the functions or protections

of the SOFTWARE or any mechanisms operatively
linked to the SOFTWARE. You may not separate

any individual component of the SOFTWARE for

use on more than one camcorder unless expressly
authorized to do so by SONY. You may not remove,
alter, cover or deface any trademarks or notices

on the SOFTWARE. You may not share, distribute,
rent, lease, sublicense, assign, transfer or sell the
SOFTWARE. The software, network services or other
products other than SOFTWARE upon which the
SOFTWARE' S performance depends might be
interrupted or discontinued at the discretion of the
suppliers (software suppliers, service suppliers, or
SONY). SONY and such suppliers do not warrant that
the SOFTWARE, network services, contents or other
products will continue to be available, or will operate
without interruption or modification.

EXCLUDED SOFTWARE AND OPEN SOURCE
COMPONENTS

Notwithstanding the foregoing limited license
grant, you acknowledge that the SOFTWARE may
include EXCLUDED SOFTWARE. Certain EXCLUDED
SOFTWARE may be covered by open source
software licenses ( “Open Source Components”),
which means any software licenses approved as
open source licenses by the Open Source Initiative
or any substantially similar licenses, including but
not limited to any license that, as a condition of
distribution of the software licensed under such
license, requires that the distributor make the
software available in source code format. If and to
the extent disclosure is required, please visit www.
sony.com/linux or other SONY-designated web site
for a list of applicable OPEN SOURCE COMPONENTS
included in the SOFTWARE from time to time, and the
applicable terms and conditions governing its use.
Such terms and conditions may be changed by the
applicable third party at any time without liability to
you. To the extent required by the licenses covering
EXCLUDED SOFTWARE, the terms of such licenses will
apply in lieu of the terms of this EULA. To the extent
the terms of the licenses applicable to EXCLUDED
SOFTWARE prohibit any of the restrictions in this
EULA with respect to such EXCLUDED SOFTWARE,
such restrictions will not apply to such EXCLUDED
SOFTWARE. To the extent the terms of the licenses
applicable to Open Source Components require
SONY to make an offer to provide source code in
connection with the SOFTWARE, such offer is hereby
made.

USE OF SOFTWARE WITH COPYRIGHTED

MATERIALS

The SOFTWARE may be capable of being used

by you to view, store, process and/or use content
created by you and/or third parties. Such content
may be protected by copyright, other intellectual
property laws, and/or agreements. You agree to
use the SOFTWARE only in compliance with all
such laws and agreements that apply to such
content. You acknowledge and agree that SONY
may take appropriate measures to protect the
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copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are not
limited to, counting the frequency of your backup
and restoration through certain SOFTWARE features,
refusal to accept your request to enable restoration
of data, and termination of this EULA in the event of
your illegitimate use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE
DESIGNED TO BE USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT SERVICES
(“CONTENT SERVICE" ). USE OF THE SERVICE AND
THAT CONTENT IS SUBJECT TO THE TERMS OF SERVICE
OF THAT CONTENT SERVICE. IF YOU DECLINETO
ACCEPT THOSE TERMS, YOUR USE OF THE SOFTWARE
WILL BE LIMITED. You acknowledge and agree that
certain content and services available through the
SOFTWARE may be provided by third parties over
which SONY has no control. USE OF THE CONTENT
SERVICE REQUIRES AN INTERNET CONNECTION. THE
CONTENT SERVICE MAY BE DISCONTINUED AT ANY
TIME.

INTERNET CONNECTIVITY AND THIRD PARTY
SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet
connection for which you are solely responsible.
Further, you are solely responsible for payment of
any third party fees associated with your Internet
connection, including but not limited to Internet
service provider or airtime charges. Operation of the
SOFTWARE may be limited or restricted depending
on the capabilities, bandwidth or technical
limitations of your Internet connection and service.
The provision, quality and security of such Internet
connectivity are the sole responsibility of the third
party providing such service.

EXPORT AND OTHER REGULATIONS

You agree to comply with all applicable export and
re-export restrictions and regulations of the area
or country in which you reside, and not to transfer,

or authorize the transfer, of the SOFTWARE to a
prohibited country or otherwise in violation of any
such restrictions or regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not
designed, manufactured or intended for use or
resale as on-line control equipment in hazardous
environments requiring fail-safe performance,

such as in the operation of nuclear facilities, aircraft
navigation or communication systems, air traffic
control, direct life support machines, or weapons
systems, in which the failure of the SOFTWARE could
lead to death, personal injury, or severe physical or
environmental damage ( "HIGH RISK ACTIVITIES™).
SONY, each of the THIRD-PARTY SUPPLIERS, and each
of their respective affiliates specifically disclaim any
express or implied warranty, duty or condition of
fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE

You acknowledge and agree that use of the
SOFTWARE is at your sole risk and that you are
responsible for use of the SOFTWARE. The SOFTWARE
is provided "ASIS,” without warranty, duty or
condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS
(for purposes of this Section, SONY and each of

the THIRD-PARTY SUPPLIERS shall be collectively
referred to as “SONY" ) EXPRESSLY DISCLAIM ALL
WARRANTIES, DUTIES OR CONDITIONS, EXPRESS

OR IMPLIED, INCLUDING, BUT NOT LIMITED TG,

THE IMPLIED WARRANTIES OF MERCHANTABILITY,
NONINFRINGEMENT AND FITNESS FOR A PARTICULAR
PURPOSE. SONY DOES NOT WARRANT OR MAKE ANY
CONDITIONS OR REPRESENTATIONS (A) THAT THE
FUNCTIONS CONTAINED IN ANY OF THE SOFTWARE
WILL MEET YOUR REQUIREMENTS OR THAT THEY
WILL BE UPDATED, (B) THAT THE OPERATION OF ANY
OF THE SOFTWARE WILL BE CORRECT OR ERROR-
FREE OR THAT ANY DEFECTS WILL BE CORRECTED,
(C) THAT THE SOFTWARE WILL NOT DAMAGE ANY
OTHER SOFTWARE, HARDWARE OR DATA, (D) THAT
ANY SOFTWARE, NETWORK SERVICES (INCLUDING

THE INTERNET) OR PRODUCTS (OTHER THAN

THE SOFTWARE) UPON WHICH THE SOFTWARE' S
PERFORMANCE DEPENDS WILL CONTINUE TO BE
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND
(E) REGARDING THE USE OR THE RESULTS OF THE USE
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE
OF SONY SHALL CREATE A WARRANTY, DUTY OR
CONDITION OR IN ANY WAY INCREASE THE SCOPE

OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION.
SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES, SO THESE
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS
(for purposes of this Section, SONY and each of the
THIRD-PARTY SUPPLIERS shall be collectively referred
toas "SONY”) SHALL NOT BE LIABLE FOR ANY
INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR
BREACH OF ANY EXPRESS OR IMPLIED WARRANTY,
BREACH OF CONTRACT, NEGLIGENCE, STRICT
LIABILITY OR UNDER ANY OTHER LEGAL THEORY
RELATED TO THE SOFTWARE, INCLUDING, BUT NOT
LIMITED TO, ANY DAMAGES ARISING OUT OF LOSS
OF PROFITS, LOSS OF REVENUE, LOSS OF DATA, LOSS
OF USE OF THE SOFTWARE OR ANY ASSOCIATED
HARDWARE, DOWN TIME AND USER" S TIME, EVEN

IF ANY OF THEM HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, EACH
AND ALL OF THEIR AGGREGATE LIABILITY UNDER ANY
PROVISION OF THIS EULA SHALL BE LIMITED TO THE
AMOUNT ACTUALLY PAID FOR THE PRODUCT. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA, DATA
SECURITY

You acknowledge and agree that SONY and its
affiliates, partners and agents may read, collect,
transfer, process and store certain information
collected from the SOFTWARE, including but not
limited to information about (i) the SOFTWARE

and (i) the software applications, contents and
peripheral devices that interact with your camcorder
and the SOFTWARE ( “Information” ). Information
includes, but is not limited to: (1) unique identifiers
relating to your camcorder and its components;

(2) performance of the camcorder, the SOFTWARE
and their components; (3) configurations of your
camcorder, the SOFTWARE and the software
applications, contents and peripheral devices that
interact with the camcorder and the SOFTWARE;

(4) use and frequency of use of the functions of (x)
the SOFTWARE, and (y) the software applications,
contents and peripheral devices that interact with
the SOFTWARE; and (5) location data, as indicated
below. SONY and its affiliates, partners and agents
may use and disclose Information subject to
applicable laws in order to improve its products

and services or to provide products or services to
you. Such uses include, but are not limited to: (a)
administering the functionalities of the SOFTWARE;
(b) to improve, service, update or upgrade the
SOFTWARE; (c) improving, developing and enhancing
the current and future products and services of SONY
and other parties; (d) to provide you with information
about the products and services offered by SONY
and other parties; (e) complying with applicable laws
or regulations; and (f) to the extent offered, providing
you with location-based services of SONY and other
parties, as indicated below. In addition, SONY retains
the right to use Information to protect itself and third
parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE
may rely upon location information, including,

but not limited to, the geographic location of the
camcorder. You acknowledge that for the purpose
of providing such services, SONY, the THIRD-PARTY
SUPPLIERS or their partners may collect, archive,
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process and use such location data, and that such
services are governed by the privacy policies of SONY
or such third party. By using any such services, you
agree that you have reviewed the privacy policies
applicable to such services and consent to such
activities.

SONY, its affiliates, partners and agents will not
intentionally use Information to personally identify
the owner or user of the SOFTWARE without your
knowledge or consent. Any use of Information will
be in accordance with the privacy policies of SONY
or such third party. Please contact applicable contact
address of each area or country for SONY" s current

privacy policy.

Please contact applicable third parties for privacy
policies relating to personally identifiable and other
information you provide when you use or access
third party software or services.

Information may be processed, stored or transferred
to SONY; its affiliates or agents which are located in
countries outside of your country of residence. Data
protection and information privacy laws in certain
countries may not offer the same level of protection
as your country of residence and you may have fewer
legal rights in relation to Information processed and
stored in, or transferred to, such countries. SONY will
use reasonable efforts to take appropriate technical
and organizational steps to prevent unauthorized
access to or disclosure of Information, but does not
warrant it will eliminate all risk of misuse of such
Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY
SUPPLIERS may automatically update or otherwise
modify the SOFTWARE, including, but not limited to,
for purposes of enhancement of security functions,
error correction and improvement of functions,

at such time as you interact with SONY" s or third
parties’ servers, or otherwise. Such updates or
modifications may delete or change the nature of
features or other aspects of the SOFTWARE, including,
but not limited to, functions you may rely upon. You

acknowledge and agree that such activities may
occur at SONY" s sole discretion and that SONY may
condition continued use of the SOFTWARE upon
your complete installation or acceptance of such
update or modifications. Any updates/modifications
shall be deemed to be, and shall constitute part

of, the SOFTWARE for purposes of this EULA. By
acceptance of this EULA, you consent to such
update/ modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY

This EULA and SONY" s privacy policy, each as
amended and modified from time to time, together
constitute the entire agreement between you and
SONY with respect to the SOFTWARE. The failure of
SONY to exercise or enforce any right or provision of
this EULA shall not constitute a waiver of such right
or provision. If any part of this EULA is held invalid,
illegal, or unenforceable, that provision shall be
enforced to the maximum extent permissible so as to
maintain the intent of this EULA, and the other parts
will remain in full force and effect.

GOVERNING LAW AND JURISDICTION

The United Nations Convention on Contracts for the
International Sale of Goods shall not apply to this
EULA. This EULA shall be governed by the laws of
Japan, without regards to conflict of laws provisions.
Any dispute arising out of this EULA shall be subject
to the exclusive venue of the Tokyo District Court in
Japan, and the parties hereby consent to the venue
and jurisdiction of such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this EULA
to the contrary, you acknowledge and agree that
any violation of or non-compliance with this EULA
by you will cause irreparable harm to SONY, for
which monetary damages would be inadequate,
and you consent to SONY obtaining any injunctive
or equitable relief that SONY deems necessary or
appropriate in such circumstances. SONY may also
take any legal and technical remedies to prevent
violation of and/or to enforce this EULA, including,
but not limited to, immediate termination of your

use of the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to violate
this EULA. These remedies are in addition to any
other remedies SONY may have at law, in equity or
under contract.

TERMINATION

Without prejudice to any of its other rights, SONY
may terminate this EULA if you fail to comply with
any of its terms. In case of such termination, you
must: (i) cease all use, and destroy any copies, of
the SOFTWARE,; (i) comply with the requirements
in the section below entitled “Your Account
Responsibilities™ .

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND ANY OF THE
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY
POSTING NOTICE ON A SONY DESIGNATED WEB SITE,
BY EMAIL NOTIFICATION TO AN EMAIL ADDRESS
PROVIDED BY YOU, BY PROVIDING NOTICE AS PART
OF THE PROCESS IN WHICH YOU OBTAIN UPGRADES/
UPDATES OR BY ANY OTHER LEGALLY RECOGNIZABLE
FORM OF NOTICE. If you do not agree to the
amendment, you should promptly contact SONY for
instructions. Your continued use of the SOFTWARE
after the effective date of any such notice shall be
deemed your agreement to be bound by such
amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended
third-party beneficiary of, and shall have the right to

enforce, each provision of this EULA with respect to
the SOFTWARE of such party.

Should you have any questions concerning this
EULA, you may contact SONY by writing to SONY at
applicable contact address of each area or country.

Copyright © 2012 Sony Corporation.
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